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Nortel USP Upgrades

New in this release
Feature changes

In SN09U (USP11.1), there are no new feature changes that affect the 
USP upgrade.

Upgrade paths
Nortel Networks supports the following direct in-service upgrade paths:

• USP10.0.x/SN08 to USP11.1.x/SN09U

• USP11.0.x/SN09 to USP11.1.x/SN09U

• USP11.1.x/SN09U to USP11.1.y/SN09U (maintenance release)

If upgrading from a USP9.0 or lower release, upgrade to USP10.0.x 
before continuing with this upgrade.

Impacts of an upgrade
This section provides the following information:

• the estimated time to complete a software upgrade

• the service impacts of a software upgrade

• other information affecting a software upgrade

ATTENTION
Perform all software upgrade procedures from the alternate boot 
server, unless otherwise noted. You must have administrative 
privileges to perform a software upgrade. 
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Time to complete an upgrade
The following table lists the tasks to upgrade USP software and the 
estimated time to complete each task.

Large systems and small systems
A small USP system typically requires less time to perform an upgrade 
than a large USP system. 

• A small USP system consists of one or two shelf systems. You can 
upgrade most small USP systems in a single six-hour maintenance 
window. 

• A large USP system consists of three or more shelves. Most large 
USP systems require two or more six-hour maintenance windows 
for a software upgrade. 

Estimated time to complete a software upgrade

Task Card Time

Preparing for the upgrade 35 minutes

Upgrading the software RTC 20 minutes per card

IPLINK 15 minutes per card

SS7IPLINK 15 minutes per card

NPC 15 minutes per card

NPE 15 minutes per card

NPS 15 minutes per card

other link nodes 5 minutes per node

CC card 2 minutes per card

Completing the upgrade 30 minutes

Total estimated upgrade time 4 to 8 hours
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The following table lists sizes of USP systems and the time to complete 
a software upgrade for each size. 

Service impacts
The upgrade of USP software does not impact service. Traffic is 
maintained through redundant links configured on different link cards. 
A loss of network redundancy occurs when a blade is taken out of 
service.

The CLI is not available for use during an upgrade.

Additional information
This section provides additional information on USP software 
upgrades.

Auto-negotiate
Auto-negotiate for the CS-LAN can be enabled during a USP software 
upgrade. 

Core Bounce cutover
The procedures for cutover from Core Bounce to Direct Messaging are 
not performed during an upgrade. Contact Nortel Networks for more 
information. 

In-service cutover
An in-service cutover is not performed during an upgrade. Contact 
Nortel for more information.

USP systems and upgrade times

System size Length of time 
Maintenance 
windows

1 shelf 2 hours 1

2 shelves 5 hours 1

3 shelves 8 hours 2

4 shelves 10 hours 2

5 shelves 12 hours 2

8 shelves 20 hours 4
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Routemaster
The Routemaster application is beyond the scope of upgrades. Contact 
Nortel for more information on using Routemaster for end office 
consolidation.

USP software releases
USP software releases use the following naming convention: 

USPnn.n.n

The first and second numbers identify a major USP software release, 
and the third number identifies a maintenance release. 

The following table lists examples of USP major releases and USP 
maintenance releases.

Scope of document
This document supports major release upgrades and maintenance 
release upgrades. 

• A major release upgrade is an upgrade from one release to a 
another release. Following is an example of a major upgrade.

USP10.0.3 to USP11.0.0

• A maintenance release upgrade is an upgrade from one release to 
a another release within the same major release. 

USP10.0.2 to 10.0.3

Upgrade order
Small systems and one maintenance window

The card upgrade order for a one maintenance window upgrade varies 
slightly for one- and two-shelf systems. 

For a one-shelf system, upgrade the following cards:

• upgrade RTC 15

• upgrade CC1 in slot 1

USP software releases

Major release Maintenance releases

USP10.0.0 USP10.0.3

USP10.1.0 USP10.1.2

USP11.0.0 USP11.0.3
NN10045-461   (I)SN09U   Standard 08.02 October 2006



Nortel Networks Confidential5Copyright © 2006, Nortel Networks
• upgrade the link cards

• upgrade the NP cards

• upgrade CC2 in slot 18

• upgrade RTC 12

For a two-shelf system, upgrade the following cards:

• upgrade RTC 15

• upgrade CC1 in slot 1 on the control shelf

• upgrade CC1 in slot 1 on the extension shelf

• upgrade the link cards on the extension shelf

• upgrade the link cards on the control shelf

• upgrade the NP cards in the control shelf

• upgrade the NP cards in the extension shelf

• upgrade CC2 in slot 18 on the control shelf

• upgrade CC2 in slot 18 on the extension shelf 

• upgrade RTC 12

For a list and detailed procedures of the card upgrade order for a 
one-and two-shelf system, see Upgrading the system nodes for one 
maintenance window upgrades on page 95.

Large systems and multiple maintenance windows
When performing a large system upgrade that requires more than one 
maintenance window to complete, you must upgrade the entire Control 
CAM shelf and one card for each unique card type before the end of the 
first maintenance window. The subsequent windows are used to 
upgrade the remaining cards in the system.

For upgrades spanning multiple maintenance windows, upgrade the 
following cards:

• upgrade RTC 15

• upgrade CC1 in slot 1 on the control shelf

• upgrade link cards in the control shelf

• upgrade NP cards in the control shelf

• upgrade CC2 in slot 18 on the control shelf

• upgrade one card for each unique card type on any extension shelf
Nortel USP Upgrades
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• SWACT RTC 12; if you cannot SWACT RTC 12, upgrade a card of 
a type that you have not yet upgraded

• perform test calls and monitor the system for at least 15 minutes to 
evaluate your acceptance of the upgrade

• upgrade RTC 12

Note: The RTC12 upgrade completes the upgrade requirement 
for the first maintenance window. You can continue the upgrade in 
this current maintenance window and in the next maintenance 
window.

• upgrade CC1 in slot 1 on the extension shelf

• upgrade the link cards on the extension shelves

• upgrade the NP cards in the extension shelves

• upgrade CC2 in slot 18

For a list and detailed procedures of the card upgrade order for a 
multiple shelf systems, see Upgrading the system nodes for multiple 
maintenance window upgrades on page 97.

NP chain upgrade considerations
The four possible NP card configurations to consider when planning to 
perform an upgrade over multiple maintenance windows are as follows:

1. All NP cards on the Control Shelf if:

• both NPCs on the control shelf

• all the chain related NPx cards on the control shelf

All NP cards will be upgraded during the first window as all cards 
must be upgraded in the Control shelf during the first window.

2. Only the NPC on the Control Shelf and other NP cards on 
Extension shelves if:

• both NPCs are on the control shelf 

• at least one chain associated NPx on an extension shelf

You must finish upgrading both NPC associated chains and all NPx 
cards on the first maintenance window. 

3. NPCs on an Extension shelf and other NP cards on the Control 
shelf if:

• both NPCs are on an extension shelf

• at least one chain related NPx provisioned on the control shelf
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You must finish upgrading all NPx cards associated to that chain in 
the first maintenance window.

Note: Nortel Networks suggests locating both NPCs on the 
control shelf to avoid extension shelf isolation.

4. All NP cards on Extension shelves if:

• both NPCs are on one extension shelf

• all the chain associated NPx also provisioned on extension 
shelves

You can choose to finish upgrading one NPC associated chain and 
one NPS associated chain (If an alternate NPS is already involved 
with the selected NPC associated chain, the NPS associated chain 
does not have to be upgraded in the first maintenance window).

Note:  Nortel Networks suggests locating both NPCs on the 
control shelf to avoid extension shelf isolation.

System capacity 
The software upgrade procedure can impact the system capacity. This 
means that additional disk space on the OAMP workstation and the 
RTC system nodes are required for converting existing databases.

The pre-checking procedure checks for adequate disk space on the 
RTC system nodes. A message box informs you if your disk space is 
too low. If disk space is too low, delete any old snapshots.

Once the update is complete, the additional disk space is no longer 
required and is made available for use.

System performance 
The software upgrade procedure can impact USP system performance 
in the following ways:

• An upgrade database conversion is necessary due to internal USP 
data format changes. This affects the RTC system node in slot 15 
(the inactive RTC system node). The RTC in slot 15 is the first 
system node upgraded to the new version.

• Depending on the scope of data format changes, the inactive RTC 
in slot 15 takes approximately 20 minutes to load and convert 
internal data to the new format. During this time, the inactive RTC 
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system node is not enabled and the system operates with a single 
RTC system node.

• You must perform software upgrade procedures during 
maintenance periods, as network capacity is reduced during the 
software upgrade. This is because the Link system nodes must be 
reloaded during the upgrade. As a result, all SS7 traffic is rerouted 
from the links and linksets that reside on the disabled Link system 
node. 

System limitations during upgrade
During a software upgrade, the system prohibits the following actions, 
listed by subsystem:

• System administration

— adding, deleting, or modifying users

— setting the time of day

— changing passwords

• System management

— modifying the system name or shelf names

— adding or deleting RTC, CC, or application system nodes

— modifying the IP address or the PEC of the RTC system nodes

• SS7 management (MTP Level 3)

— adding, deleting, or modifying a system identity

— adding, deleting, or modifying a capability code

— adding, deleting, or modifying links, linksets, linkset groups, 
combined linksets, or routesets

— adding, deleting, or modifying ASP, AS, ASP Paths, AS 
destinations, or AS assignments

• SS7 management (MSU/Gateway Screening)

— deleting gateway screening criteria files

• SS7 management (Global Title Translations)

— adding, deleting, or modifying all GTT results

— adding, deleting, or modifying all GTA results

— adding, modifying, or deleting GTT translation type text

— adding, modifying, or deleting GTT translations
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• SS7 management (Special Study Operational Measurements)

— adding, deleting, or modifying SSOMs

— enabling/disabling SSOMs on linksets 

• SS7 management (SCCP)

— adding or deleting remote point codes (RPCs)

— adding, deleting, or modifying remote subsystems (RSSs)

— adding or deleting concerned point codes

— adding, deleting, or modifying local subsystems (LSSs)

— adding or deleting

 local subsystems concerned point codes (CPCs)

— adding or deleting LSS instances

• IPS7 management 

— adding, deleting, or modifying application server process

— adding, deleting, or modifying application server process path

— adding, deleting, or modifying application server

— adding, deleting, or modifying application server destination

— adding, deleting, or modifying application server assignment

OAMP workstation functionality
The GUI allows multiple sites to be configured on an OAMP workstation 
at one time. Since the sites are not upgraded at the same time, the 
following conditions apply:

• If the GUI is upgraded and the USP is not, you can access existing 
USP capabilities. You cannot use the new capabilities.

• The new USP GUI allows you to log in to a previous system, a new 
system, or a USP system that has an upgrade in progress.

• You cannot use a previous version of the GUI to log in to a newer 
version of the USP software.

• Only one version of the GUI can be installed at a time, because the 
GUI upgrade requires the conversion of local files.

Aborting an upgrade
If you need to abort the USP upgrade, perform Aborting an Upgrade on 
page 173.
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USP upgrade tasks 
This taskflow shows you the sequence of tasks you perform to upgrade 
this component.

USP upgrade tasks

Refer to 
“Component 

Upgrade order” in 
the solution upgrade 

document

Preparing to upgrade 
the USP on page 11

Refer to “Required 
pre-upgrade 

procedures” in the 
solution upgrade 

document

 End

Yes

No

Start

Upgrading the USP on 
page 13

Completing the USP 
upgrade on page 15

All solution 
pre-upgrade 

procedures are 
complete?

Yes

No This component 
is next in 

upgrade order?
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Preparing to upgrade the USP

The following procedure provides the high-level steps you need to 
execute prior to upgrading this component. Where applicable, a 
reference to the step-by-step procedure is provided.

Prerequisites
This procedure has the following prerequisites:

• any prerequisites identified at the start of this document, have been 
completed

• all components that precede the USP, as identified at the start of this 
document, have been upgraded

• for CS 2000 Management Tools-based workstations, procedure 
Upgrading the ABS software on the CS 2000 Management Tools 
server on page 43 was completed during the CS 2000 Management 
Tools upgrade.

Action
Perform the following tasks to prepare the USP for an upgrade.

At the OAMP workstation
1 Log in to the USP GUI.

At the USP GUI

2 Determine the release that is running on the USP, which is 
indicated in the status bar as “Connected to <lab_name> 
<load_version>, and ensure the USP is running the latest point 
release of the current major release. Check for any RMR 
bulletins to determine the latest point release. 

3 Determine if the office uses Route Master. 

For detailed steps, refer to procedure Checking Route Master 
status on page 16.

4 Make sure all system nodes are operating in one of the following 
statuses:

• in-service and unlocked

• offline

For detailed steps, refer to procedure Verify the USP is running 
on page 17. 

5 Take corrective action to clear all outstanding alarms. 

For details refer to USP Fault Management, NN10071-911.
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6 Make sure each IPS7 card has no more than 16 paths. If your 
system has IPS7 cards with more that 16 paths, redistribute the 
paths among the system nodes. 

For details, refer to section "Application Server Process Paths 
Configuration" in USP Configuration Management, 
NN10093-511.

7 Delete old and unused snapshots. 

For detailed steps, refer to procedure Delete a data snapshot on 
page 19.

8 Take an alternate boot data snapshot. 

For detailed steps, refer to procedure Creating an alternate boot 
data snapshot on page 22.

9 Perform test calls and verify the calls complete successfully. 

10 Reinitialize each RTC system node. 

For detailed steps, refer to procedure Reinitializing an RTC 
system node on page 25.

11 You have competed this procedure. Proceed to Upgrading the 
USP on page 13.
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Upgrading the USP

The following procedure provides the high-level steps to upgrade this 
component. Where applicable, a reference to the step-by-step 
procedure is provided.

Prerequisites
Complete the following tasks:

1. Preparing to upgrade the USP on page 11

2. Review the upgrade schedule and office records to determine if 
ABS software on the CS 2000 Management Tools (CMT) server 
has been upgraded during this upgrade cycle.

3. Determine whether you are upgrading using a CD or Electronic 
Software Delivery (ESD), and if upgrading using a CD, ensure you 
have the CD for the release you are upgrading to.

Action
Perform the following tasks procedures to upgrade the component.

Upgrading the USP

At the OAMP workstation

1 Use the following table to determine your first step.

2 Perform one of the following tasks:

• If you receive new USP software on CD, insert the CD in the 
CD drive of your workstation.

• If you receive new software through ESD, perform Installing 
Using ESD on page 72.

3 Upgrade the ABS and USP GUI using procedure Upgrading the 
ABS and USP GUI on a Windows-based workstation on 
page 31:

If you are upgrading USP 
on a

Do

non-CMT-based OAMP 
workstation 
(Windows-based)

step 2

CMT-based OAMP 
workstation

step 4
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4 Use the upgrade wizard. See Using the Upgrade Wizard on 
page 91

5 Use the following table to determine your next step.

6 Migrate the ABS to the CS 2000 Management Tools (CMT) 
server. Refer to Migrating the Alternate Boot Server (ABS) from 
USP PC to CS 2000 Management Tools on page 123.

7 You have finished upgrading the software on the USP. Go to 
Completing the USP upgrade on page 15.

If Do

you are running the ABS on a 
non-CMT-based OAMP 
workstation in a CVoIP 
network

step 6

otherwise step 7
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Completing the USP upgrade

The USP Upgrade Wizard performs most upgrade completion tasks. 
No additional procedures are needed to complete the USP upgrade. 

Follow office policy in the removal and storage of extra copies of new 
USP software. 

• If you used a CD to upgrade the USP software, remove the CD from 
the CD drive and store the CD. 

• If you used an ESD software load to upgrade the USP software, 
archive or delete the following files:

— ESD software load

— compressed USP software

— any extra copies of new USP software on your PC
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Checking Route Master status 

Use the following procedure to determine if an office uses Route 
Master. Perform this procedure before a USP software upgrade. 

Prerequisites
This procedure has no prerequisites.

Action
Perform the following steps to complete this procedure.

Checking Route Master status

At the OAMP workstation

1 Log in to the USP GUI. 

At the USP GUI

2 Open the Route Master provisioning window through 
Configuration>rm>system-id-mapping.

3 Under the Search tab, click Retrieve.

A list of provisioned Route Master system IDs appears. If the 
office does not use Route Master, no system IDs appear.

4 Use the following table to determine your next step.

5 Record that the office uses Route Master. You will perform 
additional test calls after the upgrade.

6 Close the Route Master provisioning window.

7 You have completed this procedure. Return to Preparing to 
upgrade the USP on page 11.

If Do

a list of system IDs 
appears

step 5

otherwise step 6
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Verify the USP is running 

Before beginning upgrade procedures, complete this check from the 
USP GUI to make sure your system is running in a predictable, stable 
manner.

Prerequisites
This procedure has no prerequisites.

Action
Perform the following steps to complete this procedure.

Verify the USP is running

At the OAMP workstation

1 Log in to the USP GUI.

From the USP GUI

2 Display the node maintenance and provisioning window by 
selecting Configuration>platform>node.

3 Display the graphical view by selecting Graphical View. 

4 Make sure that the icon for each in-service system node is 
green.

5 Make sure that the icon for each offline node are yellow.

If Do

all icons for every in-service 
system node are green

step 5

any icon for any in-service 
system node is any other 
color

Do not continue with the 
upgrade. Troubleshoot the 
problem or contact your next 
level of support. 

If Do

all icons for every offline 
system node are yellow

step 6

any icon for any offline 
system node is any other 
color

Do not continue with the 
upgrade. Troubleshoot the 
problem or contact your next 
level of support. 
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6 Use the following table to determine your next step.

7 You have completed this procedure. Return to Preparing to 
upgrade the USP on page 11.

If your USP system 
contains

Do

a single shelf step 7

multiple shelves Repeat this procedure for each 
USP shelf in the office.
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Delete a data snapshot 

Use this procedure to delete old or unused data snapshots. Perform this 
procedure before a USP software upgrade. 

Prerequisites
This procedure has no prerequisites.

Action
The following figure shows the high-level steps of this procedure. Use 
the step-by-step instructions that follow the figure to perform the 
procedure.

Delete an old data snapshot

Open the File 
Manager window.

Delete the snapshot 
from the ABS.

Delete the snapshot 
from the inactive RTC 
node.

Start

Finish

Delete the snapshot 
from the active RTC 
node.
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Delete a data snapshot

At the OAMP workstation

1 Log in to the USP GUI.

At the USP GUI

2 Open the File Manager window by selecting 
Administration>file-manager.

Response

The File Manager window appears.

3 At the Source portion of the window, select a snapshot to delete 
and click Delete.

Note: The Source portion is the left side of the window under 
Alternate Boot Server.

Response

An hourglass appears while the USP Manager deletes the 
snapshot from the Alternate Boot Server. The information under 
Alternate Boot Server refreshes when the snapshot is deleted.

4 Repeat step 3 for each snapshot you want to delete from the 
Alternate Boot Server.

5 At the Destination portion of the window, make sure the active 
RTC node is selected.

Note: The Destination portion is the right side of the window 
under the RTC selection.

6 Expand the Snapshot folder and the folder for the previous 
version of software.

7 Select the snapshot and click Delete.

Response

An hourglass appears while the USP Manager deletes the 
snapshot from the active node. The information refreshes when 
the snapshot is deleted.

8 Repeat steps step 6 and step 7 for each snapshot on the active 
RTC node you want to delete. 

9 At the RTC selection, select the inactive RTC node.

10 Expand the Snapshot folder and the folder for the previous 
version of software.
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11 Select the snapshot and click Delete.

Response

An hourglass appears while the USP Manager deletes the 
snapshot from the inactive node. The information refreshes 
when the snapshot is deleted.

12 Repeat steps step 10 and step 11 for each snapshot on the 
inactive RTC node you want to delete. 

13 You have completed this procedure. Return to Preparing to 
upgrade the USP on page 11.
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Creating an alternate boot data snapshot

During the upgrade, you will be making many changes to the system. 
To ensure you have a backup in case a change has a performance 
degradation impact, you must take a snapshot when your system is 
operating properly. This allows you to revert the system to that 
snapshot. You must take a snapshot before you start the upgrade and 
once again after completing the upgrade.

Prerequisites
This procedure has no prerequisites.

Action
To create an alternate boot data snapshot, perform the following steps:

Creating an alternate boot data snapshot

At the OAMP workstation

1 Log in to the USP GUI.

At the USP GUI

2 Click Administration>backup.

3 Enter a description of the data snapshot in the Description box. 
You can enter up to 32 characters.

Use the following format for the description so the file can be 
easily identified in the future:

• pre_upgrd_<site>_<date> for backup pre-upgrade snapshot 

• post_upgrd_<site>_<date> for backup post-upgrade 
snapshot 

where 

<site> 
is the site name

<date> 
is the current date
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4 Click the corresponding checkboxes to activate the following 
options, as appropriate:

• transfer snapshot to alternate boot server

Note: Nortel Networks recommends that you enable this 
option. If you do not select this option, a warning dialog box 
will appear; select yes to continue.

• set as active snapshot on alternate boot server

Note: Nortel Networks recommends that you enable this 
option. If you do not select this option, a warning dialog box 
will appear; select yes to continue.

• delete oldest snapshot on alternate boot server if maximum 
reached (16)

• delete oldest snapshot on rtc if maximum reached (5)

5 Click Create to create the data snapshot.

A Confirmation required dialog box appears, stating: Backup 
create command can take up to 20 minutes, during which time 
system write access will be disabled. Do you want to continue? 
Click Yes to continue.

6 When the data snapshot command is complete, close the 
Administration backup window by clicking the X in the top right 
corner.

7 If you selected both transfer snapshot to alt boot server and set 
as active snapshot on alternate boot server, go to step 15. If you 
only selected transfer snapshot to alt boot server, go to step 14.

8 Click Administration>File Manager.

9 Select the active RTC system node from the drop-box.

10 Open the snapshot folder. 

11 Open the folder corresponding to the version of the USP 
software that you are running. 

12 Select the snapshot file you want to copy. When you select a file, 
its description is displayed in the Description box.

13 Copy the snapshot to the ABS by clicking <-. An hourglass 
appears while the data snapshot is copied. The folders in ABS 
portion of the window are updated with the information for the 
copied data snapshot when the copy operation is complete.

Note: These files are large and can take several minutes, 
depending on system activity, to copy from an RTC system 
node to your alternate boot server.
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14 Update the ABS Active Snapshot using the ABS Settings 
window:

• Open the Alternate Boot Server (ABS) window by clicking 
Administration> alternate-boot-server

• Select the snapshot you have just created from the Snapshot 
name drop-down list.

• Click Modify to save your changes and close the window. 

A Confirmation dialog box appears, asking if you want to 
continue with the ABS Modify command. Click Yes to 
continue.

15 This procedure is complete. If applicable, return to the 
higher-level procedure or task flow that directed you to this 
procedure.
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Reinitializing an RTC system node 

Perform the following procedure to download a boot image and 
re-initialize the RTC system node before a USP software upgrade.

Prerequisites
This procedure has no prerequisites.

Action
Perform the following steps to complete this procedure.

Reinitializing an RTC system node

At the OAMP workstation

1 Log in to the USP GUI.

At the USP GUI

2 Open the system node provisioning window by selecting 
Configuration>platform>node. 

3 Display the graphical view by selecting Graphical View. 

4 Double-click the icon for the inactive RTC system node, which is 
the one with no check mark.

5 Check the status of the node.

6 Click Lock. 

7 If a confirmation dialog box appears, Click Yes to confirm the 
change.

8 Click Load to download the RTC system node boot image and 
re-initialize the RTC system node.

9 If a confirmation dialog box appears, Click Yes to confirm the 
change.

10 Display the graphical view by selecting Graphical View.

11 Wait for the card to display in green. Green indicates initialization 
is complete.

12 Double-click the icon for the inactive RTC system node, which is 
the one with no check mark.

If the inactive RTC system node is Do

unlocked step 6

locked step 8
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13 Click Unlock to unlock the RTC.

14 If a confirmation dialog box appears, Click Yes to confirm the 
change.

15 Click SWACT to make the inactive RTC system node Active.

16 If a confirmation dialog box appears, Click Yes to confirm the 
change.

17 Us the following table to determine your next step.

18 Make sure that the RTC system node in slot 12 (RTC12) is the 
active RTC system node. 

19 Click SWACT to make RTC12 the active system node. 

20 If a confirmation dialog box appears, Click Yes to confirm the 
change.

21 This procedure is complete. Return to Preparing to upgrade the 
USP on page 11.

If you reinitialized Do

one RTC system node step 3

both RTC system nodes step 18

If RTC12 Do

inactive step 19

active step 21
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Extracting and copying a USP ESD software file

Use this procedure to extract USP software from an ESD load file and, 
if necessary, copy the new USP software to the CS 2000 Management 
Tools server.

Prerequisites
Perform the following tasks before you begin this procedure.

• Know the name of the ESD load file with the new USP software. 
Check the e-mail from Nortel that announced the availability of the 
load.

• Know how you will upgrade USP software. If you upgrade USP 
software from the CS 2000 Management Tools server, you must 
copy the new USP software to the server.

Action
Perform the following procedures.

• Extract the new USP software from the ESD load file. Perform 
Extracting USP software from an ESD load file on page 27.

• If you use the CS 2000 Management Tools server to upgrade USP 
software, perform Copying new USP software to the CS 2000 
Management Tools server on page 29

Extracting USP software from an ESD load file

At your workstation

1 Create a temporary directory to store the new USP software.

2 Use your FTP client application to copy the USP ESD load file 
from your ESD load repository server to your workstation. The 
actual steps to copy the files will depend on your FTP client 
application. Following is an example of typical steps.

Example

1. At your workstation, change directories to the temporary 
directory.

2. Start an FTP session to the ESD load repository server. 

ATTENTION
Do not extract or uncompress files on the CS 2000 Management 
Tools server. The process requires additional disk space that may 
exceed the capacity of your server.
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3. Change the session to binary.

4. At the ESD load repository server, change directories to the 
dropbox with the USP ESD load file. 

5. Use the get command to transfer the USP ESD load file to 
the temporary directory on your workstation.

6. Quit the FTP session

3 Use a file archive program such as WinZip to extract a 
compressed version of new USP software from the ESD load file 
to the temporary directory. 

Response

The program extracts a compressed file with a .gz extension to 
a new directory in your temporary directory.

Example of name of compressed file

USPM110.110.R.NCL.NAP.VAULT.9.D.tar.gz.tape

4 Locate the compressed USP software file.

5 Rename the compressed USP- Compact software file to remove 
the .tape extension. 

Example of new file name

USPM110.110.R.NCL.NAP.VAULT.9.D.tar.gz

6 Use your file archive program to extract the new USP software 
to the temporary directory.

Response

The program extracts the new software into a new folder in the 
temporary directory.

7 Use the following table to determine your next step.

8 You have completed this procedure. Go to Upgrading the USP 
on page 13.

If you install new USP soft-
ware

Do

from your workstation step 8

from the CS 2000 
Management Tools server

Copying new USP software 
to the CS 2000 Management 
Tools server on page 29
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Copying new USP software to the CS 2000 Management Tools 
server

At your workstation

1 Establish a connection to the server through telnet or SSH, and 
log in using the root user id and password.

In a two-server configuration, log in to the active server using the 
physical IP address of the active server. Use the ubmstat 
command to make sure you are on the active server.

2 Determine if the server has a /data/esd_iso directory by typing

# ls /data/esd_iso 

and pressing the Enter key.

3 Use the following table to determine your next step.

4 Create the directory by typing 

# mkdir /data/esd_iso 

and pressing the Enter key.

5 Display the available disk space in the /data directory by typing

# df -k /data 

and pressing the Enter key.

Example response

6 Determine the number of megabytes of free space by dividing 
the number under avail by 1000. The result is the amount of 
available disk space in Mbytes in the directory.

ATTENTION
In a two-server configuration, copy the software files to the active 
server.

If the response Do

indicates no such directory exists step 4

displays the name of the directory step 5

Filesystem            kbytes    used   avail capacity  Mounted on

/dev/md/dsk/d2         3082223  144125 2876454   5%    /data

# df -k /data
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7 Use the following table to determine your next step.

8 Clear additional disk space before you continue with this 
procedure. Follow local office policy. If necessary, contact the 
next level of support. 

9 Log off of the CS 2000 Management Tools server. 

10 Use your FTP client application to copy the uncompressed USP 
software from your workstation to the /data/esd_iso directory on 
the CS 2000 Management Tools server. 

11 Confirm all directories and files for new USP software were 
copied to the /data/esd_iso directory of the CS 2000 
Management Tools server.

12

In the directory with new USP software, locate the file 
install.bin.

13 Set the file permissions by typing

# chmod 755 install.bin 

and pressing the Enter key. 

14 Confirm the file permissions were changed by typing

# ls -al install.bin 

and pressing the Enter key.

Response

The file install.bin has the permissions -rwxr-xr-x.

15 You have completed this procedure. Go to Upgrading the USP 
on page 13.

If the directory Do

does not have at least 500 MBytes 
of available disk space

step 8

has at least 500 MBytes of 
available disk space

step 9

ATTENTION
The following steps require you to change the permissions 
on a file on the CS 2000 Management Tools server. 
Depending on your FTP client application, you may need to 
quit the FTP client application and establish a telnet or 
SSH session to the server. 
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Upgrading the ABS and USP GUI on a Windows-based workstation

Use this procedure to upgrade the ABS and USP GUI on a 
Windows-based OAMP workstation. 

Prerequisites
This procedure has no prerequisites.

Action
Perform the following tasks to complete this procedure:

1. Uninstalling the ABS and USP GUI from Windows-based 
workstations on page 31

2. Installing the new ABS and USP GUI on a Windows-based 
workstation on page 33

3. If the workstation serves as the alternate boot server, the Signaling 
Server Monitor, Alternate Boot Server Configuration Manager, and 
the three Distinct servers start up automatically when the 
workstation restarts. 

If this is the first time to install ABS on this windows workstation, 
you need to configure three Distinct servers. For detailed steps, 
refer to Configuring the Distinct BOOTP, FTP and NFS Servers for 
Windows on page 36.

Uninstalling the ABS and USP GUI from Windows-based 
workstations

At the OAMP workstation

1 If you are upgrading ABS server, identify the current installation 
path. From Distinct FTP server window, select 
configure-->server-->export, then record the exported folder's 
path.

2 Close all open applications and exit the USP Distinct Servers (if 
running) and Signaling Server Monitor (if running).

3 Click the Windows Start button on your desktop taskbar.

CAUTION

The GUI will not function properly with non-ASCII 
based character sets. Ensure that the OAMP 
workstation is set to either English or German 
language character sets.
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4 On the Settings menu, select Control Panel.

5 In the Control Panel window, double-click Add/Remove 
Programs.

6 In the Change or Remove Programs tab of the Add/Remove 
Programs window, select Universal Signaling Point from the 
alphabetical list of programs. 

7 Click the Change/Remove button. A uninstall pop-up window 
appears prior to removing the application and its components.

8 Wait for the uninstall window to open and click Next when it 
appears.

9 Click Completely Uninstall, then click Next. All installed 
components will be uninstalled. 

If you want to uninstall ABS or USP GUI only, click Uninstall 
specific components. Then use the following table to 
determine your action:

10 Click Done.

11 This procedure is complete. Restart your computer and go to 
Installing the new ABS and USP GUI on a Windows-based 
workstation on page 33.

If Do

Uninstalling ABS uncheck USP Software Loads 
and ABS Manager, then click 
uninstall

Uninstalling USP GUI uncheck USP Graphical Inter-
face Client, then click uninstall
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Installing the new ABS and USP GUI on a Windows-based 
workstation

At the OAMP workstation

1 Close any open applications.

2 Use the following table to determine your next step.

3 Insert the USP Software CD-ROM disk into the CD-ROM drive.

4 Double-click the My Computer icon on your desktop.

5 Double-click the CD-ROM disk icon.

6 Double-click Install.exe.

Note: When adding the USP GUI on an NTST30DA 
workstation, install the GUI using the Add/Remove Programs 
utility in the Windows Control Panel.

7 At the Introduction window for the USP setup program, click 
Next. 

ATTENTION
Installing this USP software on a workstation other than your 
Nortel Networks-approved workstation may overwrite some 
system files used by other applications. This can cause failure of 
existing applications. Also, installing software other than Nortel 
Networks-approved applications on your USP OAMP workstation 
can cause failure of the USP application.

ATTENTION
When adding the ABS and USP GUI on an NTST30DA 
workstation, install the GUI using the Add/Remove Programs 
utility in the Windows Control Panel.

If the new USP software 
is located 

Do

on a CD step 3

in a directory on your PC Open the directory with the new 
USP software and go to step 6.
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8 Select the package(s) that you want to install on this workstation. 

• Select USP Software Loads and ABS manager if you want 
this workstation to act as the alternate boot server. 

Each USP system needs one workstation configured as an 
alternate boot server. Do not configure more than one 
alternate boot server for each USP system.

• Select USP Graphical User Interface Client if you want this 
workstation to be able to log into the USP site.

• Select USP User Manuals and Documentation Suite to install 
the complete collection of FCAPS documents, Marconi 
TNX-210 ATM Switch Manuals, and Interface Specifications.

• Select USP GR-310 Mediation Application to install a SEAS 
OSS Interface.

• Select Acrobat Reader if you do not have a version of Adobe 
Acrobat Reader installed on this workstation.

9 Select Next. If you select GR-310 Mediation Application, enter 
your Nortel Networks provided serial number when prompted by 
the system.

10 Select an Installation Directory and click Install.

If you selected the ABS pkg, the following pop-up will appear: 

Prior to installing the Alternate Boot Server 
Package please ensure that all unnecessary 
snapshots and old release loads (i.e. 
maintenance releases that are no longer in use) 
are deleted. This will ensure adequate disk 
space is available during the install procedure. 

Select OK and then select an installation directory. 

If this is to upgrade the ABS server, please select the installation 
directory where the old release was installed, refer to the 
installation path recorded in step 1 of Uninstalling the ABS and 
USP GUI from Windows-based workstations on page 31.

The Copying Program Files window appears with a status bar to 
show progress in copied files.

If you chose to install Acrobat reader, a Welcome window for the 
Adobe Acrobat Reader Setup Program appears. Adobe Acrobat 
Reader is required to view the Solution information. If Adobe 
Acrobat Reader is already installed on this workstation, click No. 
Click Yes to the “Are you sure” message. Proceed to the next 
step.
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11 Use the following table to determine your next step.

12 Click Next. The Acrobat Reader License Agreement appears.

13 Click Yes to accept the terms of the agreement. The Acrobat 
Reader Destination Location window appears.

14 Click Next.

Note: Do not modify the destination path for Acrobat Reader.

15 The Acrobat Reader Setup Complete window appears. Click 
OK.

16 Log in to the USP from the new release of the USP GUI and 
monitor the OAMP workstation for 10 minutes while logged into 
the USP. Check logs during this time. Your USP GUI is now 
upgraded. You will use the GUI to upgrade your USP software. 

Note: When you first connect the GUI it will detect that the lab 
is running a prior version and will logout and log back in 
automatically to re-initialize based on the older feature set (it 
is expecting the new release by default).

17 Use the following table to determine your next step.

18 You have completed this procedure If applicable, return to the 
higher-level procedure or task flow that directed you to this 
procedure.

If Do

you want to install Adobe 
Acrobat Reader

step 12

otherwise step 16

If you Do

freshly installed ABS soft-
ware during this procedure 

proceed to Configuring the 
Distinct BOOTP, FTP and 
NFS Servers for Windows on 
page 36

otherwise step 18
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Configuring the Distinct BOOTP, FTP and NFS Servers for 
Windows

At the OAMP workstation

1

If this is the initial install of the ABS, a pop-up window prompts 
you to create a password for the Alternate Boot Server 
Configuration Manager.

2 Click the Distinct BOOTP Server button on the taskbar to 
maximize the Distinct BOOTP Server window.

3 Click the Configure menu and select Administrator and then 
Login to display the Distinct BOOTP Login window.

4 Enter your administrator password in the Enter the administrator 
password field and click OK to log into the server.

The Distinct BOOTP Login window closes.

5 Click the Configure menu and select Server to display the 
Configure BOOTP window.

6 In the Addresses tab window, view the contents of the field at the 
bottom of the window, next to the Add, Modify, and Remove 
buttons. This field should contain the hexadecimal Ethernet 
hardware addresses of the RTC system nodes in your system.

7 Select the Ethernet hardware address that matches the Ethernet 
hardware address for the RTC system node in slot 12 of your 
system. The information for that Ethernet hardware address 
should appear in the various fields.

8 In the Boot File field, change the value to 
/c/ntssgusp/abs/sites/<site_name>/rtc1/rtcboot (site_name 

CAUTION

Make a record of the password immediately.

ATTENTION
For upgrading ABS server, if the installation directory is the 
same as the one before uninstallation, procedure 
Configuring the Distinct BOOTP, FTP and NFS Servers for 
Windows can be ignored.
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is the name of your system as it appears in the site configuration 
information).

9 Click Modify to save the changes.

10 Select the Ethernet hardware address that matches the Ethernet 
hardware address for the RTC system node in slot 15 of your 
system. The information for that Ethernet hardware address 
should appear in the various fields.

11 In the Boot File field, change the value to 
/c/ntssgusp/abs/sites/<site_name>/rtc2/rtcboot (site_name 
is the name of your system as it appears in the site configuration 
information).

12 Click Modify, then Apply to save the changes.

13 Open the Alternate Boot Server Configuration Manager.

14 Log in to the Alternate Boot Server Configuration Manager.

15 Under the File drop-down menu, select ABS Configuration.

16 Select a site from the Site list.

17 Confirm that the Alternate Boot Loads displayed for each RTC 
are for the pre-upgrade load. 

18 Confirm that the Alternate Boot Snapshot display is the snapshot 
taken earlier in this procedure. A pre-upgrade snapshot

19 Click Apply to save the changes.

20 Log out of the Alternate Boot Server Configuration Manager.

Configuring the FTP server

21 Click on the Distinct FTP Server in the task bar.

22 From the Distinct FTP Server window, select 
Configure->Administrator->Login.

23 In the query dialog box, type SERVICE for password and select 
OK.

24 From the Distinct FTP Server window, select 
Configure->Server.

25 From the Server Properties window, select the Users tab 
window.

• For User Name, enter ntssg.

• For User Password, enter 1ntssgstp (number 1 followed by 
ntssg in lowercase).
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• For Confirm Password, enter 1ntssgstp.

• Select Add.

26 From the Server Properties window, select the Exports tab 
window. Important: 

The Browse Button must be used to find the C:\ directory, do not 
type the choice into the field.

• Select ntssg from the Users droplist.

• For Folder, use Browser button to select C:\

• For Export Name, enter: /c

• Check all permissions (Download, Upload, List, Delete).

• Select Add.

27 From the Server Properties window, select OK.

28 From the Distinct FTP Server window, select 
Configure->Administrator->Logout.

29 Select OK.

30 Minimize the Distinct FTP Server to the Taskbar.

Configuring the NFS server

31 Click on the Distinct NFS Server in the task bar.

32 From the Distinct NFS Server window, select 
Configure->Administrator->Login.

33 In the query dialog box, type SERVICE for password and select 
OK.

34 From the Distinct NFS Server window, select 
Configure->Server.

35 From the Configure the NFS Server window, select the Groups 
tab window.

• For Group Name, enter ssg (in lower case).

• For Group ID, enter 453.

• Then select Add.

36 From the Configure the NFS Server window, select the Users 
tab window.

• For User Name, enter ntssg (in lower case).

• For User Password, enter 1ntssgstp.

• For User ID, enter 50015.
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• For Group Name, select ssg from the droplist.

• Select Add.

37 From the Configure the NFS Server window, select the Exports 
tab window.

• For Path, use Browser button to select C:\ and double-click 
on C:\ .

• Select OK. In the Path Edit Box, ensure that C:\ is the only 
entry.

• For Owner, select ntssg from the droplist.

• Show Hidden Files attribute is not checked.

• Show System Files attribute is not checked.

• Read, write, execute for Owner permissions is checked.

• Read, execute for Group permissions is checked.

• Read, execute for World permissions is checked.

• Select Export.

• Select Apply.

38 From the Configure the NFS Server window, select the General 
tab window.

• Enter the path of the Log Folder as C:\PROGRAM 
FILES\DISTINCT\LOG

• Under Prompt Dialogs, the On Application Exit is checked.

• The Set Spool Folder is not checked.

• From the Configure the NFS Server window, select OK.

39 From the Distinct NFS Server window, select 
Configure->Administrator->Logout.

40 When a window Are you sure you want to Logout? appears, 
Select Yes.

41 Minimize the Distinct NFS Server to the Taskbar.

42 This procedure is complete. If applicable, return to the 
higher-level procedure or task flow that directed you to this 
procedure.
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Upgrading the USP GUI on a CS 2000 Management Tools-based 
OAMP workstation

Use this procedure to use console mode to upgrade the USP GUI on a 
CS 2000 Management Tools OAMP workstation.

Prerequisites
This procedure has no prerequisites.

Action
Perform the following tasks to complete this procedure:

1. Uninstalling the USP GUI on the CS 2000 Management Tools 
workstation on page 41

2. Installing the new USP GUI on the CS 2000 Management Tools 
workstation on page 41

CAUTION

The GUI may not function properly with non-ASCII 
based character sets. Ensure that the OAMP 
workstation is set to either English or German 
language character sets.

ATTENTION
If you installed the USP ABS software and GUI during the 
CS 2000 Management Tools upgrade, use the procedure Using 
the Upgrade Wizard on page 91 to upgrade the USP GUI. 
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Uninstalling the USP GUI on the CS 2000 Management Tools 
workstation

At the OAMP workstation

1 Launch the USP uninstall procedure.

> cd <original install path>/ntssgusp/ 

where

original install path
is /data/usp for offices at USP10 and lower

is /opt/usp for offices at USP11 and higher

>./Uninstall_Universal_Signaling_Point -i 
console 

Note: A space precedes -i in the above command line.

2 Press Enter in the Introduction window.

3 In the Uninstall Options step, press Enter to uninstall the USP 
GUI.

4 Press Enter to complete the installation and to exit.

5 You have uninstalled the USP GUI. Go to Installing the new USP 
GUI on the CS 2000 Management Tools workstation on page 41.

Installing the new USP GUI on the CS 2000 Management Tools 
workstation

At the OAMP workstation

1 Change directories:

2 List the directory and locate the install.bin file:

>ls 

3 Launch the installation program, which can take several minutes 
to finish launching.

>./install.bin -i console 

4 Press Enter in the Introduction step.

If the new USP-Compact 
software is located 

Do

in a CD >cd /cdrom/cdrom0 

on the CS 2000 Management 
Tools server

>cd /data/esd_iso
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5 Press Enter in the Component Selection step.

6 In the Pre-Installation Summary step, confirm that USP 
Graphical Interface Client is included in Software Components. 
Press Enter to continue.

7 Press Enter in the Installation Directory step to accept the 
default installation directory.

Note: Executing the Component Installation step can take 
several minutes to run.

8 Press Enter to complete the Installation and exit.

9 You have completed this procedure. Return to Upgrading the 
USP on page 13.
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Upgrading the ABS software on the CS 2000 Management Tools 
server

Use this procedure to install or upgrade the alternate boot server (ABS) 
software on the SPFS-based server that is hosting the CS 2000 
Management Tools. 

Prerequisites
This procedure has the following prerequisites:

• If ABS software is currently installed on the CS 2000 Management 
Tools server, this procedure includes steps to backup the existing 
ABS software to a backup directory on the server.

— Make sure you know the location of the backup directory. Nortel 
recommends a directory with unique name, such as 
usp_backup.

— Make sure you have write access to the backup directory. 

• Know the existing install path for USP software on the CS 2000 
Management Tools server before you begin this procedure. 

— For offices at USP10 and lower, the default USP install path is 
/data/usp.

— For offices at USP11 and higher, the default USP install path is 
/opt/usp.

To identify the existing install path, execute the more bootptab 
command from the /etc directory on the CS 2000 Management 
Tools server. The values for hd or bf identify the existing install path. 

• If you install the USP ABS on the CS 2000 Management Tools 
server using the GUI mode, you must export the X-Windows display 
of the CS 2000 Management Tools server to a remote workstation. 
If you are using a Windows-based workstation, use X-Windows 
server software such as Hummingbird’s Exceed. Refer to 
Configuring Exceed for an upgrade on page 58.

Action
An ABS software upgrade consists of the following tasks:

1. Preparing to upgrade ABS software on page 44

2. Upgrading the ABS software on page 45

3. Completing the ABS software upgrade on page 55
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Preparing to upgrade ABS software
The steps to prepare for an upgrade of ABS software depend on the 
method you received ABS software. Nortel delivers ABS software 
through electronic software delivery (ESD) and compact disk (CD).

Use one of the following procedures:

• If you received ABS software through ESD, use procedure 
Preparing to upgrade ABS software using an ESD load on page 44.

• If you received ABS software on CD and are accessing the server 
from a local workstation at the CS 2000 Management Tools server, 
use procedure Preparing to upgrade ABS software from a CD at a 
local workstation on page 44.

Preparing to upgrade ABS software using an ESD load

At your workstation

1 Transfer the new software from the ESD load repository server. 

For detailed steps, refer to procedure Installing Using ESD on 
page 72.

2 From the /opt/usp/iso_esd directory, set the file permissions by 
typing

chmod 755 install.bin 

and pressing the Enter key.

3 View the permissions on the install.bin file and confirm the 
change was successful by typing

ls -l install.bin

and pressing the Enter key.

Example of response

RWXR-XR-X 2 FIELD maint2 *date* *time* 
install.bin

4 You have prepared ABS software for the upgrade. Go to 
Upgrading the ABS software on page 45. 

Preparing to upgrade ABS software from a CD at a local 
workstation

At the CS 2000 Management Tools server

1 Insert the USP software CD in the CD drive of the CS 2000 
Management Tools server. If CS 2000 Management Tools 
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resides on a high-availability cluster, insert the CD in the CD 
drive of active server. 

At your workstation

2 Log in to the CS 2000 Management Tools server as the root 
user.

For detailed steps, refer to procedure Logging in to an 
SPFS-based server on page 77

3 Change directories by typing

cd /cdrom/cdrom0 

and pressing the Enter key.

4 Verify the install.bin file is present by typing

ls 

and pressing the Enter key.

5 You have prepared ABS software for the upgrade. Go to 
Upgrading the ABS software on page 45. 

Upgrading the ABS software
Upgrade the ABS software. Use one of the following procedures:

• To upgrade ABS software in console mode, go to Upgrading the 
ABS software in console mode on page 45.

• To upgrade ABS software in GUI mode, go to Upgrading the ABS 
software in GUI mode on page 50.

Upgrading the ABS software in console mode

At the workstation

1 Login to the CS 2000 Management Tools server as FIELD then 
change to the root user.

For detailed steps, refer to procedure Logging in to an 
SPFS-based server on page 77.

2 Use the following table to determine your next step.

If ABS is Do

currently installed on the server step 3

not installed on the server step 6
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3 Change to the ABS directory by typing

cd /<original USP install path>/ntssgusp/abs/ 

and pressing the Enter key.

where

<original USP install path> is one of the following:

• /data/usp for offices at USP10 and lower

• /opt/usp for offices at USP11 and higher

4 Copy the sites folder by typing

cp -r sites <backup path> 

and pressing the Enter key.

where

<backup path> is ~/usp_backup/ or the path to your backup 
directory for ABS software

5 Copy the releases folder by typing

cp -r releases <backup path> 

and pressing the Enter key.

where

<backup path> is ~/usp_backup/ or the path to your backup 
directory for ABS software

6 Change directories by typing

cd /<original USP install path>/ntssgusp 

and pressing the Enter key.

where

<original USP install path> is one of the following:

• /data/usp for offices at USP10 and lower

• /opt/usp for offices at USP11 and higher

7 Start the uninstall wizard by typing

./Uninstall_Universal_Signaling_Point -i 
console 

and pressing the Enter key.

8 When the Introduction panel appears, click Enter.

9 Wait for the uninstall wizard to open, which can take two to three 
minutes.
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10 When the uninstall wizard opens, type 1 to completely remove 
all USP software components, and press Enter to continue. 

Note: If you want to uninstall only ABS, type 2, select USP 
Software Loads and ABS Manager to uninstall, and press 
Enter to continue.

11 When the Uninstall Complete panel appears, press the Enter 
key to exit the uninstall process.

12 Change directory by typing

cd /<original USP install path>/ntssgusp/ 

and pressing the Enter key.

where

<original USP install path> is one of the following:

• /data/usp for offices at USP10 and lower

• /opt/usp for offices at USP11 and higher

13 Make sure the removal was successful by typing

ls -l |grep ABS 

and pressing the Enter key.

14 Use the following table to determine your next step.

15 Change to the directory with the new ABS software. Use the 
following table to determine the correct command.

If Do

one or more files are listed Return to step 7. If you are 
unable to uninstall the 
software on a second 
attempt, contact your next 
level of support.

otherwise step 15

If you received ABS 
software

Do

through ESD type cd /opt/usp/iso_esd/
<installation_directory/ 
where 
<installation_directory> is the 
directory where the software 
was extracted, for example, 
USP11.1.0.16F
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16 Launch the install wizard. Enter

./install.bin -i console 

and pressing the Enter key.

The application can take 2 to 3 minutes to launch.

17 When the Introduction panel appears, click Enter.

The Component Selection panel appears.

Example of Component Selection panel

1 - [ ] USP Software loads and ABS Manager

2 - [X] USP Graphical Interface Client

3 - [X] USP User Manuals and Documentation Suite

4 - [ ] USP GR-310 Mediation Application

Enter software component numbers and press 
<Enter> to continue. 

Components 2 and 3 are selected by default.

To view a detailed description of each software component, 
enter '?<component_number>'.

18 Use the following table to determine your next step.

19 Select the USP Software loads and ABS Manager component in 
addition to components 2 and 3, which are selected by default, 
by typing 

1 

and pressing the Enter key.

A pre-installation summary appears which displays the selected 
components.

on CD type cd /cdrom/cdrom0

If you are Do

using the CS 2000 Management Tools 
webstart application

step 19

not using the CS 2000 
ManagementTools webstart 
application

step 21

If you received ABS 
software

Do
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Example of Pre-Installation Summary 

Please review the selected software components

Product Name:

    Universal Signaling Point v11.1

Software Components:

    USP Software Loads and ABS Manager,

    USP Graphical Interface Client ,

    USP User Manuals and Documentation Suite

 
Press <ENTER> to continue:

20 Press Enter and go to step 23.

21 Select the USP Software loads and ABS Manager component in 
addition to component 3, which is selected by default, and 
deselect the USP Graphical Interface Client component, by 
typing

1,2 

and pressing the Enter key.

A pre-installation summary appears which displays the selected 
components.

Example of Pre-Installation Summary 

Please review the selected software components

Product Name:

    Universal Signaling Point v11.1

Software Components:

    USP Software Loads and ABS Manager,

    USP User Manuals and Documentation Suite 

Press <ENTER> to continue:

22 Press Enter to continue.

23 If a disk space warning displays, press Enter.

24 On the Install Complete panel, press Enter.

25 Change directories by typing

cd /opt/usp/ntssgusp/abs 

and pressing the Enter key.
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26 Verify the new version of ABS software. Launch the updated 
console-based ABS Configuration Manager application by 
typing

./console_abs 

and pressing the Enter key.

It takes approximately 2 to 3 minutes for the application to launch 
and be fully populated with data.

27 Log in to the ABS by typing

ABSCM> login 

and pressing the Enter key.

28 When prompted, enter the password for the ABS.

Note: Refer to the ABS_Specification.pdf document for all 
the command syntax of the console-based ABS Configuration 
manager.

29 Log out of the ABS by typing

ABSCM> exit 

and pressing the Enter key.

30 When prompted, confirm you want to log out of the ABS by 
typing

Y 

and pressing the Enter key.

31 Return to the root directory by typing

cd / 

and pressing the Enter key.

32 You have completed this procedure. Go to Completing the ABS 
software upgrade on page 55.

Upgrading the ABS software in GUI mode

At the workstation

1 Ensure that your X-Windows server software is running and that 
host access permissions are allowed for the CS 2000 
Management Tools server. Refer to your X-Windows server 
software manual for details.

2 Login to the CS 2000 Management Tools server as FIELD.

3 Once logged in, change to the root user by typing:

su - 
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and pressing the Enter key.

4 Set the display variable by typing:

DISPLAY=<IP address of your PC>:0.0 

and pressing the Enter key.

Note: You can find the IP address of the PC you are using by 
entering the command ipconfig from a DOS window. If you 
are using Contivity or similar software to connect to the 
network, make sure you use the IP address assigned to your 
PC by Contivity and not the IP address assigned to you by 
your LAN.

5 Export the display by typing:

export DISPLAY 

and pressing the Enter key.

6 Confirm the export by typing:

echo $DISPLAY 

and pressing the Enter key.

7 Use the following table to determine your next step.

8 Change to the ABS directory by typing

cd /<original USP install path>/ntssgusp/abs/ 

and pressing the Enter key.

where

<original USP install path> is one of the following:

• /data/usp for offices at USP10 and lower

• /opt/usp for offices at USP11 and higher

9 Copy the sites folder by typing

cp -r sites <backup path> 

and pressing the Enter key.

where

<backup path> is ~/usp_backup or the path to your backup 
directory for ABS software

If ABS is Do

currently installed on the server step 8

not installed on the server step 10
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10 Change directories by typing

cd /<original USP install path>/ntssgusp 

and pressing the Enter key.

where

<original USP install path> is one of the following:

• /data/usp for offices at USP10 and lower

• /opt/usp for offices at USP11 and higher

11 Start the install wizard by typing

./Uninstall_Universal_Signaling_Point -i gui & 

and pressing the Enter key.

12 Wait for the install wizard to open. The application can take two 
to three minutes to launch and receive data.

13 When the uninstall wizard opens, click Next, then click 
Completely remove all USP software components.

Note: If you want to uninstall ABS only, you can do the 
following: When the uninstall wizard opens, click Choose 
specific USP components to uninstall, then select USP 
Software Loads and ABS Manager to uninstall. 

14 Change directories by typing

cd /<original USP install path>/ntssgusp/abs 

and pressing the Enter key.

where

<original USP install path> is one of the following:

• /data/usp for offices at USP10 and lower

• /opt/usp for offices at USP11 and higher

15 Try to launch the ABS Configuration Manager to ensure the 
removal was successful by typing

./ABS 

and pressing the Enter key.
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16 Use the following table to determine your next step.

17 Change to the directory with the new ABS software. Use the 
following table to determine the correct command.

18 Launch the install wizard by typing

./install.bin 

and pressing the Enter key.

The application can take 2 to 3 minutes to launch.

Note: If the following error appears, the DISPLAY 
environment variable is not set up correctly.

Invocation of this Java Application has caused 
an InvocationTargetException. This 
application will now exit. (LAX)

Stack Trace:

at java.lang.Class.forName0(Native Method)

at java.lang.Class.forName (Class.java:130)

If any other errors occur, ensure that your X-Windows server 
software is running and that host access permissions are 
allowed for the CS 2000 Management Tools server. Refer to 
your X-Windows software manual for details.

If the errors persist, contact your Nortel support 
representative.

19 When the Introduction panel appears, click Next.

20 Select the USP Software Loads and ABS Manager package 
on the Package Selection panel. If using the CS 2000 
Management Tools webstart application, also select the USP 

If the ABS Configuration 
Manager

Do

launches Return to step 11. If you are 
unable to uninstall the software 
on a second attempt, contact 
your next level of support.

fails to launch step 17

If you receive ABS software Do

through ESD cd /opt/usp/iso_esd

on CD cd /opt/usp/absCD
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Graphical Interface Client package. Do not select other 
packages. Click Install.

21 If a disk space warning displays, click OK.

22 On the Install Complete panel, click Done.

23 Login to the CS 2000 Management Tools server as FIELD.

24 Change directories by typing

cd /opt/usp/ntssgusp/abs 

and pressing the Enter key.

25 Ensure that your X-Windows software is running and that host 
access permissions are allowed for the CS 2000 Management 
Tools server.

26 Ensure that the DISPLAY environment variable is set up 
correctly.

27 Launch the updated graphically-based ABS Configuration 
Manager application by typing 

./ABS & 

and pressing the Enter key.

It takes approximately 2 to 3 minutes for the application to launch 
and be fully populated with data.

28 Click File>Login, and as this is the first time you are launching 
the new release of ABS, set the password when prompted to set 
and confirm the password. 

29 When prompted, enter the password and press enter to login 
into ABS.

30 Click File>Exit, then a prompt indicates

Exit Alternate Boot Server Configuration 
Manager?

Click Yes to exit the ABS Manager.

31 Exit to the root directory by typing

cd / 

and pressing the Enter key.

32 You have upgraded ABS software. Go to Completing the ABS 
software upgrade on page 55
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Completing the ABS software upgrade
Perform the following procedure to complete the upgrade of ABS 
software.

Completing an ABS software upgrade

At your workstation

1 Use the following table to determine your next step.

2 Delete the temporary files by typing rm -rf 
/opt/usp/iso_esd and press the Enter key.

3 Proceed to step 6.

4 Eject the USP Software CD-ROM disk from the drive by typing

eject cdrom 

and pressing the Enter key.

5 Remove the CD and close the drive.

6 You have completed the upgrade of ABS software on the 
CS 2000 Management Tools server. Make sure that ABS is 
working correctly. Refer to Verifying correct ABS settings for the 
USP (RTC) on page 55.

Verifying correct ABS settings for the USP (RTC)

From the BOOTP server

1 You can use the USP EM PC to perform step 2 to step 8 or log 
in to the CMT and perform the steps.

2 Establish a telnet connection to RTC-12 or RTC-15.

3 Log in with a valid user name and password.

4 Verify the settings on RTC-12 by typing

admin abs test rtc-12  

and pressing the Enter key.

5 When prompted, confirm the execution of the command by 
typing

y 

If you received software Do

received software through ESD step 2

working on a local workstation step 4
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and pressing the Enter key.

If the settings are correct and the test is successful, the prompt 
returns after a few seconds. Otherwise, the system displays the 
failure before the prompt returns. If the test is not successful, 
contact your next level of support.

6 Verify the settings on RTC-15 by typing

admin abs test rtc-15  

and pressing the Enter key.

7 When prompted, confirm the execution of the command by 
typing

y 

and pressing the Enter key.

If the settings are correct and the test is successful, the prompt 
returns after a few seconds. Otherwise, the system displays the 
failure before the prompt returns. If the test is not successful, 
contact your next level of support.

8 Display all ABS settings by typing

admin abs show all  

and pressing the Enter key.

9 Verify the following information:

• the rtc-12-load-server-ipaddress is the address of the CMT 
ABS

• the rtc-15-load-server-ipaddress is the address of the CMT 
ABS

• the correct RTC loads and snapshot are selected

• all other output information is correct

Example response for a site named "Enterprise" 

~CMD>admin abs show all

rtc-12-loadname = ss7rtc_ppc750_11_00_00_36g

rtc-15-loadname = ss7rtc_ppc750_11_00_00_36g

snapshot-version = v11.0.0

snapshot-name = v11.0.0

snapshot-description = USP11.0.0 Default 
Database

virtual-index = 1
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rtc-12-load-server-ipaddress = 47.135.60.47

rtc-12-bootfile = 
/data/usp/ntssgusp/abs/sites/enterprise/rtc1/r
tcboot

rtc-12-ipaddress = 47.135.60.88

rtc-12-gateway-ipaddress = 47.135.60.1

rtc-12-subnet-mask = 255.255.252.0

rtc-15-load-server-ipaddress = 47.135.60.47

rtc-15-bootfile = 
/data/usp/ntssgusp/abs/sites/enterprise/rtc2/r
tcboot

rtc-15-ipaddress = 47.135.60.89

rtc-15-gateway-ipaddress = 47.135.60.1

rtc-15-subnet-mask = 255.255.252.0

rtc-12-last-test-result = alternate-boot-server 
test completed successfully

rtc-15-last-test-result = alternate-boot-server 
test completed successfully

~CMD>

10 Use the following table to determine your next step.

11 You have completed this procedure. If applicable, return to the 
higher level task or procedure that directed you to this 
procedure.

If Do

the information in the system 
response is correct

step 11

otherwise contact your next level of 
support
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Configuring Exceed for an upgrade

Perform the following procedure to configure the Exceed application for 
an upgrade of alternate boot server (ABS) software.

Prerequisites
Familiarity with starting the Exceed Xconfig application. Depending on 
the setup of your PC, you can start Xconfig through any of the following 
methods:

• Double-click a desktop shortcut.

• Select the menu option from Programs->Exceed or 
Programs->Hummingbird

• Double-click the xconfig.exe file in the Exceed folder.

• Type the directory path and name of the xconfig.exe file in 
Start->Run or a DOS prompt. 

Action
The following configuration steps apply to the Hummingbird version 
10.0.0.0. For other versions please consult your Hummingbird 
documentation.

Configuring Exceed for an upgrade

At your PC

1 Start the Exceed Xconfig application. 

Response

The Xconfig window opens.

2 Switch to "classic view" and select the Security icon. 

Response

The Security window opens.

3 Under Host Access Control List, choose host access. Select the 
Green check mark on the toolbar to save and exit. 

Response

The Security window closes and the Xconfig window opens.

4 Select the Communication icon. 

Response

The Communication window opens.
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5 Make sure Mode is set to Passive. Select the Green check mark 
on the toolbar to save and exit. 

Response

The Communication window closes and the Xconfig window 
opens.

6 Double-click the Screen Definition window.

Response

The Screen Definition window opens.

7 Select the tab Screen 0.

8 Under Window Mode, make sure Multiple is selected.  Select the 
Green check mark on the toolbar to save and exit. 

Response

The Screen Definition window closes and the Xconfig window 
opens.

9 Close the Xconfig window. From the menu bar, select File->Exit. 

Response

The Xconfig window closes.

10 You have completed this procedure.
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Transferring and mounting an ISO image on an SPFS-based server

Application
Use this procedure to perform the following tasks:

• uncompress the software load on your ESD load repository server

• transfer an iso image file from your ESD load repository server to 
the SSPFS-based server

• mount the image on the SSPFS-based server

Nortel delivers a software load in a compressed file through Electronic 
Software Delivery (ESD) to a local ESD load repository server. Once 
the file is uncompressed, the software load and patches are then 
available as International Standard of Organization (ISO) 
9660-compliant images for transfer to an SSPFS-based server. 

Only the files with a .iso extension need to be transferred to the 
SSPFS-based server. The other files contained in the uncompressed 
file are for information purposes and do not need to be transferred to 
the SSPFS-based server.

The patch iso image file contains a P in its name, for example, 
CS2MP080, when delivered with an NCL, or an X, for example, 
CS2MX080.iso, when delivered with an MNCL.

Prerequisites
This procedure has the following prerequisites:

• The ESD load must be available on your ESD load repository 
server.

• You must know the name or IP address of the load repository server 
and the location of the dropbox directory on the server.

• You must know the name or IP address of the SPFS-based server. 

• You must know the root password to the SPFS-based server.

This procedure requires you to confirm the availability of disk space on 
the SPFS-based server. If the server does not have the required 
amount of available disk space, follow your local office policy to clear 
space. If you do not know your policy or cannot clear the required 
amount of available disk space, contact your next level of support.
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Action
Use the flowchart as an overview of the tasks required to complete this 
procedure. Use the step-by-step instructions to complete the 
procedure. 
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Overview of steps to transfer and mount an ISO image to an SPFS-based server

Make sure the SPFS 
server has the correct 
directory.

Start an FTP session 
with the repository 
server.

Download the 
uncompressed image 
files to the correct direc-
tory

Mount the image.

Continue with upgrade

Make sure you are 
logged in to the active 
server.

Does the 
SPFS server 
have enough 
disk space?

Clear additional disk 
space on the SPFS 
server.

Start

Do you have a 
two-server 

configuration?

Y

N

Y

N

Uncompress the ESD 
load on the ESD load 
repository server.
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Uncompressing the load on the ESD load repository server

At the ESD load repository server

1 Log in to the ESD load repository server, and change directory 
to the drop box location.

Note: Ensure you log in with a user ID that has permission to 
uncompress files.

2 List the contents of the drop box:

ls *.gz 

3 Locate the file you want to uncompress.

4 Uncompress the file:

gzip -d <esd_filename>.tar.gz 

where

esd_filename
is the name of the ESD software load, for example: 

SPFS0091.91.LAB.NCL.NAP.VAULT.1.D, which is the 
esd_filename for SPFS

IEMS0091.91.LAB.NCL.NAP.VAULT.2.D, which is the 
esd_filename for IEMS

UCBM0010.10.LAB.NCL.NAP.VAULT.5.D, which is the 
esd_filename for CBM

CS2M0091.91.LAB.NCL.NAP.VAULT.1.D, which is the 
esd_filename for CS 2000 Management Tools

5 List the uncompressed file:

ls *.tar 

6 Unpack the file:

tar -xvf <esd_filename>.tar 

where

esd_filename
is the name of the ESD software load, for example: 

SPFS0091.91.LAB.NCL.NAP.VAULT.1.D, which is the 
esd_filename for SPFS

IEMS0091.91.LAB.NCL.NAP.VAULT.2.D, which is the 
esd_filename for IEMS
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UCBM0010.10.LAB.NCL.NAP.VAULT.5.D, which is the 
esd_filename for CBM

CS2M0091.91.LAB.NCL.NAP.VAULT.1.D, which is the 
esd_filename for CS 2000 Management Tools

The unpacked file is a directory that contains the iso image files.

7 Log out of the ESD load repository server.

8 Perform the steps under Transferring an ISO image to an 
SPFS-based server on page 64 to continue with this procedure.

Transferring an ISO image to an SPFS-based server

At your workstation

1 Establish a connection to the SPFS-based server through telnet 
or SSH, and log in using the root user ID and password.

In a two-server configuration, log in to the active server using the 
physical IP address of the active server, and ensure you are on 
the active server using the ubmstat command.

For detailed steps, refer to procedure Logging in to an 
SPFS-based server on page 77.

2 Make sure the server has the correct directories. Use the 
following table as reference to identify the directory required for 
the SPFS-based server type (component) to which the ISO 
image is to be transferred. 

ATTENTION
In a two-server configuration, you will transfer the ISO image to 
the active server.

Component Directory path

ERS 8600 /swd

GWC /gwc

All other components /data/esd_iso
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List the directory for your component:

ls <directory> 

where

directory
is /swd, /gwc, or /data/esd_iso

3 Use the following table to determine your next step.

4 Create the directory:

mkdir <directory> 

where

directory
is /swd, /gwc, or /data/esd_iso

5 Display the available disk space in the directory:

df -k <directory> 

where

directory
is /swd, /gwc, or /data

Example response

6 Record the amount of available disk space, which is provided in 
kilobytes. You will need the information later in this procedure.

7 Change directory:

cd <directory> 

where

directory
is /swd, /gwc, or /data/esd_iso

If the response Do

indicates no such directory 
exists

step 4

displays the name of the 
directory

step 5

Filesystem            kbytes    used   avail capacity  Mounted on

/dev/md/dsk/d2         3082223  144125 2876454   5%    /data

# df -k /data
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8 Start an FTP session with the ESD repository server:

ftp <ESD_repository_server_ip> 

where

ESD_repository_server_ip
is the machine owned by the operating company that was 
selected to be the destination for ESD software.

9 When prompted, enter your user ID and password.

10 List the directories on the ESD repository server:

ftp> ls 

11 Change directory to the drop box directory:

ftp> cd <dropbox_directory> 

where

dropbox_directory
is the name of the your dropbox directory.

12 List the contents of the drop box:

ftp> ls -l

13 Change to the directory that contains the iso image files:

ftp> cd <esd_filename_directory> 

where

esd_filename_directory
is the directory that contains the iso image files, for 
example: 

SPFS0091.91.LAB.NCL.NAP.VAULT.1.D, for SPFS

IEMS0091.91.LAB.NCL.NAP.VAULT.2.D, for IEMS

UCBM0010.10.LAB.NCL.NAP.VAULT.5.D, for CBM

CS2M0091.91.LAB.NCL.NAP.VAULT.1.D, for CS 2000 
Management Tools

14 Locate the load or patch iso image file you want to transfer, and 
identify the size of the file, which is provided in bytes.

Note 1: Divide the number of bytes by 1024 to convert the 
size to kilobytes.

Note 2: The patch iso image file contains a P in its name, for 
example, CS2MP080, when delivered with an NCL, or an X, 
for example, CS2MX080.iso, when delivered with an MNCL.
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15 Compare the size of the iso image file with the amount of 
available space you recorded in step 6. 

16 Use the following table to determine your next step.

17 Clear additional disk space following local office policy, before 
you continue with this procedure. If necessary, contact your next 
level of support. 

18 Change the transfer mode to binary:

ftp> bin 

19 Transfer the iso image file to the SPFS-based server:

ftp> get <iso_image> 

where

iso_image
is the full name of the iso image file

Note: Do not transfer any file with a .tar.gz extension.

20 End the FTP session:

ftp> bye 

21 List the contents of the directory to ensure the files successfully 
transferred to the server:

ls -l

You are now ready to mount the iso image on the server.

22 Perform the steps under Mounting an ISO image on an 
SPFS-based server on page 67 to complete this procedure.

Mounting an ISO image on an SPFS-based server

If Do

the server has enough 
available disk space

step 18

otherwise step 17

ATTENTION
In a two-server configuration, you will mount the ISO image on the 
inactive server with the exception of the APS, CEM, Media 
Server 2000, GWC, SAM21, MG 9000 nodes (cards) ISO images, 
and Patch Media ISO images, which you will mount on the active 
server. 
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At your workstation

1 Use the following table to determine your first step.

2 Use the following table to determine your next step.

3 Establish a connection to the inactive server through telnet or 
SSH using the physical IP address of the inactive server, log in 
using the root user ID and password, and ensure you are on the 
inactive server using the ubmstat command. 

For detailed steps, refer to procedure Logging in to an 
SPFS-based server on page 77.

4 Start the command line interface:

cli 

5 Enter the number next to the Other option in the menu.

6 Enter the number next to the mount_image option in the menu.

7 Use the following table to determine your next step.

8 Enter the number next to the umount_image option in the menu 
and retry step 6.

Note: If either command is unsuccessful a second time, 
contact your next level of support.

If Do

you have a two-server 
configuration

step 2

otherwise step 4

If Do

you are mounting the APS, 
CEM, Media Server 2000, 
GWC, SAM21, MG 9000 
nodes (cards) ISO image, or 
Patch Media ISO image

step 4

otherwise step 3

If the system response is Do

Enter full path to 
ISO image

step 9

ISO image Already 
Mounted

step 8
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9 When prompted, enter the full path name of the iso image on the 
server:

<directory_path>/<iso_image> 

where

directory_path
is /swd, /gwc, or /data/esd_iso

iso_image
is the full name of the ISO image file

Note 1: Do not attempt to change directories to the /tmpmnt 
directory until the mount command is complete.

Note 2: Record the path of the ISO image file for ISO image 
file removal.
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10 Use the following table to determine your next step.

11 Exit each menu level of the command line interface:

select - x 

If the response is Do

It is very important 
for the user of this 
command to know that 
if you mount an iso 
image, you must 
unmount the image 
before removing the 
image file. If the 
file is deleted while 
the operating system 
has it mounted, it 
can be harmful to the 
runtime applications 
on this unit.

step 11

Provided full path to 
ISO image does not 
exist

Verify the location and name 
of the image and retry step 8.

Error creating the 
image device location

Retry step 8. An operating 
system error with the 
loopback file driver occurred. 
If the command fails a 
second time, contact your 
next level of support.

ERROR MOUNTING 
<ESD_filename>

This response indicates that 
either the iso file is corrupt, 
or the /tmpmnt directory has 
been deleted. 

Exit each menu level of the 
command line interface to 
eventually return to the root 
level prompt by typing 
select - x 

Repeat the steps under 
Transferring an ISO image to 
an SPFS-based server on 
page 64. If the procedure 
fails a second time, contact 
your next level of support.
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12 You have completed this procedure. If applicable, return to the 
high level task or procedure that directed you to this procedure.
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Installing Using ESD

You can use a PC or Solaris to install the USP software. The following 
procedure is required to load the installation files onto the respective 
platforms.

Prerequisites
At least 500 MBytes must be available on the destination system to 
accommodate the USP install. 

The workstation must be equipped with an FTP client application, such 
as WS FTP Pro or WinSCP, that supports the recursive transfer of 
directory structures.

Action
Perform the following tasks in the order they are presented, to prepare 
for a USP software installation:

• Uncompressing the load on the ESD load repository server

• Transferring the uncompressed file to the CMT or Transferring the 
uncompressed file to Windows

Uncompressing the load on the ESD load repository server

At the ESD load repository server

1 Log in to the ESD load repository server, and change directory 
to the drop box location.

Note: Ensure you log in with a user ID that has permission to 
uncompress files.

2 List the contents of the drop box.

ls *.gz 

3 Locate the file you want to uncompress.

4 Uncompress the file.

gzip -d <esd_filename>.tar.gz 

where

esd_filename
is the name of the ESD software load, for example, 
USP11.1.0.NCL.NAP.VAULT.1.D

5 List the uncompressed file.

ls *.tar 
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6 Unpack the file.

tar -xvf <esd_filename>.tar 

where

esd_filename
is the name of the ESD software load, for example, 
USP11.1.0.NCL.NAP.VAULT.1.D

The unpacked file is a directory that contains the USP 
installation software, for example 
USP11.1.0.NCL.NAP.VAULT.1.D.

7 Change to the directory that contains the USP installation 
software.

cd <esd_filename> 

where

esd_filename
is the name of the directory that contains the USP 
installation software, for example, 
USP11.1.0.NCL.NAP.VAULT.1.D

8 Remove the .tape suffix from the USP package.

mv <usp_sys_filename>.tar.gz.tape 
<usp_sys_filename>.tar.gz 

where

usp_sys_filename
is the name of the USP package, for example, 
usp11.1.0_sys

9 Uncompress the file.

gzip -d <usp_sys_filename>.tar.gz 

where

usp_sys_filename
is the name of the USP package, for example, 
usp11.1.0_sys

10 Unpack the file.

tar -xvf <usp_sys_filename>.tar 

where

usp_sys_filename
is the name of the USP package, for example, 
usp11.1.0_sys

11 Log out of the ESD load repository server.
Nortel USP Upgrades



Nortel Networks Confidential74Copyright © 2006, Nortel Networks
12 Use the following table to determine your next step.

Transferring the uncompressed file to the CMT

At a PC terminal

1 Make a temporary directory to store the ESD software on the 
PC.

c:/usp/loads 

2 Change directory to the newly created directory.

3 Use your FTP client application to transfer the uncompressed 
USP software from the ESD load repository server to the 
directory you created in step 1.

Before the transfer, ensure your FTP client is in binary mode.

At the CMT server

4 Log in to the CMT server using the FIELD account and change 
to the root user.

For detailed steps, refer to procedure Logging in to an 
SPFS-based server on page 77.

5 Determine the usp install directory:

# cat /opt/proftpd/etc/proftpd.conf |grep usp 

6 Use the following table to determine your next step.

7 Create a temporary directory to store the ESD software:

# mkdir /data/usp/iso_esd 

8 Change directory to the newly created location:

# cd /data/usp/iso_esd 

If you are upgrading USP 
on a 

Do

CMT-based OAMP 
workstation

Transferring the 
uncompressed file to the 
CMT on page 74

non-CMT-based OAMP 
workstation (windows-based)

Transferring the 
uncompressed file to 
Windows on page 76

If the response is Do

/data/usp step 7

/opt/usp step 14
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9 Ensure that enough disk space is available for the ESD software 
(500 MByte is recommended):

# df -k /data 

The free space on the device on which /data is mounted, is 
printed. The value for "avail" is the number of free kilobytes. 
Divide that number by 1000 to determine the number of free 
megabytes.

10 Transfer the USP software installation files from the PC to the 
temporary directory (created in step 7) using your FTP client 
application at the PC terminal.

Before the transfer, ensure your FTP client is in binary mode.

11 Create a temporary directory to store the ESD software:

# mkdir /opt/usp/iso_esd 

12 Move all the data from /data/usp/iso_esd/ to /opt/usp/iso_esd/:

# mv /data/usp/iso_esd/* /opt/usp/iso_esd/ 

13 Proceed to step 18.

14 Create a temporary directory to store the ESD software:

# mkdir /opt/usp/iso_esd 

15 Change directory to the newly created location:

# cd /opt/usp/iso_esd 

16 Ensure that enough disk space is available for the ESD software 
(500 MByte is recommended):

# df -k /opt 

The free space on the device on which /opt is mounted, is 
printed. The value for "avail" is the number of free kilobytes. 
Divide that number by 1000 to determine the number of free 
megabytes.

17 Transfer the USP software installation files from the PC to the 
temporary directory (created in step 14) using your FTP client 
application.

18 Confirm the USP installation software is present:

# cd /opt/usp/iso_esd/<installation_directory> 

# ls -l 

installation_directory
is the directory that contains the USP files, for example 
USP11.1.0.16F
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19 You have completed this procedure. If applicable, return to the 
higher level task flow or procedure that directed you to this 
procedure.

Transferring the uncompressed file to Windows

At the Windows-based OAMP workstation

1 Make a temporary directory to store the ESD software on the 
PC.

c:/usp/loads 

2 Change directory to the newly created directory.

3 Use your FTP client application to transfer the uncompressed 
USP software from the ESD load repository server to the 
directory you created in step 1.

Before the transfer, ensure your FTP client is in binary mode.

4 You have completed this procedure. If applicable, return to the 
higher level task flow or procedure that directed you to this 
procedure.
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Logging in to an SPFS-based server

Application
Use this procedure to log in to a Server Platform Foundation Software 
(SPFS)-based server. This procedures provides the steps to establish 
a login session using SSH, which is secure, or telnet, which is not 
secure.

Some tasks will require that you log in to the server through the console 
(port A) using the root user ID and password.

Prerequisites
This procedure requires the following information:

• the IP address or host name of the server

Note: In a two-server configuration, you need the physical IP 
address of the active or inactive server.

• a valid user id and password

• the root password if you need to perform a task on the server that 
requires root user privileges

Action
Perform the steps under one of the following headings to complete this 
procedure.

• Logging in using SSH on page 77

• Logging in using Telnet on page 80

• Logging in through the console on page 82

Logging in using SSH

At your workstation

1 Establish an SSH session.

If you have access to a workstation which supports the ssh 
command (Linux, for example) then proceed with step a below. 
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Otherwise, connect to the server using an SSH client and 
proceed to step 2.

a Establish an SSH session to the server by typing

> ssh -l <user_id> <server> 

where

user_id
is root or your user id

server
is the IP address or host name of the SPFS-based 
server, or the physical IP address of the active or 
inactive server as required, in a two-server 
configuration

2 Use the following table to determine your next step.

3

Continue the connection by typing 

y 

and pressing the Enter key.

4 Enter the password for root or your user id.

5 Use the following table to determine your next step.

If you receive Do

a message indicating a host 
authentication issue and a 
request to continue the 
connection

step 3

a prompt for a password step 4

ATTENTION
The prompt indicates SSH is verifying whether the server 
is a trusted host for the workstation. SSH performs the 
verification the first time SSH is run on a workstation.

If your server is a Do

one-server configuration step 9

two-server configuration step 6
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6 Ensure you are on the correct server by typing

# ubmstat 

and pressing the Enter key.

7 Use the following table to determine your next step.

8 You are logged in to the wrong server. Return to step 1 to log in 
to the other server.

9 You have completed this procedure. If applicable, return to the 
high-level task or procedure that directed you to this procedure.

If you need to be on the Do

active server and the 
response is 
ClusterIndicatorSTBY

step 8

inactive server and the 
response is 
ClusterIndicatorACT

step 8

active server and the 
response is 
ClusterIndicatorACT

step 9

inactive server and the 
response is 
ClusterIndicatorSTBY

step 9
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Logging in using Telnet

At your workstation

1 Establish a telnet session to the server by typing

> telnet <server> 

and pressing the Enter key.

where

server
is the IP address or hostname of the SPFS-based server, 
or the physical IP address of the active or inactive server 
as required, in a two-server configuration

2 When prompted, enter your userid. 

Note: You cannot log in using the root userid at this step.

3 When prompted, enter your password. 

4 Use the following table to determine your next step.

5 Change to the root user by typing

$ su - 

and pressing the Enter key.

6 When prompted, enter the root password.

7 Use the following table to determine your next step.

8 Ensure you are on the correct server by typing

# ubmstat 

and pressing the Enter key.

If Do

you need to log in as root step 5

otherwise step 7

If your server is a Do

one-server configuration step 11

two-server configuration step 8
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9 Use the following table to determine your next step.

10 You are logged in to the wrong server. Log out of this server and 
return to step 1 to log in to the other server.

11 You have completed this procedure. If applicable, return to the 
high-level task or procedure that directed you to this procedure.

If you need to be on the Do

active server and the 
response is 
ClusterIndicatorSTBY

step 10

inactive server and the 
response is 
ClusterIndicatorACT

step 10

active server and the 
response is 
ClusterIndicatorACT

step 11

inactive server and the 
response is 
ClusterIndicatorSTBY

step 11
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Logging in through the console

At the console connected to the server

1 Log in to the server through the console (port A) using the root 
user ID and password. In a two-server configuration, log in to the 
the active or inactive server as required. 

2 Use the following table to determine your next step.

3 Ensure you are on the correct server by typing

# ubmstat 

and pressing the Enter key.

4 Use the following table to determine your next step.

5 You are logged in to the wrong server. Log out of this server and 
return to step 1 to log in to the other server.

6 You have completed this procedure.  If applicable, return to the 
high-level task or procedure that directed you to this procedure.  

If your server is a Do

one-server configuration step 6

two-server configuration step 3

If you need to be on the Do

active server and the 
response is 
ClusterIndicatorSTBY

step 5

inactive server and the 
response is 
ClusterIndicatorACT

step 5

active server and the 
response is 
ClusterIndicatorACT

step 6

inactive server and the 
response is 
ClusterIndicatorSTBY

step 6
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Configuring OAMP Workstations

The USP supports various workstations. 

Windows 95 workstation
If you want to replace a Windows 95 workstation with a Windows 2000 
workstation you must order a Windows 2000 workstation and configure 
it for use with your USP.

Replacing a Windows 95 workstation

At the workstation site

1 Connect the Windows 2000 workstation to the same hub to 
which the Windows 95 workstation is connected.

2 Disable the alternate boot functionality on the Windows 2000 
workstation.

3 Add the site information for your USP to the Windows 2000 
workstation.

4 Disable the alternate boot functionality on the Windows 95 
workstation and enable it on the Windows 2000 workstation.

5 Ensure that the Windows 2000 workstation is functioning 
normally.

6 Disconnect the Windows 95 workstation.

7 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

Windows 2000 workstation
Perform the following steps to replace a Windows 2000 workstation.

Replacing a Windows 2000 workstation

At the workstation site

1 Connect the new Windows 2000 workstation to the same hub to 
which the original Windows 2000 workstation is connected.

2 Disable the alternate boot functionality on the new Windows 
2000 workstation.

3 Add the site information for your USP to the new Windows 2000 
workstation.

4 Disable the alternate boot functionality on the original Windows 
2000 workstation and enable it on the new Windows 2000 
workstation.
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5 Ensure that the new Windows 2000 workstation is functioning 
normally.

6 Disconnect the original Windows 2000 workstation.

Refer to the next section, Installing and Configuring External 
Reachthrough Client Software, for information about setting up 
client software on Windows and UNIX reachthrough 
workstations.

Installation and configuration of the Windows client software
You must install Windows client software on each remote Windows 
workstation before you can use the remote reachthrough feature. For 
details refer to the Administrator’s guide, Citrix ICA Win32 Client, 
Version 7.0 or Administrator’s guide, Citrix ICA Win16 Client, Version 
7.0.

Alternate boot server (NTST30DA)
NTST30DA servers support five terminal server licenses for remote 
Windows workstations and five Citrix licenses for remote Windows or 
UNIX workstations. Nortel Networks recommends using the terminal 
server licenses for remote Windows workstations, reserving the Citrix 
licenses for remote UNIX workstations. If you need more than five 
terminal server licenses for remote Windows workstations, use the 
Citrix licenses.

Connecting to an alternate boot server (NTST30DA)

At the OAMP workstation

1 Insert Diskette 1 from the set of Windows client software 
diskettes into the disk drive of your remote Windows 
workstation.

2 Run the setup.exe file on the diskette.

3 Follow the on-screen instructions to install the client software on 
your remote Windows workstation.

4 After you install the client software you will see a Citrix Program 
Neighborhood icon on your desktop. Double-click the icon. 
Select Add ICA Connection.

5 After you have created a connection you will see an icon for the 
new connection in Citrix Program Neighborhood - ICA 
Connections.

6 After you have finished configuring the new connection icon, 
double-click it to connect your remote Windows workstation to 
your alternate boot server and run the selected application.
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7 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

Installation and configuration of external Reachthrough client 
software

Reachthrough support for Windows 2000
If your USP alternate boot workstation supports external reachthrough 
you can access the USP GUI using a remote Windows or UNIX 
workstation.

Note: Each remote workstation supports up to 16 GUI sessions at 
once, provided each session is connected to a different site. Each 
USP supports up to 16 simultaneous connections in total.

You must install and configure client software on all remote 
workstations except for UNIX workstations that do not support the 
Independent Computing Architecture (ICA) protocol.

The following sections describe the procedures for installing and 
configuring client software on remote Windows and UNIX workstations.

Connecting to the Citrix Server

At the OAMP workstation

1 Log in as Administrator.

Note: The system displays error messages as the ABS 
software attempts to start. Since this software is already 
running errors will be generated, this will not affect the 
operation of the ABS server. Changing the ABS settings 
through reachthrough can only be done through the USP GUI 
and not by changing the settings directly.

Adding new Windows users for Citrix

At the OAMP workstation

1 From the Windows Start Menu, click 
Start>Programs>Administrative Tools >Computer 
Management.

2 Click Local Users and Groups on the left-hand window of the 
Computer Management Utility. A Users folder will be displayed 
in the right-hand window of the Computer Management Utility.

3 Right-click the folder and select New User. The New user panel 
appears.

4 Enter uspgui in the User Name dialog box.
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5 Enter USP GUI Access in the Full Name dialog box.

6 Enter a password in the Password dialog box.

7 Re-enter the password in the Confirm Password dialog box.

8 Uncheck the User must change password at next logon box.

9 Check the Password never expires box.

10 Click Create.

11 Create a second user for desktop access. If you require desktop 
access, this is the preferred method as it will prevent possible 
resource conflicts with the ABS server software.

a Enter desktop in the User Name dialog box.

b Enter USP desktop Access in the Full Name dialog box.

c Enter a password in the Password dialog box.

d Re-enter the password in the Confirm Password dialog box.

e Uncheck the User must change password at next logon box.

f Check the Password never expires box.

g Click Create.

12 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

Publishing Citrix applications

At the OAMP workstation

1 From the Windows Start Menu, click 
Start>Programs>Citrix>Citrix Management Console.

2 Press Ctrl-P (Publish Application). The Application Publishing 
Wizard will start.

3 Enter USP GUI in the Display Name dialog box.

4 Enter Nortel Networks USP GUI in the Application Description 
dialog box.

5 Click Next. The Specify what to publish panel appears.

6 Click the Application radio button.

7 Click Browse.

8 Select your installation directory path from the file browser. The 
default path is c:\ntssgusp\gui\Graphical User Interface 
Client.exe.

9 Click Next. The Program Neighborhood Settings appears.
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10 Click Next. The Specify Application Appearance panel appears.

11 Select Session Windows size of 1024x768 and 256 colors.

12 Click Next. The Specify ICA Client Requirements panel appears.

13 Click Next. The Specify Servers panel appears.

14 Click the Add All button located in the middle of the screen. All 
Citrix Servers will be added to the right hand list.

15 Click Next.

16 Activate the Show Users check box on the Specify Users screen.

17 Double-click the server name in order to display all provisioned 
users.

18 Find the uspgui user and click Add. The uspgui user is added to 
the list of Configured Accounts.

19 Click Finish.

20 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

Creating an.ica file

At the OAMP workstation

1 From the Windows Start Menu, click 
Start>Programs>Citrix>Citrix Management Console.

2 Right-click the Applications folder on the left window of the 
Citrix Management Console. A list of published applications will 
be displayed.

3 Right-click the USPGUI application.

4 Click the ICA button on the toolbar. The ICA File Wizard starts.

5 Select the Minimum explanation required radio button.

6 Click Next. The ICA Files Settings (1 of 2) screen appears.

7 Click Next. The ICA Files Settings (2 of 2) screen appears.

8 Note the ICA File Name which indicates where the file will be 
created. Use the browse feature if you want to save it elsewhere.

9 Click Next. The Create HTML File screen appears.

10 Select the No radio button.

11 Click Next. The ICA File Summary screen appears.

12 Click Finish.
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13 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

Windows remote workstations
Perform the following procedures for Windows remote workstations.

Windows Client software diskettes
You must have a set of Windows client software installation diskettes 
before you can install the client software on a remote Windows 
workstation. If you do not already have a set of client software diskettes 
you must create one.

Windows 2000 Advanced Server 
You can also use this procedure to load client software on a Windows 
95 (NTST30AA) workstation.

Use the Terminal Services Client Creator software on your alternate 
boot server to create a set of Windows client software diskettes. 

Creating Windows client software diskettes

At the alternate boot server

1 Open the Terminal Services Client Creator. Open the 
Administrative Tools program group. Double-click the Terminal 
Services Client Creator icon.

2 Ensure that you have several blank formatted diskettes 
available. The 16-bit Windows client software requires four 
diskettes and the 32-bit client software requires two diskettes.

3 Insert a blank diskette into the disk drive of your alternate boot 
server.

4 Select either 16 or 32-bit Terminal Services and click OK. 
Normally, you will select 32-bit terminal services unless your 
remote Windows workstation is using Windows 3.1.

5 Follow the on-screen instructions until you have finished 
creating your set of client diskettes.

6 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

Windows 2000 Advanced Server (NTST30DA) with Metaframe
Use the ICA Client Create software on your alternate boot server to 
create your client software diskettes.
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Using the ICA Client Create software to create your client software 
diskettes

At the alternate boot server

1 Open the ICA Client Creator (Start>Programs>Metaframe 
Tools>ICA Client Creator).

2 Ensure that you have several blank formatted diskettes 
available.

3 Insert a blank diskette into the disk drive of your alternate boot 
server.

4 Follow the on-screen instructions until you have finished 
creating the set of client diskettes.

5 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

UNIX remote workstations
If you have an NTST30DA USP alternate boot server you can access 
the USP GUI from a remote UNIX workstation. The following 
procedures describe the installation and configuration of client software 
on a remote UNIX workstation. This procedure applies to most common 
UNIX workstation configurations. For more details refer to the Citrix ICA 
UNIX Client Administrator’s Guide, Version 3.0, which is available on 
the Citrix Metaframe software CD.

Installing and configuring client software on a remote UNIX 
workstation

At the remote UNIX workstation

1 Log in as administrator on your remote UNIX workstation and 
open a command window.

2 Insert the Citrix Metaframe CD-ROM disk into the UNIX 
workstation CD player and mount the CD-ROM using the 
procedure for your workstation.

3 Go to the ICA Client/Ica unix directory on the CD-ROM disk.

4 Run the setup program by entering /.setupwfc at the UNIX 
command line. Press Enter.

5 Select item 1 from the displayed menu to install the Citrix ICA 
client. Press Enter.

6 Follow the on-screen instructions to complete the installation of 
the ICA client.
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After you have finished installing the ICA client you will see a 
Citrix ICA Client window on your desktop.

7 Add a new connection by selecting Entry>New from the ICA 
Client window. Enter a description for your connection and select 
the alternate boot server from the server list.

8 Select the application that you want to run when you connect to 
the alternate boot server by selecting Application from the list at 
the top left of the ICA Client window. Enter the name of the 
application file and the path to that file for the application that you 
want to run.

For example, to run the USP GUI when you connect to your 
alternate boot server, enter the following information: 
c:\ntssgusp\gui\Graphical User Interface Client.exe. (This is 
the default installation path. If you have selected another 
directory location, enter your installation directory path 
information.) 

9 You can connect to the alternate boot server and run the 
application by double-clicking the connection name in the Citrix 
ICA Client window.

10 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.
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Using the Upgrade Wizard

Use the following procedure to upgrade USP software.

Setup
The system performs the following actions to prepare the USP for an 
upgrade:

• copies upgrade package to the RTCs from Alternate Boot Server

• copies software loads to RTCs from Alternate Boot Server

• sets the target upgrade software version

Note: Prior to running the setup, ensure that the maximum number 
of files permitted in the file system has not been reached. Otherwise, 
the setup procedure will fail.

Running the setup

At the OAMP workstation

1 Log in to the USP GUI. 

2 Click Fault>Log. Display the Realtime log list by selecting 
Realtime View. Any new logs generated by the system are 
displayed on the screen.

3 Click the Clear button to clear the Realtime log.

4 Click the Start button.

5 Click Administration>software-upgrade. Select the software 
release you are installing in the Target Version text box. Use the 
notation vn.n.n (for example v11.0.0).

6 Click the Run Setup button. A confirmation dialog box is 
displayed.

ATTENTION
Do not use the software upgrade wizard to upgrade 
NPC/NPS/NPE system nodes if there are NPE chains 
provisioned. Manually upgrade these nodes instead. See 
Upgrade of NPC, NPS, and NPE nodes on page 102.

Upgrading NPC, NPS, and NPE system nodes is only applicable 
to systems that include the optional Universal Number Portability 
Master (UNPM) capability.
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7 Click Yes.

Note:  Setup can take up to an hour to complete. 
A confirmation that the setup is complete will appear at the 
bottom left corner of the dialog box.

8 Click Next when you see the message "command completed" at 
the bottom left corner of the window.

9 Proceed to the next section (Precheck).

Precheck
Run the precheck to ensure that the upgrade is ready to proceed. The 
system confirms the following: 

• Both RTCs are in-service with an operational state of enabled.

• RTC in slot 12 of control shelf is the current active RTC.

• The alternate boot server is configured properly for current system 
configuration for both RTCs.

• All other system nodes are in-service with an operational state of 
enabled or have an availability state of offline.

• Software upgrade packages have been transferred to both RTCs.

If any of the checks fail, resolve them before proceeding with the 
upgrade.

Running the precheck

At the OAMP workstation

1 Click the Run Precheck button. 

2 Click Yes to confirm the action.

3 Click Next when you see the message "upgrade precheck 
successful" at the bottom left corner of the dialog box.

4 If the status panel indicates that the precheck is successful, 
proceed to the next section (Limit user access). If the precheck 
was not successful, address any error messages and repeat the 
precheck before you proceed. For example, if the precheck 
status panel indicates that disk space is low, delete any unused 
snapshots and loads from the RTC SCSI disk using the File 
Manager.

Limit user access
Before you begin a software upgrade, limit connections to the USP to 
prevent other users from accidentally modifying provisioning data while 
the upgrade is in progress.
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Although the following procedure is not a part of the Upgrade Wizard, it 
is performed at this point since you are now ready to proceed with the 
upgrade.

To view or restrict user access to the USP during a software upgrade, 
perform the following procedure.

Viewing and restricting user access to the USP

At the OAMP workstation

1 To modify user account information, click 
Security>user-account.

2 Click the Search tab.

3 Select All from the Records drop-down menu.

4 Click Retrieve.

5 Select all records by clicking the first one and then holding the 
shift key down, and clicking the last record.

Do not include your own user account with the records you have 
selected. Find your own record in the list and while holding down 
the Ctrl key, click on your record. This will de-select your record, 
while keeping the others selected.

6 Click on Post. An X appears to the left of all the records.

7 Create a record showing the currently enabled and disabled 
users as follows:

a Click on the Export posted records icon (the second button 
to the left of the context-sensitive Help button). A message 
box appears, asking: "Do you want to continue?". Answer 
Yes.

b The Export dialog box appears. Enter a filename and specify 
a file type for the exported records file. Click Save.

The file you have just created is a list of all user accounts. It 
shows which users were enabled or disabled before 
beginning the upgrade procedure. Use this list to restore the 
correct user account status when directed to do so in 
Complete the upgrade on page 114. 

8 Double-click on any posted record. The Administration tab then 
appears.

9 Ensure the enabled option is not selected. Uncheck the enabled 
option if it is checked.

10 Click Modify.
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A confirmation dialog box appears.

11 Use the following table to determine your next step.

12 Select the enabled option field. The letter n should appear to the 
right.

13 Click OK. All posted users will be disabled once the command 
completes.

14 Proceed to section Start the upgrade.

Start the upgrade
Run the Start Upgrade procedure to begin the software upgrade. All 
pre-check conditions must be met before the upgrade is allowed to 
start. All upgrade packages and target software loads must be 
transferred to both RTCs.

Running the Start Upgrade procedure

At the OAMP workstation

1 Click the Start Upgrade button.

2 Click Yes to confirm.

3 Click Next.

Note: To abort the software upgrade, all nodes must be 
running the original back-level release (no nodes must have 
an upgrade-status of upgraded. If nodes are upgraded, they 
must be downgraded before you click the Stop Upgrade 
button.

4 Proceed to section Software load setup.

If Do

only one user was posted in 
step 6

click Yes and proceed to 
step 14

multiple users were posted in 
step 6

click Posted, which displays 
the multi-modify field 
selection dialog box, and 
proceed to step 12
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Software load setup
The Software Load Setup builds a mapping between the current 
software loads and the target software loads and automatically re-maps 
the software load pointer to the new target software release. 

The system creates a default mapping based on the current software 
version and the target upgrade version specified during setup. All 
current software loads must be mapped to the target software loads. If 
a software mapping does not exist for the current load, you must resolve 
the missing pairing.

The current load list contains all software loads available on the active 
RTC that match the current software release.

The upgrade load list contains all software loads available on the active 
RTC that match the target upgrade software release.

Running the software load setup

At the OAMP workstation

1 Review the software mapping displayed in the software load 
setup. Confirm the mapping is correct.

2 Click the Next button. 

3 Proceed to the next section (Upgrade the system nodes).

Upgrade the system nodes
Run the node upgrade to perform the software upgrade for a specific 
node. You can also select multiple nodes to upgrade using the 
Shift+Ctrl keys or Ctrl+click with a mouse.

Upgrading the system nodes for one maintenance window upgrades
Upgrade the system nodes for a one-shelf or two-shelf system using 
the procedure that follows. 

At the OAMP workstation
1 Upgrade the inactive RTC in slot 15. For detailed steps, refer to 

Upgrading the inactive RTC in slot 15 on page 98.
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2 Upgrade the CC in slot 1 on the control CAM shelf. For detailed 
steps, refer to Upgrade a CC node on page 100.

3 Use the following table to determine your next step.

4 For a two-shelf system, also upgrade the CCs in slot 1 on the 
extension CAM shelf. For detailed steps, refer to Upgrade a CC 
node on page 100.

5 Upgrade the link system nodes on the control shelf. For detailed 
steps, refer to Upgrade a link node on page 100.

6 Use the following table to determine your next step.

7 For a two-shelf system, also upgrade the link system nodes on 
the extension CAM shelf. For detailed steps, refer to Upgrade a 
link node on page 100.

8 If your system includes the optional Universal Number Portability 
Master (UNPM) capability, upgrade the NPC, NPS and NPE 
nodes on the control CAM shelf. For detailed steps, refer to 
Upgrade of NPC, NPS, and NPE nodes on page 102.

9 Use the following table to determine your next step.

10 For a two-shelf system, also upgrade the NPC, NPS and NPE 
nodes on the extension CAM shelf. For detailed steps, refer to 
Upgrade of NPC, NPS, and NPE nodes on page 102.

11 Upgrade the CCs in slot 18 on the control CAM shelf. For 
detailed steps, refer to Upgrade a CC node on page 100.

12 Upgrade the CC in slot 18 on the extension CAM shelf. For 
detailed steps, refer to Upgrade a CC node on page 100.

If you have a Do

one-shelf system step 5

two-shelf system step 4

If you have a Do

one-shelf system step 8

two-shelf system step 7

If you have a Do

one-shelf system step 12

two-shelf system step 10
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13 Switch activity (SWACT) between RTCs, and upgrade the 
inactive RTC in slot 12. For detailed steps, refer to Perform a 
SWACT and upgrade the Inactive RTC node in slot 12 on 
page 109.

14 Activate new features. For detailed steps, refer to Activate 
features on page 113.

15 Monitor the USP for 15 minutes, and ensure the USP performs 
without degradation. If there is a degradation in service, 
complete section Deactivate upgrade features on page 113. If 
there is no degradation and you want to keep the features 
activated, proceed to section Cleanup on page 114.

Upgrading the system nodes for multiple maintenance window upgrades
When performing a large system upgrade that requires more than one 
maintenance window to complete, you must upgrade the entire Control 
CAM shelf before the end of the first maintenance window. Use the 
additional window to upgrade the cards in the extension shelves.

Note:  If your system includes NPC, NPS and/or NPE nodes, you 
must upgrade the NPC, NPS and NPE system nodes (on all shelves 
if you have a dual-shelf or multi-shelf system) in a specific order 
depending on the local subsystem assignment. (See Upgrade of 
NPC, NPS, and NPE nodes on page 102.) Re-ordering of the 
upgrade sequence may be required if performing a multi-node 
upgrade operation.

Upgrade the system nodes with three or more shelves using the 
procedure that follows: 

At the OAMP workstation
1 Upgrade the inactive RTC in slot 15. For detailed steps, refer to 

Upgrade of the inactive RTC node in slot 15 on page 98.

2 Upgrade the CC in slot 1 on the control CAM shelf. For detailed 
steps, refer to Upgrade a CC node on page 100.

3 Upgrade the CCs in slot 1 on the extension CAM shelves. For 
detailed steps, refer to Upgrade a CC node on page 100.

4 Upgrade the link system nodes on the control CAM shelf. For 
detailed steps, refer to Upgrade a link node on page 100.

5 If your system includes the optional Universal Number Portability 
Master (UNPM) capability, upgrade the NPC, NPS and NPE 
nodes on the control CAM shelf. For detailed steps, refer to 
Upgrade of NPC, NPS, and NPE nodes on page 102.
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6 Upgrade the CCs in slot 18 on the control CAM shelf. For 
detailed steps, refer to Upgrade a CC node on page 100.

Note: When you perform the SWACT command in step 7, 
you will be informed if you have not upgraded one card of each 
unique card type in your system. In this case, upgrade the 
card which will be on an extension shelf. You can perform the 
SWACT again until it is successful.

7

Switch activity (SWACT) between RTCs, and upgrade the 
inactive RTC in slot 12. For detailed steps, refer to Perform a 
SWACT and upgrade the Inactive RTC node in slot 12 on 
page 109.

Note: The required cards have been upgraded for the first 
maintenance window. You can continue to upgrade cards now 
or in the next maintenance window.

8 Upgrade the link system nodes on the extension CAM shelves. 
For detailed steps, refer to Upgrade a link node on page 100.

9 If your system includes the optional Universal Number Portability 
Master (UNPM) capability, upgrade the NPC, NPS and NPE 
nodes on the extension CAM shelves. For detailed steps, refer 
to Upgrade of NPC, NPS, and NPE nodes on page 102.

10 Upgrade the CCs in slot 18 on the extension CAM shelves. For 
detailed steps, refer to Upgrade a CC node on page 100.

Upgrade of the inactive RTC node in slot 15
The upgrade of the RTC in slot 15 can take up to 20 minutes to 
complete.

Upgrading the inactive RTC in slot 15

At the OAMP workstation

1 Click on the appropriate row to select the RTC15 node to 
upgrade from the list of available nodes in the software upgrade 
wizard. The RTC node is in slot 15, with a slot type of rtc.

ATTENTION
Before upgrading RTC12, perform test calls to ensure the 
system is performing properly. Once RTC 12 is upgraded, 
the abort of the upgrade requires an out-of-service 
alternate boot to the snapshot taken before starting the 
upgrade.
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2 Click the Upgrade button. A confirmation dialog box appears. 
Click Yes to continue.

3 Wait for the upgrade to complete. The upgrade-status will 
change to upgraded on completion.

Note: If the automatic node upgrade fails to complete 
successfully, perform the upgrade manually. For detailed 
steps, refer to Upgrade nodes manually on page 110.

4 Click Fault>Log. Display the Realtime log list by selecting 
Realtime View to monitor the USP to ensure it performs normally 
and does not report any LOG_SWERRS or LOG_TRAPS. If it 
does, contact your next level of support.

5 Set the alternate boot load for RTC system nodes to the new 
upgrade load.

The alternate boot settings are used when an RTC is not able to 
boot from disk. After upgrading RTC15, if RTC15 were to boot, it 
would be able to data sync from RTC12 and upgrade. But if 
RTC12 were to boot, it would be booting the old release load and 
would not be able to data sync from RTC15, which is now 
running the upgrade load. So RTC12 would alternate boot. If the 
alternate boot load is the old release load, RTC 12 would again, 
not be able to data sync and become enabled. This is why the 
active alternate boot loads for both RTCs must be changed to 
the new upgrade load, thus permitting RTC12 to alternate boot 
the upgrade load and then data sync with RTC15 (also running 
the upgrade load).

A special case occurs if both RTCs were to alternate boot at the 
same time, before you changed the active snapshot to one taken 
with the active RTC running the upgrade load. In this case, you 
will have to change the active alternate boot loads to the old 
release loads, since the snapshot would contain data from the 
old release.

a Click Administration>alternate-boot-server.

b Update RTC 12 to the new release version by selecting the 
new release from the ABS Active Loads drop-down menu.

c Update RTC 15 to the new release version by selecting the 
new release from the ABS Active Loads drop-down menu.

d Click Modify.

6 This procedure is complete. Return to Upgrade the system 
nodes on page 95 to determine your next step.
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Upgrade a CC node
To upgrade a CC node, perform the following steps:

Note: Start with CC1 on the control shelf.

Upgrading the CC node

At the OAMP workstation 

1 Select the node to upgrade in the list of available nodes in the 
software upgrade wizard.

2 Click the Upgrade button. The system asks for confirmation.

3 Wait for the node upgrade to complete (the upgrade-status will 
change to upgraded on completion).

Note: If the automatic node upgrade fails to complete 
successfully, perform the upgrade manually. 

4 Click Fault>Log. Display the Realtime log list by selecting 
Realtime View to monitor the USP to ensure it performs normally 
and does not report any LOG_SWERRs or LOG_TRAPs. If it 
does, do not continue with the node upgrade, contact your next 
level of support.

5 This procedure is complete. Return to Upgrade the system 
nodes on page 95 to determine your next step.

Upgrade a link node

To upgrade a single system node, perform the following steps:

ATTENTION
To upgrade an NPC, NPS, or NPE node see Upgrade of NPC, 
NPS, and NPE nodes on page 102.

ATTENTION
Traffic is maintained through redundant links configured on 
different link cards. To maintain the traffic, ensure there are 
redundant links configured on different link cards before 
upgrading the link card.
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Upgrading a link node

At the OAMP workstation 

1 Select the node to upgrade in the list of available nodes in the 
software upgrade wizard.

2 Click the Upgrade button. The system asks for confirmation.

3 Wait for node upgrade to complete (upgrade-status will change 
to upgraded on completion).

4 Click Fault>Log. Display the Realtime log list by selecting 
Realtime View to monitor the USP to ensure it performs normally 
and does not report any LOG_SWERRs or LOG_TRAPs. If it 
does, do not continue with the node upgrade.

5 Repeat this procedure for all remaining link nodes.

6 This procedure is complete. Return to Upgrade the system 
nodes on page 95 to determine your next step.

Upgrade multiple link nodes

To upgrade multiple system nodes, perform the following steps.

Upgrading multiple link nodes

At the OAMP workstation 

1 Shift-click or ctrl-click to select a range of nodes to upgrade in 
the list of available nodes in the software upgrade wizard.

2 Select the delay interval between each successive node 
upgrade. This will be used to soak the upgraded node before 
moving to the next system node.

3 Click the Upgrade node button. The system asks for 
confirmation.

4 Wait for the node upgrade to complete (upgrade-status will 
change to upgraded on completion).

Note: If the automatic node upgrade fails to complete 
successfully, perform the upgrade manually. 

5 The upgrade will now delay for the selected interval before 
continuing to the next node to upgrade. Upgrade of nodes can 

ATTENTION
To upgrade an NPC, NPS, or NPE node, see Upgrade of NPC, 
NPS, and NPE nodes on page 102.
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be cancelled at any time by clicking the Stop button. To skip the 
delay count down, click No delay and the next node will be 
upgraded immediately.

6 Click Fault>Log. Display the Realtime log list by selecting 
Realtime View to monitor the USP to ensure it performs normally 
and does not report any LOG_SWERRs or LOG_TRAPs. If it 
does, do not continue with the node upgrade.

7 Repeat this procedure for all remaining link nodes.

8 This procedure is complete. Return to Upgrade the system 
nodes on page 95 to determine your next step.

Upgrade of NPC, NPS, and NPE nodes
The upgrade of an NPC, NPS or NPE node or all nodes, requires 
special handling to ensure that the local subsystem instances 
associated with an NPC, NPS and NPE chain, have been deactivated. 
Also, the node to upgrade must not be the active NPC node. If the node 
to upgrade is the active node, then a switch of activity must be 
performed prior to upgrading the node.

Note: Upgrading NPC, NPS and NPE nodes is only applicable to 
systems that include the optional Universal Number Portability 
Master (UNPM) capability.

For a multiple maintenance window, upgrade the NPC and NPS system 
nodes without NP chains, as indicated in the procedure that follows.

In the first maintenance window
1 Upgrade the inactive NPC system node.

2 Upgrade one NPS system node.

In subsequent maintenance windows

3 Upgrade the remaining NPS system nodes.

4 Switch activity (SWACT) to the newly-upgraded NPC node.

CAUTION
Potential for NPDB corruption
If upgrading the NP nodes/chains, the connection to 
the LSMS will need to be released on the LSMS. 
Refer to the LSMS operation manual for release
methods. Contact Nortel Networks Technical Support
for more information. Failure in doing so will result in
NPDB corruption.
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5 Upgrade the inactive NPC system node.

For a multiple maintenance window, upgrade the NPC, NPS, and NPE 
system nodes with NP chains as indicated in the procedure that follows.

In the first maintenance window
1 Upgrade the inactive NPC system node, the NPE nodes in that 

chain, and any associated NPS nodes.

2 If no NPS cards have been upgraded, upgrade one NPS node 
and the NPE nodes in its chain.

In subsequent maintenance windows

3 Upgrade the remaining NPS chains, their associated NPS 
nodes, and the NPE nodes in those chains.

4 Switch activity (SWACT) to the newly-upgraded NPC node.

5 Upgrade the final NPC system node, the NPE nodes in that 
chain, and any associated NPS nodes.

Upgrading NPC, NPS, and NPE nodes

On LSMS

1 Release all SMI connections to the UNPM. Refer to the LSMS 
operation manual for release methods.

At the OAMP workstation

2 In the menu bar, click Administration>Platform>Node.

3 Select the NPC you want to upgrade, and check the activity state 
of the NPC.

4 Use the following table to determine your next step.

5 Deactivate the NP local subsystem instance running on the 
inactive NPC system node as follows: 

Click 
Configuration>SCCP>shared-local-subsystem-instance, 
select the desired NPx, and click Deactivate.

If the NPC is Do

active Perform a SWACT, then 
continue to step 5.

inactive Continue to step 5.
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6 If an NPE chain has been provisioned with this NPC node as the 
master and with an alternate NPS system node, then deactivate 
the local subsystem instance running on the alternate NPS as 
follows: 

Click 
Configuration>SCCP>shared-local-subsystem-instance, 
select the desired NPx, and click Deactivate.

7 Using the software upgrade wizard, select the NPC node to 
upgrade in the list of available nodes. 

8 Click the Upgrade node button. The system asks for 
confirmation.

9 Wait for node upgrade to complete (the upgrade-status will 
change to upgraded on completion).

Note: If the automatic node upgrade fails to complete 
successfully, perform the upgrade manually. 

10 Use the following table to determine your next step.

11 Wait for the local subsystem instance to be 
deactivated/prohibited.

12 Reactivate the local subsystem instance running on the inactive 
NPC as follows: 

Click 
Configuration>SCCP>shared-local-subsystem-instance, 
select the desired NPx, and click Activate.

13 Use the following table to determine your next step.

If Do

an NPE chain is 
provisioned with this NPC 
node as master

repeat step 7 to step 9 for each 
NPE system node and the 
alternate NPS system node 
associated with this chain.

there is no NPE chain 
associated with this NPC 
node

proceed to step 11

If Do

an NPE chain is 
provisioned with an 
alternate NPS system node

step 14
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14 Wait for the local subsystem instance to be 
deactivated/prohibited, and then reactivate the local subsystem 
instance running on the alternate NPS as follows: 

Click 
Configuration>SCCP>shared-local-subsystem-instance, 
select the desired NPx, and click Activate.

15 Wait for the reactivated local subsystem instances to return to 
the activated/allowed state. 

16 Click Fault>Log. Display the Realtime log list by selecting 
Realtime View to monitor the USP to ensure it performs normally 
and does not report any LOG_SWERRs or LOG_TRAPs. If it 
does, do not continue with the node upgrade.

17

18 Deactivate the NP local subsystem instance running on the NPS 
system node as follows: 

Click 
Configuration>SCCP>shared-local-subsystem-instance, 
select the desired NPx, and click Deactivate.

19 If an NPE chain has been provisioned with an alternate NPS for 
the selected NPS, deactivate the NP LSS instance running on 
the alternate NPS system node as follows: 

Click 
Configuration>SCCP>shared-local-subsystem-instance, 
select the desired NPx, and click Deactivate.

there is no NPE chain 
provisioned with an 
alternate NPS system node

step 15

If Do

NPS system nodes are 
provisioned without a 
chain, or NPS system 
nodes which are 
masters of a chain

select an NPS system node to be 
upgraded. This node cannot be an 
NPS system node already 
upgraded in the previous steps or 
the NPS system node associated 
with the currently active NPC 
chain.

there are no further 
NPS system nodes to 
be upgraded

proceed to step 30.

If Do
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20 Using the software upgrade wizard, select the NPS node to 
upgrade in the list of available nodes 

21 Click Upgrade node.

22 Wait for node upgrade to complete (upgrade-status will change 
to upgraded on completion).

Note: If the automatic node upgrade fails to complete 
successfully, perform the upgrade manually. 

23 Use the following table to determine your next step.

24 Wait for the local subsystem instance to be 
deactivated/prohibited.

25 Reactivate the local subsystem instance running on the NPS as 
follows: 

Click 
Configuration>SCCP>shared-local-subsystem-instance, 
select the desired NPx, and click Activate.

26 If an NPE chain has been provisioned with an alternate NPS 
system node:

a Wait for the local subsystem instance to be active/allowed.

b Reactivate the NP local subsystem instance running on the 
alternate NPS as follows: 

Click 
Configuration>SCCP>shared-local-subsystem-instance 
select the desired NPx, and click Activate.

27 Wait for the reactivated local subsystem instances to return to 
the activated/allowed state. 

28 Click Fault>Log. Display the Realtime log list by selecting 
Realtime View to monitor the USP to ensure it performs normally 
and does not report any LOG_SWERRs or LOG_TRAPs. If it 
does, do not continue with the node upgrade.

If Do

an NPE chain has been 
provisioned for this NPS 
node

repeat step 20 to step 22 for 
each NPE system node and 
the alternate NPS system node 
associated with this chain.

there is no NPE chain 
associated with this NPS 
node

step 24
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29 Repeat step 17 to step 28 for any remaining NPS system nodes 
in the system, otherwise proceed to step 30.

30 Switch activity between the active and inactive NPC nodes as 
follows: 

Click Administration>platform>node for the currently active 
NPC node, then click Swact.

31 Deactivate the NP local subsystem instance running on the 
inactive NPC system node as follows: 

Click 
Configuration>SCCP>shared-local-subsystem-instance, 
select the desired NPx, and click Deactivate.

32 If an NPE chain has been provisioned with an alternate NPS 
system node, deactivate the local subsystem instance running 
on the alternate NPS as follows: 

Click 
Configuration>SCCP>shared-local-subsystem-instance, 
select the desired NPx, and click Deactivate.

33 Using the software upgrade wizard, select the newly inactive 
NPC node to upgrade in the list of available nodes.

34 Click the Upgrade node button.

35 Wait for the node upgrade to complete (upgrade-status will 
change to upgraded on completion).

Note: In the event that the automatic node upgrade fails to 
complete successfully, perform the upgrade manually.

36 If an NPE chain has been provisioned for this NPC, repeat 
step 33 to step 35 for each NPE system node and the alternate 
NPS system node associated with this chain.

37 Wait for the local subsystem instance to be 
deactivated/prohibited, then, reactivate the local subsystem 
instance running on the inactive NPC as follows:

Click 
Configuration>SCCP>shared-local-subsystem-instance, 
select the desired NPx, and click Activate.

38 If an NPE chain has been provisioned with an alternate NPS 
system node, wait for the local subsystem instance to be 
deactivated/prohibited, then reactivate the local subsystem 
instance running on the alternate NPS as follows: 

Click 
Configuration>SCCP>shared-local-subsystem-instance, 
select the desired NPx, and click Activate.
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39 Wait for the reactivated local subsystem instances to return to 
the activated/allowed state. 

40 Click Fault>Log. Display the Realtime log list by selecting 
Realtime View to monitor the USP to ensure it performs normally 
and does not report any LOG_SWERRs or LOG_TRAPs. If it 
does, do not continue with the node upgrade.

41 Ensure the activity state of the NPC is set to not-active as 
follows: 

Click Administration>shared>local-subsystem. If the NPC’s 
activity state is currently active then go to step 38, otherwise go 
to step 39.

42 Switch activity between the active and inactive NPC nodes as 
follows: 

Click Administration>platform>node for the currently active 
NPC node, then click Swact.

43 Click Fault>Log. Display the Realtime log list by selecting 
Realtime View to monitor the USP to ensure it performs normally 
and does not report any LOG_SWERRs or LOG_TRAPs. If it 
does, do not continue with the node upgrade.

On LSMS

44 Re-establish all SMI connections to the UNPM. Refer to the 
LSMS operation manual for release methods.

45 This procedure is complete. Return to Upgrade the system 
nodes on page 95 to determine your next step.

If: Do:

the NPC’s activity state is 
currently active 

proceed to step 42.

the NPC’s activity state is 
currently inactive 

proceed to step 43.
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Perform a SWACT and upgrade the Inactive RTC node in slot 12

Upgrade of the RTC in slot 12 can take up to 20 minutes to complete.

Performing a SWACT and upgrade for the inactive RTC node in 
slot 12

At the OAMP workstation

1 Verify that RTC15 is the active RTC.

a  In the menu bar, click Configuration>platform>node.

b Click the Graphical view tab.

c Double-click the RTC in slot 15.

2 Select the RTC12 node to upgrade from the list of available 
nodes in the software upgrade wizard.

3 Use the following table to determine your next step.

ATTENTION
After completing step 5 in the procedure that follows, you will not 
be able to abort the upgrade process, except by performing an 
out-of-service alternate boot to the data snapshot taken before 
you started the upgrade procedure.

If: Do:

the Activity State is 
Active

step 2

the Activity State is not 
Active

perform a SWACT, then proceed to 
step 2

If Do

you want to proceed with the 
upgrade

step 5

you want to abort the 
upgrade process

step 4
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4 Verify that RTC12 is the active RTC.

a  In the menu bar, click Configuration>platform>node.

b Click the Graphical view tab.

c Double-click the RTC in slot 12.

5 Click the Upgrade button.

6 Wait for the node upgrade to complete (upgrade-status will 
change to upgraded on completion).

Note: In the event that automatic node upgrade fails to 
complete successfully, perform the upgrade manually.

7 Wait 10 minutes and then perform a SWACT.

8 Click Fault>Log. Display the Realtime log list by selecting 
Realtime View to monitor the USP to ensure it performs normally 
and does not report any LOG_SWERRs or LOG_TRAPs. If 
LOG_SWERRs or LOG_TRAPs are reported, do not continue 
with the node upgrade. If the upgrade was successful, proceed 
to the next step.

9 Click Next and continue with Activating new features on 
page 113.

10 This procedure is complete. Return to Upgrade the system 
nodes on page 95 to determine your next step.

Upgrade nodes manually
Perform the steps in the following procedure to manually upgrade any 
system node type including link nodes, as appropriate. 

If: Do:

the Activity State is 
Active

Downgrading Using the Wizard on 
page 174

the Activity State is not 
Active

perform a SWACT and proceed to 
Downgrading Using the Wizard on 
page 174

ATTENTION
The procedure that follows provides the general steps on how to 
upgrade a system node. However, nodes must be upgraded in a 
specific order. Refer to section Upgrading the system nodes for 
one maintenance window upgrades on page 95 or Upgrading the 
system nodes for multiple maintenance window upgrades on 
page 97 as appropriate.
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Upgrading nodes manually

At the OAMP workstation

1 If you are manually upgrading a system link node and if the 
system link node is unlocked and enabled, proceed to step 2; 
otherwise, proceed to step 3. 

If you are manually upgrading a non-link node, and if the system 
node is unlocked and enabled proceed to step 5, otherwise, 
proceed to step 4.

2 Inhibit all of the links on the system node, if applicable. See the 
USP Configuration Management guide for these procedures.

Note: You cannot inhibit IPS7 links. If there is only one 
available link on a linkset, you will not be able to inhibit it. If it 
is a one-link linkset, proceed to step 3 without inhibiting the 
link. If there are other links on the linkset, make at least one of 
them available before attempting to inhibit the link.

3 Deactivate all of the links or paths on the system node, as 
applicable to the system node. See the USP Configuration 
Management guide for these procedures.

4 Set the boot image of the node by completing the following 
steps. For link nodes, complete substeps a - f. For non-link 
nodes, complete substeps a - d and then f. 

a Click Configuration>platform>node.

b Click Graphical View.

c Click the slot for the node you need to upgrade to open the 
node in the Administration panel.

d Select the drop-down menu to set the boot image to the new 
release version. 

e For link nodes, you also need to set its HA boot image to the 
new HA release version.

Note: IPS7 and IP high-speed (HSL) link cards do not 
require HA loads.

f Click Modify.

Note: The card must be reloaded immediately after the 
boot image is set to the new release version.

If the system node is off-line, the setting of the boot image 
reset the status to Upgraded. There are no alarms for an 
offlined node.
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5 Lock and load the system node. See the USP Configuration 
Management guide for these procedures.

6 When the system node becomes enabled, unlock it.

7 Verify that the running load is the new version. If not, make sure 
that the correct image is selected in the platform-node 
Administration panel. If not, contact your next level of support.

8 For link nodes, Activate and uninhibit all of the links on the 
system link node.

9 Click Fault>Log. Display the Realtime log list by selecting 
Realtime View to monitor the USP for 15 minutes after you 
upgrade the first card and each unique card type in the system 
(for example, ATM and IP). Make sure the USP performs 
normally and does not report any LOG_SWERRs or 
LOG_TRAPs. During this period, perform test calls to verify that 
the newly loaded system node performs consistently with its 
pre-upgrade status. Take steps to ensure test calls are routed 
through links on this Link system node.

10 After the first linkset is upgraded (a linkset upgrade requires the 
upgrade of several link cards), perform a test call to make sure 
all of the link cards in the linkset have been correctly upgraded. 
If there are any errors, contact your next level of support. The 
test call for the linkset is required only for the first linkset 
upgraded.

11 Repeat step 1 to step 9 for the remaining system nodes on the 
remaining CAM shelves. Upgrade the system nodes from the 
lowest slot on the lowest-numbered shelf to the highest slot on 
the highest-numbered shelf. After you have successfully 
upgraded the first system node, remaining system nodes only 
need to be monitored for stability. A complete set of test calls will 
be performed when all system nodes are upgraded.

12 Perform a complete set of test calls when all system nodes are 
upgraded.

If it was determined prior to the upgrade, that the site is using a 
route master configuration, perform the following test calls:

• network to host

• network to donor

• host to donor

• migrated donor to donor

13 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.
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Activate features
You must activate the new features of the software load. All system 
nodes must be upgraded to activate features. 

Activating new features

At the OAMP workstation

1 Click Activate Features.

2 Click Yes to accept the activation and continue.

3 Perform test calls to verify that messages are correctly routed. 

If it was determined prior to the upgrade that the site is using a 
route master configuration, the following test calls must be 
performed:

• network to host

• network to donor

• host to donor

• migrated donor to donor

Click Fault>Log. Display the Realtime log list by selecting 
Realtime View to monitor the USP to ensure it does not report 
any LOG_SWERRs or LOG_TRAPs. 

4 This procedure is complete. Return to Upgrade the system 
nodes on page 95 to determine your next step.

Deactivate upgrade features
Complete this procedure only if you want to deactivate new features 
from a software upgrade (for instance, in the event of a degradation in 
service). If features for the new release were activated, deactivate the 
features using the Upgrade Administration window.

ATTENTION
When you activate new features, all GUI connections will log out 
and log back in automatically to re-initialize in order to pick up the 
new features. Select Administration>software-upgrade. Click Next 
to go to the feature activation screen.
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Deactivating new features

At the OAMP workstation

1 Open the Upgrade Administration window as follows: 

Click Administration>software-upgrade> Deactivate New 
Features. 

A confirmation dialog box appears.

2 Click Yes to deactivate or No to leave features active.

3 You have completed this procedure. Proceed to the next section 
(Cleanup).

Cleanup
The cleanup stage, deletes some of the upgrade files that were used 
during the upgrade. 

Running the cleanup

At the OAMP workstation

1 Click Administration>software-upgrade.

2 Ensure that the new features are activated.

3 Click Next.

4 Click Run Cleanup. 

A confirmation dialog box appears.

5 Click Yes.

6 Proceed to the next section (Complete the upgrade).

Complete the upgrade
The complete stage stops the upgrade, shuts down the wizard, creates 
a data snapshot, restores access privileges, and checks the donor 
switch for SS7 alarms.

Stopping the upgrade

At the OAMP workstation

1 Click Administration>software-upgrade

2 Click Stop Upgrade. A confirmation dialog box appears.To 
inform the system that the upgrade has completed successfully, 
click Yes.

3 Click the X at the top right corner of the wizard action panel to 
close the wizard.
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4 Set user privileges back to pre-upgrade settings and re-enable 
any user accounts that were disabled during the upgrade. Refer 
to the file you created in "Limit user access" section, step 7 for 
the correct user status. Refer to the sections Security: User 
accounts and Security: User session in the USP Administration 
and Security guide for additional information.

5 Create a data snapshot, copy it to the alternate boot server and 
set the alternate boot server snapshot. Refer to procedure 
Creating an alternate boot data snapshot on page 22.

6 If it was determined prior to the upgrade that the site is using a 
route master configuration, check the donor switch for SS7 
alarms.

7 Determine whether the USP is installed on the IEMS. Launch the 
IEMS Java Web Start Client (refer to “Launching IEMS Java Web 
Start Client” in IEMS Basics, NN10329-111).

8 Select the Network Elements topology panel in the IEMS 
Topologies tree.

9 In the list of network elements that displays, determine whether 
the USP is present.

10 Use the following table to determine your next step.

11 Update the software version in the Device Version field by editing 
the Managed Object Properties in IEMS for the USP that you just 
upgraded to reflect the new software version. 

Refer to either of the following procedures to update the Device 
Version field: 

• “Editing and viewing object properties using Java Web Start 
Client” in Nortel Carrier Voice over IP Network Upgrades and 
Patches, NN10440-450.

• “Editing and viewing object properties using Web Client” in 
Nortel Carrier Voice over IP Network Upgrades and Patches, 
NN10440-450.

12 Exit from the IEMS Java Web Start Client.

If the USP is Do

configured in IEMS step 11

not configured in IEMS step 12
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13 You have completed this procedure. 

Configure the Nortel Ethernet Routing Switch port to auto-negotiate

To enable auto-negotiation of the Ethernet port speed and duplex state, 
perform the following steps at the command line interface to the Nortel 
Ethernet Routing switch. 

Note: After you execute step 1 of this procedure and you confirm 
that you will need to modify auto-negotiate, lock the IPS7 card before 
you make the 8600 port change. After the port change, load and 
unlock the card. Perform these steps at the USP OAMP workstation.

If Do

you have a Nortel Ethernet 
Routing Switch 8600 in your 
solution and you want to 
enable auto-negotiate

Configure the Nortel 
Ethernet Routing Switch port 
to auto-negotiate on 
page 116

otherwise Post-upgrade checklist on 
page 120

ATTENTION
Perform this procedure if you have a Nortel Ethernet Routing 
Switch 8600 in your solution, and you want to enable 
auto-negotiation.

If you are not using auto-negotiation, skip this procedure and 
proceed to Post-upgrade checklist on page 120.
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Configuring the Nortel Ethernet Routing Switch port 

At the CLI for the Nortel Ethernet Routing Switch

1 Determine the slot and port on the Nortel Ethernet Routing 
Switch that connects to the device:

> show ip arp info <ip_address> 

ip_address
is the physical IP address of the IPS7 GW card.

The slot and port are reported.

If the response indicates MLT instead of the slot and port, 
perform this operation from the mate Nortel Ethernet Routing 
Switch unit. If the response indicates that no arp entry is found, 
ping the IP address from the CLI, and retry the command.

2 Determine if the ports are already set to auto-negotiate by 
typing:

> show port info config port <slot>/<port> 

and pressing the Enter key.

where

<slot>
is the slot number from the previous step

<port>
is the port number from the previous step

prompt:cpu> show ip arp info 172.30.242.25

172.30.242.25 00:90:69:1a:d4:fc  200 1/2 DYNAMIC 272

=========================================================================
                                        Ip Arp
=========================================================================
  IP_ADDRESS       MAC_ADDRESS      VLAN  PORT    TYPE    TTL
-------------------------------------------------------------------------
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3 Use the following table to determine your next step.

At the OAMP workstation

4 Lock the IPS7 card connected to the 8600 port as follows:

a Click Configuration>platform>node.

b Click the Graphical View tab.

c Double-click the slot of the IPS7 card you want to lock.

d Click Lock. A confirmation dialog box appears.

e Click Yes.

At the CLI for the Nortel Ethernet Routing Switch

5 Set the slot and port to auto-negotiate:

> config ethernet <slot>/<port> auto-negotiate 
enable 

The slot and port are reconfigured to auto-negotiate and the 
prompt returns.

prompt:cpu> show port info config port 1/2

===========================================================================
                                        Port Config
===========================================================================

PORT                AUTO  SFFD  ADMIN       OPERATE     DIFF-SERV  QOS MLT 
NUM   TYPE          NEG.        DUPLX SPD   DUPLX SPD   EN   TYPE  LVL ID  
---------------------------------------------------------------------------
1/2   100BaseTX     false  false half  100   full  100  fals  core  1   0 

If the ports Do

are already set to auto-negotiate step 10

are not set to auto-negotiate step 4

prompt:cpu> config ethernet 1/2 auto-negotiate enable
prompt:cpu>
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6 Verify the port configuration:

> show port info config port <slot>/<port> 

The slot and port configuration is displayed.

7 Commit the change:

> save config 

At the OAMP workstation

8 Load the IPS7 card as follows:

a Click Configuration>platform>node.

b Click Graphical View.

c Double-click the slot of the IPS7 card you want to load.

d Click Load. A confirmation dialog box appears.

e Click Yes.

9 Unlock the IPS7 card as follows:

a Click Configuration>platform>node.

b Click the Graphical View tab.

c Double-click the slot of the IPS7 card you want to unlock.

d Click Unlock. A confirmation dialog box appears.

e Click Yes.

10 This procedure is complete. Proceed to the next section 
(Post-upgrade checklist.).

prompt:cpu> show port info config port 1/2

===========================================================================
                                        Port Config
===========================================================================

PORT                AUTO  SFFD  ADMIN       OPERATE     DIFF-SERV  QOS MLT 
NUM   TYPE          NEG.        DUPLX SPD   DUPLX SPD   EN   TYPE  LVL ID  
---------------------------------------------------------------------------
1/2   100BaseTX     true  false half  100   full  100  fals  core  1   0  
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Post-upgrade checklist
This checklist provides system cleanup on your upgraded USP. Perform 
this checklist on your alternate boot server. To complete the 
post-upgrade checklist, perform the following steps:

Note: Wait 24 hours after completing all of the upgrade procedures.

Performing the post-upgrade checklist

At the OAMP workstation

1 Begin a new log time period to end the upgrade log tracking time 
period as follows: 

Click Fault>Log>New Period.

2 Delete all snapshots associated with the previous USP release 
from both RTC system nodes as follows: 

Note: If you have changed your boot image file for a new 
release, Nortel Networks recommends that you delete the 
out-of-date image file from your system using the File 
Manager function.

a In the File Manager panel, select the data snapshot to be 
deleted from the Snapshot field in the RTC portion of the 
window.

Note: You cannot delete the boot data snapshot. If you 
attempt to delete the boot data snapshot, you will receive 
an error message.

b Expand the Snapshot folder.

c Expand the folder for the previous version of the software.

d Click Delete to delete the snapshot. An hourglass appears 
while the data snapshot is deleted. When the deletion 
operation is complete, snapshot is removed from the RTC 
side of the File Manager panel.

3 Delete old loads from the Alternate Boot Server:

a Open the ABS configuration manager application. If your 
ABS is on a PC, then open the configuration manager from 
the Windows Start menu and perform substeps d to f. If your 
ABS is on the CMT, then proceed to substep b.
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b There are two versions of the ABS Configuration Manager 
available on the CMT. One is graphically-based and the other 
is console-based. If you want to use graphically-based ABS 
Configuration Manager, perform substeps c to f. If you want 
to use the console-based ABS Configuration Manager, 
perform substeps g to h.

c For the graphically-based ABS Configuration Manager on 
the CMT, perform the following:

i Ensure that your X-Windows server software is running 
and that host access permissions are allowed for the 
CMT. Refer to your X-Windows server software manual 
for details.

ii Log in to the CMT as root.

iii Enter DISPLAY=<IP address of your PC>:0.0. To find 
the IP address of the PC you are using, enter ipconfig 
from a DOS window.

iv Enter export DISPLAY. To confirm the export, enter 
echo $DISPLAY.

v Enter cd /<USP install path>/ntssgusp/abs.

vi Launch the ABS Configuration Manager. Type ./ABS&

d Click File>uninstall Release. The uninstall existing release 
window appears.

e Select the release to be deleted from the drop-down menu.

f Click Apply.

g Enter ./console_abs to launch the console-based ABS 
Configuration Manager application. You will be prompted 
with the ABSCM> prompt.

h Enter ABSCM>release uninstall <release-name>

Note: Refer to the ABS_Specification.pdf document for all 
the command syntax of the console-based ABS 
Configuration manager.

4 Delete old snapshots from the Alternate Boot Server.

a Click the Administration button on the main menu.

b Click File Manager.

c In the Alternate Boot Server window, navigate to the release 
associated with the snapshots you wish to remove. 

d Click on the snapshot you want to delete.

e Click Delete.
Nortel USP Upgrades



Nortel Networks Confidential122Copyright © 2006, Nortel Networks
5 Perform a hard disk defragmentation on your alternate boot PC. 
On a Windows 2000 machine, open the Disk Defragmenter utility 
(Start>Programs>Accessories>System Tools>Disk 
Defragmenter). Select the Analyze option. If Windows 
recommends that the disk be Defragmented, run the utility.

6 This procedure is complete. Return to Upgrading the USP on 
page 13 to determine your next step.
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Migrating the Alternate Boot Server (ABS) from USP PC to CS 2000 
Management Tools

The purpose of this method is to provide information and instructions 
for migrating the Alternate Boot Server (ABS) from the USP EM PC to 
the CS 2000 Management Tools (CMT) server on the SPFS platform

Material requirements
The following is a list of material requirements.

Required documents
The required documents are listed as follows:

• Job Site Information Package

• Customer Information Documentation (CI or CNCD)

• Installation Safety Manual (ISM/IM0). This document can be 
requested from the Regional Tool Facility.

• EHS (European Health and Safety) EHS_MAN_002

• WMS (Workmanship Standards) WMS-001

Tools
The tools listed in the following table are required.

Software
Software for USP11.0.0, USP Compact, or BBSTP on CD is required.

Precautions
Observe the general safety precautions against personal injury and 
equipment damage outlined in the ISM/IM0 at all times.

Due to the nature of the BOOTP protocol, the BOOTP server must 
either be located on the same IP subnet as the USP or be used with a 
BOOTP server and router that support BOOTP forwarding.

Do not power down a terminal if connected to a console port on the 
T240. Powering down the terminal will take the T240 down.

Do not disconnect a serial connection to the Netra T240 before closing 
any application that was previously using the port. This will cause the 

U.S. tools Canadian tools Description

E003389 E003389 Installation Data Toolkit
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server to lock-up and will have to be powered down to gain access once 
again.

Prior to integrating any equipment into the network it is critical to verify 
the IP Address assigned to the new equipment is not already assigned 
to existing equipment on the network. Perform aPing test prior to 
assigning IP Addresses to any equipment to verify the IP Address is not 
currently assigned. Verify no response is received when performing the 
Ping test prior to integrating any equipment into the network.

Preparations
Prior to starting the operations presented in this method, arrange all 
materials, tools, and test equipment at the work location so as to 
minimize fatigue and inconvenience.

For the installation, you can use either a graphical interface 
(Hummingbird suite) or a command line interface. If you require it, 
ensure the FT laptop has Hummingbird installed and contains FTP and 
Exceed. If you use Exceed, make sure the application is configured to 
support the upgrade. See Configuring Exceed for an upgrade on 
page 58.

The following information must be provided by the customer or site 
specific documentation. Use the following table to help insert the 
customer provided information throughout the method. The following 
table will be used for an initial install.

System variable Actual value

Client PC Information (Current ABS)

PC HostName

PC IP Address

List all PC usernames and passwords 
that will be needed

DISTINCT BOOTP/FTP/NFS Server 
passwords

ABS Configuration Manager password

Configured Sites

Alternate Boot Loads
RTC-12
RTC-15
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Overview
In the Carrier Voice over IP Solution, a customer has the option of 
moving the existing PC ABS function to the CS 2000 Management 
Tools (CMT) server. The following method will provide the procedures 
to complete the migration of the ABS and install the USP EM on the 
CMT server.

This method contains the following procedures:

• Preparing the PC ABS workstation on page 126

• Creating a user account for the CMT Server on page 127

ABS Snapshot

CS2000 Management Tools Server (new ABS)

CMT HostName

CMT IP Address

Root user

Root password

root

(root password is set to root during 
factory loading of the SPFS)

User account

Password

FIELD

SERVICE

BOOTP settings

SiteName

Gateway IP Address

RTC-12 MAC address Note: Do not include the :’s

RTC-15 MAC address Note: Do not include the :’s

Host IP Address Note: This is the RTC IP address

Server IP Address Note: This is the CMT IP address

Subnet Mask

System variable Actual value
Nortel USP Upgrades



Nortel Networks Confidential126Copyright © 2006, Nortel Networks
• Install/configure the ABS application using only one of the following 
procedures:

— Install and configure the ABS application using Exceed on 
page 128

— Install and configure the ABS application using a console on 
page 129

• Access verification and pre-migration completion on page 131

• CMT Server migration on page 133

• Verification procedure on page 141

PC ABS workstation
To prepare the PC ABS workstation for installation and configuration 
procedures, perform the following steps.

Preparing the PC ABS workstation

From the ABS PC workstation

1 To reduce the amount of data that will need to be moved, 
uninstall any unused releases from the ABS Manager. To do this, 
perform the following steps:

Note: The tool checks to ensure that no existing USP sites 
are using the release loads files and snapshots.

a Log in to the ABS Configuration Manager: Click File>Login.

b Type SERVICE for the password and click OK.

2 Select File>Uninstall Release.

3 Click on the release that you want to uninstall and select apply.

Note: Do not remove the current release.

4 Close the Uninstall window when all unused releases have been 
removed.

5 Delete any old snapshots from the existing USP sites if they are 
no longer required.

To open the ABS Configuration Window, select File>ABS 
Configuration.

6 Select each Site using the drop-down menu. Using the 
drop-down menu, select the Snapshot record you want to delete.

7 Click Delete.

Note: You will only be able to delete snapshots that begin 
with bv******. Keep at least one recent snapshot.
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8 Click OK when all old snapshots have been removed.

9 Repeat for all sites in office.

10 In the ABS Configuration window, record all the sites that are 
configured along with their Alternate Boot loads and Snapshot 
records. (See the table provided on page 124.)

11 Log out of the ABS Configuration Manager.

12 Click YES to confirm and minimize window.

13 Record the BOOTP settings for reference when setting up the 
CMT as follows:

a Open the Distinct BootP Server window.

Note: You may have to log in using File>Login (FIELD 
passwd SERVICE).

b Click Configure>Server.

c Click on each of the Address and Networks tabs.

d Capture data.

14 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

CMT Server user account
Complete the setup of the FIELD user account on the SPFS server. By 
default, the FIELD account is created in the Carrier Voice over IP group. 
However, the password now needs to be set.

Creating a user account for the CMT Server

Setup UserID and Password for ABS Server on CMT

1 Open a Telnet session. To do this, click Start>Run.

2 Enter the <CMT IP address>:

Telnet <CMT IP address>

3 Click OK. 

The session opens.

4 Log in as maint:

Type: maint

Type: <maint password>

5 Switch user to root:

Type: su -root
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Type: <root password>

Note: The FIELD user is created as part of the SPFS install.

6 Change the password to SERVICE:

Type: passwd FIELD

7 Type: SERVICE

You will be prompted to re-enter your new password.

8 Do not close the Telnet window.

Install and configure the ABS application using Exceed

When installing the BPS/USP EM on the SPFS server, you will have to 
export the display to your PC. If you prefer to use a command line 
interface for this installation, see Install and configure the ABS 
application using a console on page 129. The SPFS is a headless 
server (no keyboard or monitor) and therefore a GUI install must be 
re-routed to a PC with a display.

In this procedure, use Exceed to assist in the installation of the USP 
EM.

Installing and configuring the ABS application using Exceed

From the FT Laptop PC

1 Make sure Exceed is configured to support the upgrade. See the 
Preparations section of this procedure and Configuring Exceed 
for an upgrade on page 58.

2 To start an Exceed session, click Programs>Hummingbird 
Suite>Exceed>Exceed.

The program will be running and minimized to the task bar.

3 Return to your Telnet session.

Type: DISPLAY=<IP address of your PC>:0.0

Note: To find the IPaddress of the PC you are using, type: 
ipconfig from a DOS window.

4 Type: export DISPLAY

5 Type: echo $DISPLAY

ATTENTION
The procedures in this section assume that you are using the 
software distribution CD.
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You will see <IP address of your PC>:0.0.

6 Type: cd /cdrom/cdrom0

Type: ls

Ensure that you see the file install.bin.

7 Type: ./install.bin

This can take several minutes to launch. You will see the 
following response:

• Preparing to install...

• Extracting the JRE from the installer archive...

• Unpacking the JRE...

• Extracting the installation resources from the installer 
archive...

• Configuring the installer for this system's environment...

• Launching installer...

• ........

• (new PC window)

A new window will appear on your PC (from the Exceed 
session).

8 Click Next and you will see the selection of components to 
install.

9 Select the components you want to install using the Choose 
button.

10 Click Next and you will see a warning for disk space.

11 Click OK.

12 When the installation is complete, close the window by selecting 
Done.

13 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

Install and configure the ABS application using a console
If you have already performed this installation with Exceed in the last 
procedure, skip this procedure.
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Installing and configuring the ABS application using a console

From the FT Laptop PC

1 To switch to the CDROM, enter cd /cdrom.

This command can be slightly different depending on the system 
you are using.

2 To ensure that the file is there, type ls.

Check that you see the file install.bin.

3 Enter ./install.bin -i console.

You will now see preparations for console mode installation. This 
can take a few minutes.

4 Press Enter to continue.

5 Use the following table to determine your next step.

6 Change the selected packages. Type 1 to select item 1 USP 
Software Loads and ABS Manager. 

Example of Package Selection panel

1 - [X] USP Software loads and ABS Manager

2 - [X] USP Graphical Interface Client

3 - [X] USP User Manuals and Documentation Suite

Enter software component numbers and press 
<Enter> to continue. 

7 Press Enter and go to step 10.

8 Change the selected packages. 

• Type 1 to select item 1 USP Software Loads and ABS 
Manager. 

• Type 2 to deselect item 2 USP Graphical Interface Client

Example of Package Selection panel

1 - [X] USP Software loads and ABS Manager

2 - [ ] USP Graphical Interface Client

If you are Do

using the CS 2000 Management Tools 
webstart application

step 6

not using the CS 2000 Management Tools 
webstart application

step 8
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3 - [X] USP User Manuals and Documentation Suite

Enter software component numbers and press 
<Enter> to continue. 

9 Press Enter to continue.

10 You will be asked to confirm your selection.

For non-CMT platforms, press Enter to see the default USP 
directory. You can change this if you wish.

11 Press Enter again to start the installation. You will be updated 
with the installation progress.

12 Press Enter to exit.

13 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

Access verification and pre-migration completion
This procedure will verify the access to the ABS Configuration Manager 
and ensure that there are no sites at this time.

This procedure will also locate the ntssgusp/abs directory in 
preparation for the migration.

Verifying access and completing pre-migration steps

From the FT laptop PC

1 Type: su -root

password <root password>

2 Type: cd /<USP install path>/ntssgusp/

Type: chown -R FIELD:maint2 abs

Type: chmod -R 775 abs

3 Check to ensure permissions are set correctly.

Type: ls -l

Response:

drwxrwxr-x 2 FIELD maint2 *date* *time* abs

4 Exit from the root user shell. Type: exit 

5 Move to the abs directory. Type: cd abs

6 There are two versions of the ABS Configuration Manager 
available on the CMT. One is graphically-based and the other is 
console-based. If you want to use the graphically-based ABS 
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Configuration Manager, perform steps 7 to 12. If you want to use 
the console-based ABS Configuration Manager, perform steps 
13 to 16.

7 Ensure that DISPLAY is set correctly.

8 The following command will start the ABS Configuration 
Manager and export the display back to the IP assigned in the 
previous steps.

Type: ./ABS

You will be prompted to set your password.

9 Enter the Password twice:

Type: SERVICE

Type: SERVICE

Click OK.

10 Log in to the ABS Configuration Manager. To do this, click 
File>Login.

11 Enter SERVICE as the password and click Login.

12 If you successfully logged into the ABS Configuration Manager, 
you have verified access.

Note: The window will appear blank. Click on the File 
pull-down menu. If logout is highlighted then you are logged 
in.

You can minimize the ABS window.

13 Enter ./console_abs to launch the console-based ABS 
Configuration Manager application.

You will be prompted with ABSCM> prompt.

14 Set your password. Enter ABSCM>passwd set.

Supply password as SERVICE and re-enter the same again for 
confirmation. 

15 Log in to the ABS to go through. 

Type: ABSCM> login.

Supply password as SERVICE.

16 If you successfully logged into the ABS Configuration Manager, 
you have verified access.

17 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.
NN10045-461   (I)SN09U   Standard 08.02 October 2006



Nortel Networks Confidential133Copyright © 2006, Nortel Networks
CMT Server migration
To migrate to the CMT Server, perform the following procedures:

• Configure the FTP and NFS servers on the CMT to allow the 
transfer of files from existing PC ABS. See Configuring the FTP and 
NFS servers on page 133.

• Set permissions on the ABS files. See Setting permissions on the 
ABS files (CMT) on page 136.

• Verify the data transfer. See Verifying the data transfer on page 137.

• Enable and configure the BOOTP server on the CMT ABS. See 
Enabling and configuring the BOOTP server on the CMT ABS on 
page 138.

• Disable the BOOTP server on the PC ABS. See Disabling the 
BOOTP server on the PC ABS on page 139.

• Verify correct settings for the USP (RTC). See Verifying correct 
settings for the USP (RTC) on page 140.

Configuring the FTP and NFS servers

From the FT Laptop PC

1 Open a new Telnet session to the CMT Server.

maint

<maint password>

2 Switch to user root.

su -root

<root password>

Root privileges are required for SPFS modifications.

3 From the # prompt,

Type: cli

4 Enter the number next to the Configuration menu option.

5 Enter the number next to the NFS Configuration menu option.

6 Enter the number next to the usp_nfs_on (turn on the USP NFS 
configuration) menu option.

You will see this message, followed by the NFS Configuration 
options:
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=== Executing "usp_nfs_on"
USP NFS successfully turned on
=== "usp_nfs_on" completed successfully

Note 1: You need root privileges to enable/disable NFS on 
the CMT.

Note 2: Before executing usp_NFS_on, log in again after 
running the USP installer.

Note 3: After executing usp_NFS_on, select list_nfs to check 
if the directory used to install the USP is mounted.

7 Select X three times to exit the CLI tool.

8 Minimize the Telnet session.

Note: The next several steps will move the existing ABS data 
from the USP EM PC over to the CMT Server. These steps will 
be performed from the Field Technician’s laptop. An abstemp 
folder will need to be created on the FT laptop to temporarily 
hold the data during the transfer.

9 Open a DOS prompt. To do this, click Start >Run. Type cmd and 
click OK.

10 Type: cd \.

11 Type: mkdir abstemp.

12 Type: dir /w.

13 Ensure that the abstemp folder is present, and close the DOS 
window.

14 Before any transfer of data, the FT laptop MUST disable the 
CyberArmor Personal Firewall.

Mouse over the CyberArmor icon in the task bar (right lower 
corner of the screen).

a Right-click on the CyberArmor.

b Select Stop Profile from the pop-up menu.

c When prompted to stop the profile, click Yes.

15 To open an FTP session, click: Start>Programs> 
Hummingbird suite>Host Access>FTP for windows 
Explorer.

The Hummingbird Neighborhood window appears.

16 To connect to the USP EM PC, click: File>New FTP Profile.

17 Complete the FTP Site Properties in the General tab window:

Host Address: <USP PC IPaddress>
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User Name: ntssg

Password: 1ntssgstp (note: 1 is the #1)

Account:

Initial Directory: /c/ntssgusp/abs

18 In the FTP Site Properties window, select the Advanced tab.

19 De-select Enable Directory Caching.

20 De-select Passive Mode.

21 In the FTP Site Properties window, select the Other tab.

Use the drop-box to select Binary for Uploading and 
Downloading.

22 Click OK.

23 Save the FTP profile:

Type: USP PC

Click OK.

24 Double-click the USP PC. 

A new Explorer window appears.

25 Ensure that the FT Laptop PC FTP window has the c:\abstemp 
directory expanded (use the + to expand the directory structure).

Ensure that the USP PC has the ntssgusp\abs directory 
expanded.

26 Copy the releases folder from the USP PC to the FT laptop PC.

Right-click on the releases folder and drag it to the C:\abstemp 
folder. Select Copy Here.

You will see the file transfer window while copying the files.

27 Copy the sites folder from the USP PC to the FT laptop PC.

28 Right-click on the sites folder and drag it to the C:\abstemp 
folder. Select Copy Here.

29 Check the C:\abstemp folder to ensure that the releases and 
sites folders exist (and sub-folders).

30 Close the Explorer window.

31 Double-click the CMT server.

A new Explorer window appears.

Note: The CMT Server profile was created in Creating a user 
account for the CMT Server on page 127.
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32 Ensure that the FT Laptop PC has the abstemp directory 
expanded and that the CMT has the /opt/usp directory 
expanded.

33 Copy folders from the FT Laptop PC to the CMT Server by 
holding down the Ctrl key and selecting all releases that are not 
currently present on the CMT Server. Drag and drop these 
folders by right-clicking Copy Here.

34 Ensure that the FT Laptop PC has the abstemp\sites directory 
expanded. Ensure that the CMT has the /opt/usp directory 
expanded.

35 Copy all files and folders from the FT Laptop PC to the CMT 
Server.

36 Right-click and drag and drop the entire Sites folder onto the 
/opt/usp/ntssgusp/abs directory.

37 Check to ensure that all data was transferred correctly by 
expanding the CMT server /opt/usp/ntssgusp/abs directory.

38 Expand each of the releases and sites folders to ensure correct 
data.

39 Close the Explorer window and the Hummingbird FTP program.

40 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

Setting permissions on the ABS files (CMT)

From the FT Laptop PC

1 Open/restore a Telnet session to the CMT Server.

2 Ensure that you are logged in as root.

su -root

3 Type: cd /

Type: chmod -R 775 /<USP install path>

4 Ensure permissions are set correctly.

Type: cd /<USP install path>/../

Type: ls -l

Look for the following line:

drwxrwxr-x 5 FIELD maint2 *date* *time* usp

5  Minimize the Telnet session.

6 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.
NN10045-461   (I)SN09U   Standard 08.02 October 2006



Nortel Networks Confidential137Copyright © 2006, Nortel Networks
Verifying the data transfer

From the FT Laptop PC

1 Restore or open the ABS Configuration Manager on the CMT 
Server. There are two versions of the ABS Configuration 
Manager available on the CMT. One is graphically-based and 
the other is console-based. If you restored or opened the 
graphically-based ABS Configuration Manager, perform steps 2 
to 6. If you restored or opened the console-based ABS 
Configuration Manager, perform steps 7 to 13.

2 Click on File>ABS Configuration.

The Alternate Boot Server window appears.

3 Verify that all required sites and releases are present.

4 Select each site in the drop down menu and verify the following:

• RTC loads

• Snapshots

5 Click the Apply button for each site. When you click the Apply 
button, the ABS Configuration Manager will rebuild the 
site-specific configuration files based on the CMT directory 
structure.

6 Minimize the ABS Configuration Manager window.

7 Enter the ABSCM>site show <site-name> command to view 
the site's details.

8 To view all the available loads, enter ABSCM>load show all

9 To view all the snapshots for a specified site, enter:

ABSCM>snapshot show <site-name>

10 To modify the RTC12-load of the specified site, enter:

ABSCM>site mod <site-name> rtc12-load <new-rtc12-load- 
name>

11 To modify the RTC15-load of the specified site, enter:

ABSCM>site mod <site-name> rtc15-load 
<new-rtc15-load-name>

12 To modify the snapshot name of the specified site, enter:

ABSCM>site mod <site-name> snapshot 
<new-snapshot-name>

13 When the site mod command is executed, the ABS 
Configuration Manager will rebuild the site-specific configuration 
files based on the CMT directory structure.
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14 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

Note: Refer to the ABS_Specification.pdf document for the 
complete details of all the console-based ABS Configuration 
Manager commands.

Enabling and configuring the BOOTP server on the CMT ABS

From the FT Laptop PC

1 Open a new Telnet session to the CMT Server.

2 Ensure that you are logged in as root:

su -root

Root privileges are required for SPFS modifications.

3 From the # prompt,

Type: cli

4 Enter the number next to the Configuration menu option.

5 Enter the number next to the Bootp Configuration menu option.

6 Enter the number next to the bootp_add menu option.

=== Executing "bootp_add"

Note: RTC 12 or 15

7 Enter the bootfile value [bf] for bootp entry.

8 The following value is for RTC12. Type:

/<USP install path>/ntssgusp/abs/sites/<sitename>/ 
rtc1/rtcboot

For RTC 15, type:

/<USP install path>/ntssgusp/abs/sites/<sitename>/rtc2/ 
rtcboot

9 Enter the gateway IP address [gw] for bootp entry. 

Type: <gateway IP address>

10 Enter the home directory [hd] for bootp entry.

Type: .

Note: The character is a period [.].

11 Enter the hardware type [ht] for bootp entry.

Type: ethernet
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12 Enter the hardware address [ha] for bootp entry.

Note: Do not include the colon [:] character. The following is 
an example: (010080E944056B)

Type: <MAC address>

13 Enter the host IP address [ip] for bootp entry.

Type: <Host IP address>

Note: RTC IP Address

14 Enter the server IP address [sa] for bootp entry.

Type: <Server IP address>

Note: CMT IP Address

15 Enter the subnet mask value [sm] for bootpentry.

Type: <subnet mask> Bootfile: *****

Gateway IP Address: **********

Home Directory: .

Hardware Type: ethernet

Hardware Address: **********

Host IP Address:**********

Server IP Address: **********

Subnet Mask: **********

Type ok to accept current settings.

16 Ensure that all data you entered is correct. If not, type anything 
other than OK and press Enter. Re-enter the data.

Type: ok

17 Repeat step 1 to step 15 for RTC#2 which is called RTC15.

18 Type: X

You will see the Configuration options.

19 Select X three times to exit the CLI tool.

20 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

Disabling the BOOTP server on the PC ABS

From the USP EM PC

1 Restore the (PC) Distinct BOOTP Server window.
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2 Click Configure>Disabled.

3 Exit the Distinct BOOTP Server window. To do this, click 
File>Exit. Click Yes.

4 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

Verifying correct settings for the USP (RTC)

From the BOOTP server

1 You can use the USP EM PC to perform step 1 to step 5 or log 
in to the CMT and perform the steps.

2 Telnet to RTC-12 or RTC-15.

3 Log in with a valid username and password.

4 Type: admin abs test rtc-12

Verify the prompt is returned after issuing the command. This 
can take a couple of seconds to respond.

The following response indicates that there were no issues.

CMD>

5 Type: admin abs test rtc-15

Verify the prompt is returned after issuing the command. This 
can take a couple seconds to respond.

The following response indicates that there were no issues.

CMD>

6 Type: admin abs show all

Verify that the abs-ipaddress is the address of the CMT ABS and 
that the correct RTC loads and snapshot are selected.

(Example response ONLY for a site named Ireland):

~CMD>admin abs show all
rtc-12-loadname = ss7rtc_ppc750_09_00_03_47c
rtc-15-loadname = ss7rtc_ppc750_09_00_03_47c
snapshot-version = v9.0.3
snapshot-name = bv2_0-6277d3091d27
snapshot-date = 07/29/2004 09:39:39
snapshot-description = usp9.0.3.47c_02_purge
abs-ipaddress = 47.142.142.26
abs-path = /opt/usp/ntssgusp /abs/sites/Ireland/rtc2/rtcboot
virtual-index = 1
~CMD>
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7 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

Verification procedure

Verifying and testing your work

From the USP EM PC

1 Launch the Application Launch Point.

2 Launch the USP GUI.

3 Click File>session-login.

4 Log in to the site:

FIELD

SERVICE

5 Click Administration, then select alternate-boot-server.

Verify that the BootP response displays the IP address of the 
CMT Server. Also verify that the bootP path matches what was 
set during the procedure Enabling and configuring the BOOTP 
server on the CMT ABS.

6 Click Test.

Click OK.

7 Check the logs using the Logs button on the USP GUI. The Site 
log window appears.

8 Verify that the test completed successfully for each RTC and that 
there are no ABS related alarms.

In the information field you should see abs test: success.

9 In the Alternate Boot settings window, click Modify and verify 
that the ABS settings are successfully applied (no adverse logs, 
alarms or pop-ups).

In the log information field you should see abs mod:success.

10 From the USP GUI, click Administration>Backup.

CAUTION

Do not perform step 17 to step 35 if this is an 
in-service site.
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11 Enter a snapshot description of CMT ABS Test Snapshot. Click 
Backup.

Note: This action can take up to 10 minutes.

When the action is complete, a Successful snapshot window will 
open.

12 Click OK and close the backup window.

13 From the USP GUI, click Administration>File Manager.

After a couple of minutes, the File Manager panel opens.

14 In the right-hand side of the screen (RTC **), double-click 
snapshots.

Double-click the appropriate v11.0.x release folder and locate 
the snapshot that was just created.

Note: Highlight each snapshot and view the description field 
to find the snapshot called CMT ABS Test snapshot or use the 
date field.

15 Select the snapshot and click the left arrow in the middle of the 
screen to transfer the snapshot to the CMT ABS.

The transfer will be completed when Ready is displayed in the 
bottom left corner of the GUI.

16 In the left-hand side of the screen (Alternate Boot Server), 
double-click snapshots.

Double-click the appropriate v11.0.x release folder and locate 
the snapshot that was just transferred.

Note: Use the description field to ensure that you are using 
the correct snapshot.

17 Select the snapshot on the ABS (located on the left side of the 
file manager screen). Click the delete button.

Verify that the snapshot is deleted (no adverse logs, alarms or 
pop-ups). Use the Log manager to verify the logs.

18 Select the snapshot on the RTC side (located on the right side 
of the file manager screen). Click the delete button.

Verify that the snapshot is deleted (no adverse logs, alarms or 
pop-ups). Use the Log manager to verify the logs.

19 Close the window.

Note: Do not perform step 20 to step 37 if this is an in-service 
site. If this is an in-service site, skip to step 37.
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From the FT laptop PC

20 Establish an Exceed connection to the CMT Server and launch 
the ABS Configuration Manager (refer to the procedure Verifying 
the data transfer to open the ABS Configuration Manager from 
the CMT Server). There are two versions of the ABS 
Configuration Manager available on the CMT. One is 
graphically-based and the other is console-based. To use the 
graphically-based ABS Configuration Manager, perform steps 
21 and 22. If you want to use the console-based ABS 
Configuration Manager, perform steps 23 and 24.

21 Select File>Login. Enter the password SERVICE.

22 Select File>SSMON. 

The Signaling Server Monitor window will open.

23 Log in to the console-based ABS Configuration manager. 

Type: ABSCM> login.  Enter the password SERVICE.

24 To read ssmon logs from the ssmon.log file type either of the 
following commands:

ABSCM>ssmonlog show all

or

ssmonlog show last-num-logs <no-of-logs>

Note: The console-based ABS Configuration Manager does 
not display ssmon logs in real time. Instead, it reads from the 
ssmon.log file and display logs. Refer to the 
ABS_Specification.pdf document for complete details.

25 Leave the Signaling Server Monitor window open on the FT 
laptop and perform the next steps from the USP EM PC.

From the USP EM PC

26 Start the USP EM GUI and log in.

27 Click System Mgmt.

The Site System Management window will open.

28 Click the first shelf on the top left.

The control shelf window will open.

29 Look at the graphical representation of the RTC cards in slot 12 
and slot 15. The active RTC will have a check mark in a small 
box. You must perform this test on the inactive RTC.
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Click the inactive RTC to open the screen and note the IP 
address for this card. This IP address is used in the next step as 
the <Inactive IP address>.

30 Click Start>Run and type: FTP <Inactive IP address>.

31 Log in using the FIELD username with password SERVICE 
account.

32 Type: cd /sd0 *** Changed directory to "/sdo".

33 Type: del sysconf.

34 From the USP GUI, click the lock button on the inactive RTC that 
is currently open. Click Yes.

The RTC changes to LOCK status.

35 From the USP GUI, click the load button on the inactive RTC that 
is currently open. Click Yes.

Note: Several pop-ups can be generated indicating a loss of 
connection to the RTC (This step can several minutes).

36 Monitor the SSMON window for status messages as the RTC 
performs an alternate boot. The entire process can take up to 15 
to 30 minutes.

37 When connectivity to the RTC is restored (a pop-up message 
will open). Click OK.

38 Click the unlock button on the inactive RTC that is currently 
open.

39 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.
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In-Service Introduction of Inter-CAM Communication Media (ICCMs)

Use this procedure for an in-service conversion of the USP from a 
dual-shelf system, that links directly through OC-3 cables, to a system 
where the shelves link through two Inter-CAM Communication Media 
(ICCM). The system can be expanded to a multi-shelf system with up 
to eight Communications Application Module (CAM) shelves. 

One shelf remains designated as the control CAM shelf and the 
additional shelves are designated as extension CAM shelves. Each 
extension shelf contains two CCs and a maximum of 16 additional 
system nodes.

CAUTION
Service interruption
To reduce the risk of service-affecting issues, Nortel 
recommends that you perform the procedure during 
low traffic periods in the maintenance time frame.

CAUTION
Service degradation
If your system has a mate system, do not perform 
maintenance activities on the mate while you perform 
the conversion procedure on the first node. 
Performing maintenance activities during an 
inservice conversion can affect service.

ATTENTION
Make sure that the dual-shelf system is working properly before 
starting the conversion procedure. Check alarm information to 
make sure there are no alarms pointing to problems with CC 
cards, RTC cards, fibre-optic cable states, loss of communication 
redundancy (LOCR), isolation, or shelf states. Make sure that all 
connecting nodes and network connections are in service. 
Review and coordinate the conversion procedure with other 
operating companies in the network.
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To maintain the existing redundancy and availability of the Signaling 
Server platform, two ICCMs are deployed in the system configuration. 
One CC node on each shelf is connected to the first ICCM. The other 
CC node on each shelf is connected to the second ICCM. This 
configuration allows full redundancy of SS7 messaging as well as the 
inservice upgrade capability of the ICCMs. The servicing of one ICCM 
can take place while the second ICCM carries traffic. This ensures no 
service impact to SS7 traffic on the link cards.

Prerequisites
This procedure has the following prerequisites:

• The USP software upgrade must be complete, and all nodes in the 
system must be running the same load.

• The USP must be provisioned with all hardware required for a 
dual-shelf system.

• The RTC must be provisioned with a CE3 (Computing Engine 3 with 
PP4), running a PP4 750-based load.

• Two ICCMs and associated cabling must be available on-site.

Hardware requirements
The following tables describe the additional minimum hardware 
requirements needed for the in-service conversion.

Additional minimum hardware required for dual-shelf in-service 
conversion

Name PEC Quantity

ICCM (Marconi 
TNX-210 ATM 
Switch)

NTST87AA 2 for the system

RTC CE3 
(Computing Engine 
3 with PP4)

NTST11BA 2 for the control shelf

OC-3 Fibre Cables NTST88AA 4 (2 for each shelf)
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Additional minimum hardware required for four-shelf in-service 
conversion

Name PEC Quantity

ICCM (Marconi 
TNX-210 ATM 
Switch)

NTST87AA 2 for the system

RTC CE3 
(Computing Engine 
3 with PP4)

NTST11BA 2 for the control shelf

OC-3 Fibre Cables NTST88AA 8 (2 for each shelf)

Additional minimum hardware required for five-shelf in-service 
conversion

Name PEC Quantity

ICCM (Marconi 
TNX-210 ATM 
Switch)

NTST87AA 2 for the system

RTC CE3 
(Computing Engine 
3 with PP4)

NTST11BA 2 for the control shelf

OC-3 Fibre Cables NTST88AA 10 (2 for each shelf)

Additional minimum hardware required for eight-shelf in-service 
conversion

Name PEC Quantity

ICCM (Marconi 
TNX-210 ATM 
Switch)

NTST87AA 2 for the system

RTC CE3 
(Computing Engine 
3 with PP4)

NTST11BA 2 for the control shelf

OC-3 Fibre Cables NTST88AA 16 (2 for each shelf)
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Each ICCM provides room for expansion to up to 16 OC-3 ports. The 
ICCM terminates the OC-3 links from the CAM shelves and provides 
routing between the CAM shelves on the system.

Nortel arranges the provisioning of the ICCMs to allow the CAM 
shelves to communicate properly. Once the ICCMs are powered up, 
they are ready to route ATM messages. If a routing error occurs, 
contact your next level of support.

The OC-3 fibre cable between the CCs and the ICCMs is a standard 
multi-node fibre cable with SC connectors. This cable is custom-built for 
the application. The same OC-3 cable is used for connection of 
dual-shelf systems. Nortel Networks recommends that you have extra 
OC-3 cables on site in case of fibre optic cable failure.

For additional information on provisioning the hardware, contact your 
installation prime. 

In-service introduction of ICCMs process

This section describes the step-by-step in-service conversion 
procedure for converting a system from a dual-shelf system, that links 
directly through OC-3 fibre optic cables, to a system where the CAM 
shelves link through ICCMs.

CAUTION
Non-redundant system
During most of the conversion procedure, the system 
operates without redundancy. Nortel recommends 
that the conversion take place during low traffic 
periods in the maintenance window in order to avoid 
loss of service.
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ICCM connectivity with system shelves

A dual-shelf system with ICCMs uses four OC-3 cable links. The 
following is a summary of the cable connections:

• OC-3 link 1 connects the CC in slot 1 on the control CAM shelf to 
line 0 on line card 0 of ICCM 0.

• OC-3 link 2 connects the CC in slot 1 on the extension CAM shelf to 
line 1 on line card 0 of ICCM 0.

• OC-3 link 3 connects the CC in slot 18 on the control CAM shelf to 
line 0 on line card 0 of ICCM 1.

• OC-3 link 4 connects the CC in slot 18 on the extension CAM shelf 
to line 1 on line 0 of ICCM 1.

In order for the pre-configured ICCMs to operate correctly with the CAM 
shelves, the system must be connected as specified in this document.

To avoid disruption to service, only one set of the CCs is disabled at one 
time, and all traffic is carried on the other set of CCs during the 
conversion procedure. In this document, conversion of the CCs in slot 
1 occurs first, followed by the conversion of the CCs in slot 18.

In-service introduction of ICCMs procedures
In-service introduction of ICCMs in a dual-shelf system requires the 
completion of the following separate procedures:

1. Upgrade USP software.

2. Log in and check alarms.

3. Disable and offline the CC in slot 1 on the extension CAM shelf.

• • • • •
CC CC

Application
Mission

Slice

Application
Mission

Slice

ATM 
switch

ATM 
switch

• • • • •
CC CC

Application
Mission

Slice

Application
Mission
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4. Disable and offline the CC in slot 1 on the control CAM shelf.

5. Remove OC-3 cable connections for the CCs in slot 1 and connect 
the CCs to ICCM 0.

6. Enable the CC in slot 1 on the control CAM shelf.

7. Enable the CC in slot 1 on the extension CAM shelf.

8. Check OMs to ensure messaging goes through ICCM 0.

9. Soak the system after conversion of the CCs in slot 1.

10.Disable and offline the CC in slot 18 on the extension CAM shelf.

11. Disable and offline the CC in slot 18 on the control CAM shelf.

12.Remove OC-3 cable connections for the CCs in slot 18 and 
connect the CCs to ICCM 08.

13.Enable the CC in slot 18 on the control CAM shelf.

14.Enable the CC in slot 18 on the extension CAM shelf.

15.Check OMs to ensure messaging goes through ICCM 1.

16.Add ICCMs to the system GUI.

17.Soak the dual-shelf system.

Upgrading the USP software
Use the procedures in this document.

Logging in and checking alarms

At the OAMP workstation

1 Double-click the system icon on your OAMP workstation to 
display the login window.

2 To log in to the system GUI, select a site and enter a user 
identification and password. 

3 Check alarm information to make sure there are no alarms 
pointing to problems with CC cards, RTC cards, fibre-optic cable 
states, loss of communication redundancy (LOCR), isolation, or 
shelf states. To view alarms, click the alarm banner. The Alarms 
window appears.

4 You have completed this procedure. If applicable, return to the 
higher level task flow or procedure that directed you to this 
procedure.
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Disabling and offlining the CC in slot 1 on the extension CAM shelf

On the system GUI

1 Click Configuration>platform>node>Graphical View.

2 Click the icon for the extension shelf to open the shelf_name 
window for the extension CAM shelf.

3 Click the icon for the CC in slot 1 to open the CC in slot 1 on the 
graphical view window for the extension CAM shelf.

4 Click Lock to lock the CC in slot 1. A pop-up window appears. 
Click Yes to confirm the change. Check the Administrative state 
(the word Locked should be highlighted).

5 Click Offline to offline the CC in slot 1. A pop-up window 
appears. Click Yes to confirm the change. Click OK to continue. 
Check the Availability status in the Maintenance portion of the 
window. The word Offline should be highlighted.

6 Click Close to return to the shelf_name window for the extension 
CAM shelf. Click Close to return to the System Configuration 
window.

7 You have completed this procedure. If applicable, return to the 
higher level task flow or procedure that directed you to this 
procedure.

Disabling and offlining the CC in slot 1 on the control CAM shelf

On the system GUI

1 Click Configuration>platform>node>graphical view.

2 Click the icon for the control CAM shelf to open the shelf_name 
window for the control CAM shelf.

3 Click the icon for the CC in slot 1 to open the CC in slot 1 on the 
maintenance and provisioning window for the control CAM shelf.

4 Click Lock to lock the CC in slot 1. A pop-up window appears. 
Click Yes to confirm the change. Check the Administrative state 
in the Maintenance portion of the window. The word Locked 
should be highlighted.

5 Click Offline to offline the CC in slot 1. A pop-up window 
appears. Click Yes to confirm the change. Click OK to continue. 
Check the Availability status in the Maintenance portion of the 
window. The word Offline should be highlighted.

6 Click Close to return to the shelf_name window for the control 
CAM shelf. Click Close to return to the System Configuration 
window.
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7 You have completed this procedure. If applicable, return to the 
higher level task flow or procedure that directed you to this 
procedure.
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Removing OC-3 cable connections for the CCs in slot 1 and 
connecting the CCs to ICCM 0

On the system

1 Remove the OC-3 cable connecting the CC in slot 1 on the 
control CAM shelf to the CC in slot 1 on the extension CAM shelf.

2 Use the OC-3 cable to connect the CC in slot 1 on the control 
CAM shelf to line 0 on line card 0 of the ICCM 0. Check the lights 
on the ICCM 0 for line 0. A green light indicates the cable 
connection is correct. If the red light is on, a line error occurred. 
If a problem occurs, perform the steps in the Troubleshooting an 
OC-3 cable connection on page 161.

3 Use an OC-3 cable to connect the CC in slot 1 on the extension 
CAM to line 1 on line card 0 of the ICCM 0. Check the lights on 
the ICCM 0 for line 0. A green light indicates the cable 
connection is correct. If the red light is on, a line error occurred. 
If a problem occurs, perform the steps in the Troubleshooting an 
OC-3 cable connection on page 161.

4 You have completed this procedure. If applicable, return to the 
higher level task flow or procedure that directed you to this 
procedure.

Enabling the CC in slot 1 on the control CAM shelf

On the system GUI

1 Click Configuration>platform>node>graphical view.

2 Click the icon for the control CAM shelf to open the shelf_name 
window for the control CAM shelf.

3 Click the icon for CC in slot 1 to open the CC in slot 1 on the 
maintenance and provisioning window for the control CAM shelf.

CAUTION
Service interruption
When you remove the OC-3 cable, make sure that 
you remove the cable from the CCs in slot 1. 
Removal of the OC-3 cable from the CCs in slot 18 
can disrupt service. Make sure that the LED on the 
CC TM is OFF before you remove the OC-3 cable. If 
the LED is ON, the CC is enabled, and loss of service 
can occur.
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4 Click Load to load the CC in slot 1. A pop-up window appears. 
Click Yes to confirm the change. Check the Operational state in 
the Maintenance portion of the window to verify the changes. 
The word Unlocked should be highlighted.

5 Click Unlock to unlock the CC in slot 1. A pop-up window 
appears. Click Yes to confirm the change. Check the 
Administrative state in the Maintenance window. The word 
Unlocked should be highlighted.

6 Click Close to return to the shelf_name window for the control 
CAM shelf. Click Close to return to the System Configuration 
window.

7 You have completed this procedure. If applicable, return to the 
higher level task flow or procedure that directed you to this 
procedure.

Enabling the CC in slot 1 on the extension CAM shelf

On the system GUI

1 Click Configuration>platform>node>graphical view.

2 Click the icon for the extension CAM shelf to open the 
shelf_name window for the extension CAM shelf.

3 Click the icon for CC in slot 1 to open the CC in slot 1 on the 
maintenance and provisioning window for the extension CAM 
shelf.

4 Click Load to load the CC in slot 1. A pop-up window appears. 
Click Yes to confirm the change. Check the Operational state in 
the Maintenance portion of the window to verify the changes. 
The word Unlocked should be highlighted.

5 Click Unlock to unlock the CC in slot 1. A pop-up window 
appears. Click Yes to confirm the change. Check the 
Administrative state in the Maintenance window. The word 
Unlocked should be highlighted.

6 Click Close to return to the shelf_name window for the extension 
CAM shelf. Click Close to return to the System Configuration 
window.

7 Wait for at least 10 minutes after enabling the CC in slot 1 on the 
extension shelf. Check the system logs and OMs for any 
unusual events.

8 You have completed this procedure. If applicable, return to the 
higher level task flow or procedure that directed you to this 
procedure.
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Checking OMs to ensure messaging goes through LCCM 1

On the system GUI

1 Click Performance>om.

2 Click Search.

3 In the criteria box select:

• application-namefrom the Field drop-down menu

• equal from the Condition drop-down menu

• ATM Driver Messaging from the Value drop-down menu

4 Click Retrieve.

5 You have completed this procedure. If applicable, return to the 
higher level task flow or procedure that directed you to this 
procedure.

Soaking the system after the conversion of CCs in slot 1

At the OAMP workstation

1 Allow the system to soak for one hour after the conversion of the 
CCs in slot 1.

2 Check the logs for the system. Click Logs on the main menu to 
open the Logs window. 

3 Check the alarms for the system. To view alarms, click the alarm 
banner. The Alarms window appears. Check alarm information 
to make sure there are no alarms pointing to problems with CC 
cards, RTC cards, fibre-optic cable states, loss of 
communication redundancy (LOCR), isolation or shelf states.

If a problem or failure occurs at any time during soak do not 
proceed until the problem is resolved and the alarm clears. If you 
cannot resolve the problem, contact your next level of support.

4 You have completed this procedure. If applicable, return to the 
higher level task flow or procedure that directed you to this 
procedure.

Disabling and offlining the CC in slot 18 on the extension CAM 
shelf

On the system GUI

1 Click Configuration>platform>node>graphical view.

2 Click the icon for the extension CAM shelf to open the 
shelf_name window for the extension CAM shelf.
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3 Click the icon for the CC in slot 18 to open the CC in slot 18 on 
the maintenance and provisioning window for the extension 
CAM shelf.

4 Click Lock to lock the CC in slot 18. A pop-up window appears. 
Click Yes to confirm the change. Check the Administrative state 
in the Maintenance portion of the window. The word Locked 
should be highlighted.

5 Click Offline to offline the CC in slot 18. A pop-up window 
appears. Click Yes to confirm the change. Click OK to continue. 
Check the Availability state in the Maintenance portion of the 
window. The word Offline should be highlighted.

6 Click Close to return to the shelf_name window for the extension 
CAM shelf. Click Close to return to the System Configuration 
window.

7 You have completed this procedure. If applicable, return to the 
higher level task flow or procedure that directed you to this 
procedure.

Disabling and offlining the CC in slot 18 on the control CAM shelf

On the system GUI

1 Click Configuration>platform>node>graphical view.

2 Click the icon for the control CAM shelf to open the shelf_name 
window for the control CAM shelf.

3 Click the icon for the CC in slot 18 to open the CC in slot 18 on 
the maintenance and provisioning window for the control CAM 
shelf.

4 Click Lock to lock the CC in slot 18. A pop-up window appears. 
Click Yes to confirm the change. Check the Administrative state 
in the Maintenance portion of the window. The word Locked 
should be highlighted.

5 Click Offline to offline the CC in slot 18. A pop-up window 
appears. Click Yes to confirm the change. Click OK to continue. 
Check the Availability state in the Maintenance portion of the 
window. The word Offline should be highlighted.

6 Click Close to return to the shelf_name window for the control 
CAM shelf. Click Close to return to the System Configuration 
window.

7 You have completed this procedure. If applicable, return to the 
higher level task flow or procedure that directed you to this 
procedure.
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Removing the OC-3 cable connections for the CCs in slot 18 and 
connecting the CCs to ICCM 1

On the system

1 Remove the OC-3 cable connecting the CC in slot 18 on the 
control CAM shelf to the CC in slot 18 on the extension CAM 
shelf.

2 Use the OC-3 cable to connect the CC in slot 18 on the control 
CAM shelf to line 0 on line card 0 of the ICCM 1. Check the lights 
on the ICCM 1 for line 0. A green light indicates the cable 
connection is correct. If the red light is on, a line error occurred. 
If a problem occurs, perform the steps in the Troubleshooting an 
OC-3 cable connection on page 161.

3 Use an OC-3 cable to connect the CC in slot 18 on the extension 
CAM to line 1 on line card 0 of the ICCM 1. Check the lights on 
the ICCM 1 for line 0. A green light indicates the cable 
connection is correct. If the red light is on, a line error occurred. 
If a problem occurs, perform the steps in the Troubleshooting an 
OC-3 cable connection on page 161.

4 You have completed this procedure. If applicable, return to the 
higher level task flow or procedure that directed you to this 
procedure.

Enabling the CC in slot 18 on the control CAM shelf

On the system GUI

1 Click Configuration>platform>node>graphical view.

2 Click the icon for the control CAM shelf to open the shelf_name 
window for the control CAM shelf.

3 Click the icon for CC in slot 18 to open the CC in slot 18 on the 
maintenance and provisioning window for the control CAM shelf.

CAUTION
Service interruption
When you remove the OC-3 cable, make sure that 
you remove the cable from the CCs in slot 18. 
Removal of the OC-3 cable from the CCs in slot 1 
can disrupt service. Make sure that the LED on the 
CC TM is OFF before you remove the OC-3 cable. If 
the LED is ON, the CC is enabled, and loss of service 
can occur.
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4 Click Load to load the CC in slot 18. A pop-up window appears. 
Click Yes to confirm the change. Check the Operational state in 
the Maintenance portion of the window to verify the changes. 
The word Unlocked should be highlighted.

5 Click Unlock to unlock the CC in slot 18. A pop-up window 
appears. Click Yes to confirm the change. Check the 
Administrative state in the Maintenance window. The word 
Unlocked should be highlighted.

6 Click Close to return to the shelf_name window for the control 
CAM shelf. Click Close to return to the System Configuration 
window.

7 You have completed this procedure. If applicable, return to the 
higher level task flow or procedure that directed you to this 
procedure.

Enabling the CC in slot 18 on the extension CAM shelf

On the system GUI

1 Click Configuration>platform>node>graphical view.

2 Click the icon for the extension CAM shelf to open the 
shelf_name window for the extension CAM shelf.

3 Click the icon for CC in slot 18 to open the CC in slot 18 on the 
maintenance and provisioning window for the extension CAM 
shelf.

4 Click Load to load the CC in slot 18. A pop-up window appears. 
Click Yes to confirm the change. Check the Operational state in 
the Maintenance portion of the window to verify the changes. 
The word Unlocked should be highlighted.

5 Click Unlock to unlock the CC in slot 18. A pop-up window 
appears. Click Yes to confirm the change. Check the 
Administrative state in the Maintenance window. The word 
Unlocked should be highlighted.

6 Click Close to return to the shelf_name window for the extension 
CAM shelf. Click Close to return to the System Configuration 
window.

7 Wait for at least 10 minutes after enabling the CC in slot 18 on 
the extension shelf.

8 You have completed this procedure. If applicable, return to the 
higher level task flow or procedure that directed you to this 
procedure.
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Checking OMs to ensure messaging goes through ICCM 1

On the system GUI

1 Click OMs on the main menu to open the Operation 
Measurements window.

2 Set the interval to five minutes in the Interval Type field. Click 
Query Interval Data to open the OMBrowser Interval Selection 
window.

3 Click on the bottom line of the window to select the last 
five-minute interval. Click Get Selected Intervals. A pop-up 
window appears. Click Yes to confirm your change.

4 Click Open Filter Selection Window to open the Operational 
Measurements Filter window.

5 Select ATM Driver Messaging in the Application Filter list.

6 Select the CC in slot 18 on the extension shelf in the Element 
Filter list.

7 Click Close to return to the Operational Measurements window.

8 In the Register portion of the window, locate “Plane 1 Message 
Count” and “Plane 2 Message Count”. The OM Value should be 
the same for each count. If the OM value is not the same for the 
two counts, contact your next level of support.

9 You have completed this procedure. If applicable, return to the 
higher level task flow or procedure that directed you to this 
procedure.

Adding ICCMs on the system GUI

On the system GUI

1 Click System mgmt on the main menu to open the System 
Configuration window.

2 Click Add ICCM. A pop-up window appears. Click Yes to confirm 
the change. Click OK to continue. Two ICCMs appear on the 
GUI.

3 Check the OC-3 link state indicator on the GUI to make sure all 
the OC-3 links are up.

If an OC-3 link is down, the OC-3 link indicator changes to show 
a broken link in the black square below the shelf.

4 You have completed this procedure. If applicable, return to the 
higher level task flow or procedure that directed you to this 
procedure.
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Soaking the dual-shelf system

At the OAMP workstation

1 Allow the system to soak for one hour after the conversion to a 
system with two ICCMs.

2 Check the logs for the system. Click Logs on the main menu to 
open the Logs window.

3 Check the alarms for the system. To view alarms, click the alarm 
banner. The Alarms window appears. Check for alarms pointing 
to problems with CC cards, RTC cards, fibre-optic cable states, 
loss of communication redundancy (LOCR), isolation or shelf 
states.

4 Check the OC-3 link state indicator on the system GUI. Make 
sure all of the OC-3 links are up.

5 You have completed this procedure. If applicable, return to the 
higher level task flow or procedure that directed you to this 
procedure.

Troubleshooting and system recovery
This section provides the procedures for troubleshooting and 
recovering a system from problems encountered during the conversion 
process.

Each line on the ICCM has a green light and a red light. A green light 
indicates a correct OC-3 cable connection. A red light indicates a 
problem with the connection. After you connect the CAM shelves to the 
ICCMs using OC-3 cables, check the lights. If the red light is on, 
perform the following steps:

ATTENTION
If a failure occurs at any time during this phase, refer to 
Conversion failure management on page 161. If you cannot 
resolve the problem, contact your next level of support.

ATTENTION
When you complete this procedure, you can now install additional 
shelves on the system. Refer to the section “Adding an Extension 
Shelf” in the Configuration Management guide.
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Troubleshooting an OC-3 cable connection

At the ICCM

1 A reversal of the RX and TX nodes on the OC-3 cable can be the 
problem. To solve the problem, unplug the cable, switch the RX 
and TX nodes, and plug the cable in again. If the green light is 
on, continue with the conversion procedure. Otherwise, perform 
the next step.

2 Use another OC-3 cable to replace the current cable. Make sure 
that you connect the RX and TX nodes correctly.

3 You have completed this procedure. If the green light is on, 
continue with the conversion procedure. If the problem 
continues, contact your next level of support.

Conversion failure management
To abort the conversion, perform the following backout procedures:

1. Remove ICCMs on the system GUI.

2. Perform a back out for the ICCM 1.

3. Remove the ICCM and connect the CCs with direct OC-3 cable 
links.

4. Perform a back out for the ICCM 0.

Removing ICCMs from the system GUI

At the OAMP workstation

1 On the system GUI, open the System Configuration window. To 
do this, click Configuration>platform>system.

2 Click Delete ICCM. A pop-up window appears. Click Yes to 
confirm. Click OK to continue. The system removes the ICCMs 
from the GUI.

3 You have completed this procedure. Continue the backout 
procedure or contact your next level of support

ATTENTION
If you added ICCMs on the system GUI, perform the following 
steps to remove them. If no ICCMs were added, skip this 
procedure.
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Performing a back out for ICCM 1

At the OAMP workstation

1 Disable and offline the CC in slot 18 on the extension shelf. See 
Disabling and offlining the CC in slot 18 on the extension CAM 
shelf on page 155.

2 Disable and offline the CC in slot 18 on the control shelf. See 
Disabling and offlining the CC in slot 18 on the control CAM shelf 
on page 156.

3 Remove ICCM 1 and connect the CCs in slot 18 with direct OC-3 
cable links. See Removing the OC-3 cable connections for the 
CCs in slot 18 and connecting the CCs to ICCM 1 on page 157.

4 Enable the CC in slot 18 on the control shelf. See Enabling the 
CC in slot 18 on the control CAM shelf on page 157.

5 Enable the CC in slot 18 on the extension shelf. See Enabling 
the CC in slot 18 on the extension CAM shelf on page 158.

6 You have completed this procedure. If applicable, return to the 
higher level task flow or procedure that directed you to this 
procedure.

Removing the ICCM and connecting the CCs with direct OC-3 
cable links

At the system

1 Remove the OC-3 cable connecting the CC on the control CAM 
shelf to the line card of the ICCM.

2 Remove the OC-3 cable connecting the CC on the extension 
CAM shelf to the line card of the ICCM.

3 Use an OC-3 cable to connect the CC on the control CAM shelf 
to the CC on the extension CAM shelf.

CAUTION
Service interruption
When you remove the OC-3 cables, make sure that 
you remove the OC-3 cables from the CCs in slot 18 
connecting to ICCM 1. Removal of the OC-3 cables 
from the CCs in slot 1 connecting to ICCM 0 can 
result in loss of service. Make sure that the LED on 
the CC TM card is OFF before removing the OC-3 
cables. If the LED is ON, the CC is enabled and 
service can be disrupted.
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4 You have completed this procedure. If applicable, return to the 
higher level task flow or procedure that directed you to this 
procedure.

Performing a back out for ICCM 0

At the system

1 Disable and offline the CC in slot 1 on the extension shelf. See 
Disabling and offlining the CC in slot 1 on the extension CAM 
shelf on page 151.

2 Disable and offline the CC in slot 1 on the control shelf. See 
Disabling and offlining the CC in slot 1 on the control CAM shelf 
on page 151.

3 Remove ICCM 0 and connect the CCs in slot 1 with direct OC-3 
cable links. See Removing OC-3 cable connections for the CCs 
in slot 1 and connecting the CCs to ICCM 0 on page 153.

4 Enable the CC in slot 1 on the control shelf. See Enabling the CC 
in slot 1 on the control CAM shelf on page 153.

5 Enable the CC in slot 1 on the extension shelf. See Enabling the 
CC in slot 1 on the extension CAM shelf on page 154.

6 You have completed this procedure. If applicable, return to the 
higher level task flow or procedure that directed you to this 
procedure.
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USP High-Speed Link Cutover Procedure

This section details procedures for converting a Common Channel 
Signaling System 7 (SS7) low-speed link (LSL) linkset into an 
high-speed link (HSL) linkset.

Throughout this document, links originating on DS0A, V.35 or 
Channelized E1/T1 link system nodes are referred to as low-speed 
links (LSLs). Links originating on high-speed link or SS7 IP link system 
nodes are referred to as high-speed links (HSL). The ATM high-speed 
link system node physically consists of the T1/E1 Transition Module 
(TM) and a link mission card. The computing engine mission card 
consists of a Power/SCSI/Ethernet (PSE) TM, an SS7 IP link mission 
card, and an MTP2 E1 HSL.

This section also provides the procedures to transition from low-speed 
link (LSL) linksets to high-speed link (HSL) linksets.

CAUTION

Conduct the cutover during a maintenance window, 
where the low speed link traffic is below 0.2 erlang.

To cutover from 16 LSL to two HSLs, the low speed 
link traffic must be less than 0.1 erlang.
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Hardware requirements
The following hardware is required for ATM high-speed links:

• T1/E1 Transition Module NTST81BA, or NTST81AB

• Link Mission Card

— NTST10BA (base link card)

The following hardware is required for E1 MTP2 high-speed links:

• T1/E1 Transition Module NTST81BA

• Link Mission Card

— NTST10CA

The following hardware is required for SS7 IP High Speed links:

• PSE TM NTST09AA, NTST09AB, or NTST09AC

• IP Link Mission Card which includes:

— NTST11BA (LE3)

For further information about issues related to hardware installations 
involving high-speed links (HSL), contact the installation prime.

Software requirements
Software release USP8.0 or later is required for this cutover. 
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HSL cutover process

HSL cutover guidelines
Note the following guidelines when performing the HSL cutover:

• The high-speed link system node can support HSLs for C-links, B/D 
links, or A-links.

• Carry out the C-linkset cutover before the signaling transfer point 
(STP) quad B/D-linkset cutover because only two nodes are 
involved in the C-linkset cutover.

• An HSL system node provides a single port in the same space that 
an LSL system node provides four or eight ports. Therefore, on a full 
system, four or eight LSL ports must be decommissioned for each 
HSL added.

The HSL cutover applies to:

• C-linkset cutover for a signaling transfer point (STP) pair

• B-linkset cutover for an STP quad

• D-linkset cutover for an STP quad

ATTENTION
Ensure that the network to be converted and all connecting nodes 
and network connections are in service.

Ensure that all alarms have been cleared before proceeding with 
the cutover procedure.

Review and coordinate the cutover procedure with other 
operating companies in the network that are involved in the 
cutover procedure.

Up to 16 ATM/E1or MTP2 HSL system nodes can be 
commissioned on an extension shelf (12 on a control shelf). For 
IP HSLs, up to eight HSL, can be commissioned on each shelf. 
On a fully populated system, an LSL link system node must be 
decommissioned before installing each HSL system node. 
Existing links on the LSL system node must be moved to other 
link system nodes or decommissioned. If your system is fully 
populated, contact your next level of support.

The cutover procedure requires operating company personnel to 
be present at each office that is affected by a link change during 
any step of the procedure. Nortel Networks recommends that you 
appoint a cutover project manager to coordinate all the steps for 
the cutover.
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• A-links-to-service control point (SCP) cutover

• A-links-to-SSP cutover

Note: Nortel Networks recommends performing the C-linkset 
cutover for an STP pair before attempting the B-linkset and D-linkset 
cutover for an STP quad.

HSL cutover procedures

The following figure shows the cutover steps.

ATTENTION
During cutover, HSLs and LSLs are supported in the same mixed 
linkset. The USP supports mixed HSL and LSL linksets only 
during the cutover procedure. After the cutover is complete, 
linksets s will be homogeneous.

ATTENTION
Contact your next level of support to determine the correct version 
of the engineering bulletin and to determine if any other 
engineering bulletins apply.
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The HSL cutover requires completing the following procedures:

1. Cutover setup.

a. Configure the HSL system node. Refer to the procedure 
“Provisioning Links” in the Operational Configuration section of 
the customer documentation.

b. Configure ports. Refer to the procedure “Provisioning Links” in 
the Operational Configuration section of the customer 
documentation.

Note: For MTP2 E1 HSLs the cable must be connected to 
RJ45 cable.

c. Load the HSL system nodes. Refer to the procedures 
“Provisioning Links” in the Operational Configuration section of 
the customer documentation.

2. Add HSLs.

a. Configure SAAL timers. Refer to the procedure “Adding a 
SAAL Timer or Parameter Index” in the Operational 
Configuration section of the customer documentation.

b. Configure SAAL parameters. Refer to the procedure “Adding a 
SAAL Timer or Parameter Index” in the Operational 
Configuration section of the customer documentation.

c. Deactivate LSLs. Refer to the procedure “Activating and 
Deactivating Links” in the Operational Configuration section of 
the customer documentation.

d. Delete LSLs. Refer to the procedure “De-provisioning links” in 
the Operational Configuration section of the customer 
documentation.

e. Configure HSLs. Refer to the applicable ATM, E1 MTP2, or IP 
HSL procedure in the Operational Configuration section of the 
customer documentation.

f. Perform BERT on ATM and E1 MTP2 before RTSing the links, 
“Perform BERT” in the Security and Administration guide.

g. RTS the link. Refer to the procedure “Activating and 
deactivating links” in the Operational Configuration section of 
the customer documentation.

3. Soak the HSLs in a mixed linkset. Refer to the procedure Soaking 
the HSLs on page 171.
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4. Offline the LSLs.

a. Calculate LSL traffic. Refer to the procedure “Performing USP 
traffic calculations” in the Operational Configuration section of 
the customer documentation.

Note: If the Erlang level is above 0.2 E, contact the 
personnel responsible for your next level of support. Use 
Operational Measurements to calculate traffic and to 
determine if you can proceed with the cutover. 

b. Calculate LSL traffic on the mate node. Refer to the procedure 
“Performing USP traffic calculations” in the Operational 
Configuration section of the customer documentation.

Note: If the Erlang level is above 0.2 E, contact the 
personnel responsible for your next level of support. Use 
Operational Measurements to calculate traffic and to 
determine if you can proceed with the cutover. 

c. Deactivate the LSL. Refer to the procedure “Activating and 
deactivating links” in the Operational Configuration section of 
the customer documentation.

d. Deactivate all remaining LSLs in the linkset. Refer to the 
procedure “Activating and deactivating links” in the Operational 
Configuration section of the customer documentation.

e. Deactivate the LSL on the mate node. Refer to the procedure 
“Activating and deactivating links” in the Operational 
Configuration section of the customer documentation.

f. Deactivate all remaining LSLs in the linkset on the mate node. 
Refer to the procedure “Activating and deactivating links” in the 
Operational Configuration section of the customer 
documentation.
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5. Soak the HSLs. Refer to the procedure Soaking the HSLs on 
page 171. 

6. Decommission the LSLs.

a. Delete the datafill for the LSLs. Refer to the procedure 
“De-provisioning links” in the Operational Configuration section 
of the customer documentation.

b. Delete LSLs for remaining links in the linkset. Refer to the 
procedure “De-provisioning links” in the Operational 
Configuration section of the customer documentation.

c. Delete the datafill for the LSLs on the mate node. Refer to the 
procedure “De-provisioning links” in the Operational 
Configuration section of the customer documentation.

d. Delete LSLs for remaining links in the linkset on the mate node. 
Refer to the procedure “De-provisioning links” in the 
Operational Configuration section of the customer 
documentation.

Soaking the HSLs

1 Allow the system to soak for one hour.

2 Check the logs for the system. Click Fault>Logs on the main 
menu to open the Logs window.

3 Check the alarms for the system. To view alarms, click the alarm 
banner. The Alarms window appears. Check for alarms.

4 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

Recovery procedure for HSL failure
If an HSL fails during either phase, traffic is redistributed over the 
remaining links in the linkset or combined linkset. The following steps 
describe the HSL recovery procedure.

ATTENTION
If a failure occurs at any time during this phase, refer to 
Performing the recovery procedure for HSL failure on page 172.
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Performing the recovery procedure for HSL failure

At the OAMP workstation

1 Deactivate and offline the failed HSL. Refer to the procedure 
“Activating and deactivating links” in the Operational 
Configuration section of the customer documentation.

2 Perform a remote Loopback at the far end of the link. Refer to 
the procedure “Remote Loopback” in the Fault Management 
section of the customer documentation. On the local end of the 
link, perform a BERT Operation. Refer to the procedure 
“Performing Bert” in the Security and Administration guide. Clear 
any faults before proceeding.

3 RTS the HSL. To RTS the link, refer to the procedure “Activating 
and deactivating links” in the Operational Configuration section 
of the customer documentation.

4 Select one of the following options.:

5 Provision LSLs. Refer to the procedure “Provisioning links” in the 
Operational Configuration section of the customer 
documentation.

6 RTS the LSLs. To RTS the link, refer to the procedure “Activating 
and deactivating links” in the Operational Configuration section 
of the customer documentation.

7 Contact your next level of support.

8 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

If Do

the failure condition exists continue to step 5.

the failure condition clears step 8
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Aborting an Upgrade

The following sections describe the procedures used to abort a 
software upgrade before it has been completed. When you have 
completed this process, your system runs the previous software 
version.

To abort an upgrade, downgrade only the system nodes that have been 
upgraded.

At the OAMP workstation
1 Use the following table to determine the procedure you need to 

start with to downgrade your system.

CAUTION

Once you complete the upgrade of the RTC in slot 
12, the only way to return to the previous 
configuration is to perform an alternate boot from a 
data snapshot created prior to the upgrade. Do not 
upgrade the RTC in slot 12 until you perform test 
calls and ensure the system is ready for completion 
of the upgrade.

CAUTION

Before you begin any downgrade procedure, make 
sure that you have a recent data snapshot on the 
alternate boot server.

If Do

RTC 12 has been upgraded Downgrade the USP from a 
data snapshot on page 174

RTC 12 is not upgraded, but 
other cards have been 
upgraded

Downgrading Using the Wiz-
ard on page 174

RTC 15 has been upgraded Downgrading the inactive 
RTC node in slot 15 on 
page 184
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2 When all the cards in the system are running the original release 
loads, complete the following sections:

• Stop the upgrade and delete the upgrade package on 
page 194

• Downgrade the GUI on page 196

3 You have completed this procedure.

Downgrade the USP from a data snapshot
If you upgraded RTC12, you can only return to the previous software 
version by restoring the data snapshot created before you upgraded the 
GUI. The downgrade process contains the following procedures:

At the OAMP workstation
1 Restore the data snapshot you created before beginning the 

upgrade. For the restore procedure, refer to USP Security and 
Administration, NN10159-611.

For the procedure to create a data snapshot, refer to Creating an 
alternate boot data snapshot on page 22.

2 You have completed this procedure. If applicable, return to the 
higher level task or procedure that directed you to this 
procedure.

Downgrading Using the Wizard
Perform the following procedures to prepare the system for the 
software downgrade using the Wizard.

Downgrade the system nodes
Run the Wizard node downgrade to perform the software downgrade 
for a specific node. You can also select multiple nodes to downgrade 
using the Shift+Ctrl keys or Ctrl+click with a mouse.

Downgrade order

ATTENTION
If you have not yet upgraded RTC12 prior to this downgrade, then 
follow the downgrade order listed below. Otherwise, refer to 
Downgrade the USP from a data snapshot on page 174.
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Downgrade the system nodes in the following order:

1. CC in slot 18 on control CAM shelf, see To downgrade a CC node: 
on page 175.

2. CCs in slot 18 on extension CAM shelves, see To downgrade a CC 
node: on page 175.

3. NPC, NPS and NPE nodes on control and extension CAM shelves, 
see To downgrade NPC, NPS, and NPE nodes: on page 176.

4. Link system nodes on control and extension CAM shelves, see To 
downgrade a single Link node: on page 181.

5. CCs in slot 1 on extension CAM shelves, see To downgrade a CC 
node: on page 175.

6. CC in slot 1 on control CAM shelf, see To downgrade a CC node: 
on page 175.

7. Inactive RTC in slot 15, see To downgrade the inactive RTC in slot 
15: on page 184.

Downgrading a CC node
The following procedure is used to downgrade a CC node using the 
wizard.

To downgrade a CC node:

At the OAMP workstation 

1 Select the node to downgrade in the list of available nodes in the 
software upgrade wizard.

2 Click the Downgrade button. The system asks for confirmation.

3 Wait for the node downgrade to complete (the upgrade-status 
will change to not-upgraded on completion).

Note: In the event that the automatic node downgrade fails to 
complete successfully, perform the downgrade manually. See 
Manually downgrading system nodes on page 185.

4 Monitor the USP to ensure it performs normally and does not 
report any LOG_SWERRs or LOG_TRAPs. If it does, do not 
continue with the node downgrade, contact your next level of 
support.

5 This procedure is complete. Continue to downgrade the next 
system node in the order appropriate to your system.
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Downgrading the NPC, NPS, and NPE nodes
The downgrade of an NPC, NPS and/or NPE node requires special 
handling to ensure that the local subsystem instances associated with 
an NPC, NPS and an NPE chain have been deactivated. Also, the 
downgrading node must not be the active NPC node. If it is, then a 
switch of activity must be performed prior to downgrading the node.

To downgrade NPC, NPS, and NPE nodes:

On LSMS

1 Release all SMI connections to the UNPM. Refer to the LSMS 
operation manual for release methods.

At the OAMP workstation

2 In the menu bar, click Administration>Platform>Node.

3 Select the NPC you want to downgrade.

4 Check the activity state of the NPC.

5 Click Lock.

CAUTION
Potential for NPDB corruption
If downgrading the NP nodes/chains, the connection 
to the LSMS will need to be released on the LSMS. 
Contact Nortel Networks Technical Support for more 
information. Failure in doing so will result in NPDB 
corruption.

ATTENTION
Do not use the software upgrade wizard to downgrade 
NPC/NPS/NPE system nodes if there are NPE chains 
provisioned. Manually downgrade these nodes instead, as 
detailed in Manually downgrading the NPC, NPS, and NPE 
system nodes on page 189.

If Do

the NPC is active Perform a SWACT, then 
continue to step 5.

the NPC is inactive Continue to step 5.
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6 Deactivate the NP local subsystem instance running on the 
inactive NPC system node. To do this, click 
configuration>sccp>shared-local-subsystem-instance , 
select the NPx of interest and click Deactivate.

7 If an NPE chain has been provisioned with this NPC node as the 
master and with an alternate NPS system node, then deactivate 
the local subsystem instance running on the alternate NPS. To 
do this, click 
configuration>sccp>shared-local-subsystem-instance, 
select the NPx of interest and click Deactivate.

8 Using the software upgrade wizard, select the NPC node to 
downgrade in the list of available nodes. 

9 Click the Downgrade node button. The system asks for 
confirmation.

10 Wait for node downgrade to complete (the upgrade-status will 
change to not-upgraded on completion).

Note: In the event that the automatic node downgrade fails to 
complete successfully, perform the downgrade manually. See 
Manually downgrading the NPC, NPS, and NPE system 
nodes on page 189.

11

12 Wait for the local subsystem instance to be 
deactivated/prohibited.

13 Re-activate the local subsystem instance running on the inactive 
NPC To do this, click 
configuration>sccp>shared-local-subsystem-instance, 
select the NPx of interest and click Activate.

If Do

an NPE chain is 
provisioned with this NPC 
node as master

repeat steps 8 to 10 for each 
NPE system node and the 
alternate NPS system node 
associated with this chain.

there is no NPE chain 
associated with this NPC 
node

continue this procedure.
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14

15 Wait for the re-activated local subsystem instances to return to 
the activated/allowed state. 

16 Monitor the USP to ensure it performs normally and does not 
report any LOG_SWERRs or LOG_TRAPs. If it does, do not 
continue with the node downgrade.

17

18 Deactivate the NP local subsystem instance running on the NPS 
system node. To do this, click 
configuration>sccp>shared-local-subsystem-instance, 
select the NPx of interest and click Deactivate.

19 If an NPE chain has been provisioned with an alternate NPS for 
the selected NPS, deactivate the NP LSS instance running on 
the alternate NPS system node. To do this, click 
configuration>sccp>shared-local-subsystem-instance, 
select the NPx of interest and click Deactivate.

If Do

an NPE chain is 
provisioned with an 
alternate NPS system node

Wait for the local subsystem 
instance to be 
deactivated/prohibited. 
Re-activate the local 
subsystem instance running 
on the alternate NPS To do 
this, click 
Configuration>SCCP>local-s
ubsystem, select the NPx of 
interest and click Activate.

there is no NPE chain 
provisioned with an 
alternate NPS system node

continue this procedure.

If Do

NPS system nodes are 
provisioned without a 
chain, or NPS system 
nodes which are 
masters of a chain

select an NPS system node to be 
downgraded. This node cannot be 
an NPS system node already 
downgraded in the previous steps 
or the NPS system node 
associated with the currently active 
NPC chain.

there are no further 
NPS system nodes to 
be downgraded

Proceed to step 30.
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20 Using the software upgrade wizard, select the NPS node to 
downgrade in the list of available nodes 

21 Click the Downgrade node button.

22 Wait for node downgrade to complete (upgrade-status will 
change to not-upgraded on completion).

Note: In the event that the automatic node downgrade fails to 
complete successfully, perform the downgrade manually. 
Manually downgrading the NPC, NPS, and NPE system 
nodes on page 189.

23

24 Wait for the local subsystem instance to be 
deactivated/prohibited.

25 Re-activate the local subsystem instance running on the NPS. 
To do this, click 
configuration>sccp>shared-local-subsystem-instance, 
select the NPx of interest and click Activate.

26 If an NPE chain has been provisioned with an alternate NPS 
system node:

a Wait for the local subsystem instance to be 
activated/allowed.

b Re-activate the NP local subsystem instance running on the 
alternate NPS. To do this, click 
configuration>sccp>shared-local-subsystem-instance, 
select the NPx of interest and click Activate.

27 Wait for the re-activated local subsystem instances to return to 
the activated/allowed state. 

28 Monitor the USP to ensure it performs normally and does not 
report any LOG_SWERRs or LOG_TRAPs. If it does, do not 
continue with the node downgrade.

29 Repeat steps 17 to 28 for any remaining NPS system nodes in 
the system, otherwise proceed to step 30.

If Do

an NPE chain has been 
provisioned for this NPS 
node

repeat steps 20 to 22 for each 
NPE system node and the 
alternate NPS system node 
associated with this chain.

there is no NPE chain 
associated with this NPS 
node

continue this procedure.
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30 Swact the active NPC node. To do this, click 
Administration>platform>node for the currently active NPC 
node, then click the Swact button.

31 Deactivate the NP local subsystem instance running on the 
inactive NPC system node. To do this, click 
configuration>sccp>shared-local-subsystem-instance, 
select the NPx of interest and click Deactivate.

32 If an NPE chain has been provisioned with an alternate NPS 
system node, then deactivate the local subsystem instance 
running on the alternate NPS. To do this, click 
configuration>sccp>shared-local-subsystem-instance, 
select the NPx of interest and click Deactivate.

33 Using the software upgrade wizard, select the newly inactive 
NPC node to downgrade in the list of available nodes.

34 Click the Downgrade node button.

35 Wait for the node downgrade to complete (upgrade-status will 
change to not-upgraded on completion).

Note: In the event that the automatic node downgrade fails to 
complete successfully, perform the downgrade manually. 
Manually downgrading the NPC, NPS, and NPE system 
nodes on page 189.

36 If an NPE chain has been provisioned for this NPC, repeat steps 
33 to 35 for each NPE system node and the alternate NPS 
system node associated with this chain.

37 Wait for the local subsystem instance to be 
deactivated/prohibited, then, re-activate the local subsystem 
instance running on the inactive NPC. To do this, click 
configuration>sccp>shared-local-subsystem-instance, 
select the NPx of interest and click Activate.

38 If an NPE chain has been provisioned with an alternate NPS 
system node, wait for the local subsystem instance to be 
deactivated/prohibited, then re-activate the local subsystem 
instance running on the alternate NPS. To do this, click 
configuration>sccp>shared-local-subsystem-instance, 
select the NPx of interest and click Activate.

39 Wait for the re-activated local subsystem instances to return to 
the activated/allowed state. 

40 Monitor the USP to ensure it performs normally and does not 
report any LOG_SWERRs or LOG_TRAPs. If it does, do not 
continue with the node downgrade.
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41 Ensure that the activity state of the NPC is set to not-active. To 
do this click Administration>shared>local-subsystem.

42 SWACT the currently active NPC node. To do this click 
Administration>platform>node. 

43 Monitor the USP to ensure it performs normally and does not 
report any LOG_SWERRs or LOG_TRAPs. If it does, do not 
continue with the node downgrade.

On LSMS

44 Re-establish all SMI connections to the UNPM. Refer to the 
LSMS operation manual for release methods.

45 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

Downgrading a single Link node

The following procedure is used to downgrade a single system node 
using the wizard.

To downgrade a single Link node:

At the OAMP workstation 

1 Select the node to downgrade in the list of available nodes in the 
software upgrade wizard.

2 Click the Downgrade button. The system asks for confirmation.

If Do

the NPC’s activity state is 
currently active 

continue to step 42.

the NPC’s activity state is 
currently inactive 

continue to step 43.

ATTENTION
To downgrade an NPC, NPS, or NPE node see Downgrading the 
NPC, NPS, and NPE nodes on page 176.
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3 Wait for node downgrade to complete (upgrade-status will 
change to not-upgraded on completion).

Note: If the automatic node downgrade fails to complete 
successfully, perform the downgrade manually. See Manually 
downgrading system nodes on page 185.

4 Monitor the USP to ensure it performs normally and does not 
report any LOG_SWERRs or LOG_TRAPs. If it does, do not 
continue with the node downgrade.

5 Repeat this procedure for all remaining link nodes.

6 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.
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Downgrading multiple Link nodes

The following procedure is used to downgrade multiple system nodes 
using the wizard.

To downgrade multiple Link nodes:

At the OAMP workstation 

1 Shift-click or ctrl-click to select a range of nodes to downgrade 
in the list of available nodes in the software upgrade wizard.

2 Select the delay interval between each successive node 
downgrade. This will be used to soak the downgraded node 
before moving to the next system node.

3 Click the Downgrade node button. The system asks for 
confirmation.

4 Wait for the node downgrade to complete (upgrade-status will 
change to not-upgraded on completion).

Note: If the automatic node downgrade fails to complete 
successfully, perform the downgrade manually. See Manually 
downgrading system nodes on page 185.

5 The downgrade will now delay for the selected interval before 
continuing to the next node to downgrade. Downgrade of nodes 
can be cancelled at any time by clicking the Stop button. To skip 
the delay count down, click No delay and the next node will be 
downgraded immediately.

6 Monitor the USP to ensure it performs normally and does not 
report any LOG_SWERRs or LOG_TRAPs. If it does, do not 
continue with the node downgrade.

7 Repeat this procedure for all remaining link nodes.

8 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

ATTENTION
To downgrade an NPC, NPS, or NPE node, see Downgrading the 
NPC, NPS, and NPE nodes on page 176.
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Downgrading the inactive RTC node in slot 15
The downgrade of the RTC in slot 15 can take up to 20 minutes to 
complete.

To downgrade the inactive RTC in slot 15:

At the OAMP workstation

1 Verify that RTC15 is the inactive RTC.

a In the menu bar, click Configuration>platform>node.

b Click the Graphical view tab.

c Double-click the RTC in slot 15.

2 Select the RTC15 node to downgrade from the list of available 
nodes in the software upgrade wizard.

3 Click the Downgrade button. A confirmation dialog box appears. 
Click Yes to continue.

4 Wait for node downgrade to complete (the upgrade-status will 
change to not-upgraded on completion).

Note: If the automatic node downgrade fails to complete 
successfully, perform the downgrade manually. See Manually 
downgrading system nodes on page 185.

5 Monitor the USP to ensure it performs normally and does not 
report any LOG_SWERRS or LOG_TRAPS. If it does, contact 
your next level of support.

6 Set the alternate boot load for RTC system nodes to the  
downgrade load.

Note: The alternate boot settings are used when an RTC is 
not able to boot from disk.

a Click Administration>alternate-boot-server.

b Update RTC 12 to the old release version by selecting the old 
release from the ABS Active Loads drop-down menu.

c Update RTC 15 to the old release version by selecting the old 
release from the ABS Active Loads drop-down menu.

If Do

the Activity State is inactive Continue to step 2.

the Activity State is active Perform a SWACT, then 
continue to step 2.
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d Select the data snapshot taken before starting the upgrade 
from the Alt. Boot Data Snapshot list. Once the snapshot is 
selected, the window displays the Description.

e Click Modify.

7 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

Manually downgrading system nodes 
You can only downgrade system nodes if the RTC in slot 12 is not 
upgraded. Nortel Networks recommends that you downgrade the cards 
in the reverse order as you upgraded the cards.

The procedures in this section describe how to perform a downgrade 
for each of the following nodes:

• CC system node 

• Link system nodes

• NPC, NPS, and NPE system nodes

• RTC system node in slot 15; this must be the last card downgraded

Perform each downgrade only as necessary (if you upgraded the 
system node).

CAUTION

Do not downgrade RTC 15 until all other cards have 
been downgraded. If you downgrade RTC 15 before 
you have downgraded all the other cards in the 
system, and an upgraded card reboots, the upgraded 
card is orphaned and will not enable because there is 
no upgraded RTC to provide the upgraded data. To 
recover this orphaned card, change the boot load to 
the older release.
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Manually downgrading a CC system node 
The following procedure is used to manually downgrade the CC system 
node. 

To manually downgrade a CC system node:

At the OAMP workstation

1 Click Configuration>platform>node.

2 Double-click the slot for this node to open the node in the 
Administration panel.

3 Click Graphical View.

4 Select the drop-down menu to set the boot image to the previous 
release version.

5 Lock and load the CC system node.

6 When the CC system node becomes enabled, unlock it.

7 Verify that the running load is the downgraded load. If not, 
double-check that the correct image is selected on the 
maintenance and provisioning window.

8 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.
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Manually downgrading the Link system nodes 
Downgrade the Link system nodes one at a time, beginning with the 
lowest slot number and proceeding to the highest slot number. 

To manually downgrade the Link system nodes:

At the OAMP workstation

1 Click Configuration>platform>node.

2 Click Graphical View

3 Double-click the slot for the link node to open the node in the 
Administration panel.

4 Select the drop-down menu to set its boot image to the previous 
Link release version. Set the HA boot image to the previous HA 
release version, if applicable.

Note:  IP high-speed link (HSL) link cards do not require HA 
loads.

5 Inhibit all the links on the Link system node, if applicable.

Note 1: You cannot inhibit IPS7 links.

Note 2: If there is only one available link on a linkset, you 
cannot inhibit it. If there are other links on the linkset, make at 
least one of them available before attempting to inhibit the link. 
If it is a one-link linkset, proceed to step 6 without inhibiting the 
link.

6 Deactivate all of the links or paths on the Link system node, as 
applicable.

7 Lock and load the Link system node.

8 When the Link system node becomes enabled, unlock it.

9 Verify that the running load is the downgraded load. If not, 
double-check that the correct image is selected on the 
maintenance and provisioning window.

10 Activate and uninhibit all of the links on the Link system node. 

11 Repeat steps 4 to 10 for the remaining Link system nodes.

ATTENTION
To manually downgrade an NPC, NPS, or NPE node see 
Manually downgrading the NPC, NPS, and NPE system nodes on 
page 189.
Nortel USP Upgrades



Nortel Networks Confidential188Copyright © 2006, Nortel Networks
12 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.
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Manually downgrading the NPC, NPS, and NPE system nodes
If your system includes the optional Universal Number Portability 
Master (UNPM) feature, you must downgrade the NPC, NPS, and NPE 
system nodes (on all shelves if you have a dual-shelf or multi-shelf 
system). If your system does not include the UNPM feature, skip this 
section. 

To manually downgrade the NPC, NPS, and NPE system nodes:

On LSMS

1 Release all SMI connections to the UNPM. Refer to the LSMS 
operation manual for release methods.

At the OAMP workstation

2 Click Configuration>platform>node.

3 Click Graphical View.

4 Double-click the slot for this node to open the node in the 
Administration panel.

5 Select the drop-down menu to set the boot image to the previous 
release version.

6 If an NPE chain has been provisioned for this NPC, repeat steps 
2 to 5 for the NPE system nodes and the alternate NPS system 
node associated with this chain.

7 Deactivate the NP LSS instance running on the inactive NPC 
system node, using the Local Subsystem Instance window.

8 If an NPE chain has been provisioned with an alternate NPS, 
deactivate the NP LSS instance running on the alternate NPS 
system node, using the Local Subsystem Instance window.

9 Lock and load the inactive NPC system node.

10 If an NPE chain has been provisioned for this NPC, lock and load 
each NPE system node and the alternate NPS system node 
associated with this chain.

CAUTION
Potential for NPDB corruption
If downgrading the NP nodes/chains, the connection 
to the LSMS will need to be released on the LSMS. 
Refer to the LSMS operation manual for release
methods. Contact Nortel Networks Technical 
Support. Failure in doing so will result in NPDB 
corruption.
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11 When the inactive NPC system node becomes enabled, unlock 
it.

12 If an NPE chain has been provisioned for this NPC, when each 
NPE system node and the alternate NPS system node becomes 
enabled, unlock each of these nodes.

13 Contact Nortel Networks Technical support to continue the 
downgrade.

Note:  NPDB raises a critical alarm, this is expected due to 
Nortel Networks technical support issuing commands on the 
NPDB.

14 Wait for the LSSI to be Deactivated/Prohibited, then re-activate 
the local subsystem instance running on the inactive NPC 
system node.

15 If an NPE chain has been provisioned with an alternate NPS, 
wait for the LSSI to be Deactivated/Prohibited, then re-activate 
the NP LSS instance running on the alternate NPS system node.

16 Verify that the load running for the inactivate NPC system node 
is the previous version. If not, make sure that the correct image 
is selected on the maintenance and provisioning window. If the 
right image is selected but the incorrect load is running, stop the 
downgrade procedures and contact Nortel Networks technical 
support.

17 When the re-activated local subsystem instance(s) enter the 
allowed/activated state, monitor the USP for 15 minutes to 
ensure it performs normally and does not report any 
LOG_SWERRs or LOG_TRAPs.

18 If NPS system nodes are provisioned, select an NPS system 
node to be downgraded. Note, that this can not be an NPS 
system node already downgraded in the previous steps. If there 
are no NPS system nodes to be downgraded, skip to step 31.

19 In the provisioning and maintenance window of the selected 
NPS system node, set its boot image to the previous NPS 
release version. 

20 If an NPE chain has been provisioned for the selected NPS, 
repeat steps 2 to 5 for the NPE system nodes and the alternate 
NPS system node associated with this chain.

21 Deactivate the local subsystem (LSS) instance associated with 
the NPS system node. 

22 If an NPE chain has been provisioned with an alternate NPS for 
the selected NPS, deactivate the NP LSS instance running on 
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the alternate NPS system node, using the Local Subsystem 
Instance window.

23 Lock and load the selected NPS system node.

24 If an NPE chain has been provisioned for this NPS, lock and load 
each NPE system node and the alternate NPS system node 
associated with this chain.

25 When the NPS system node becomes enabled, unlock it.

26 If an NPE chain has been provisioned for this NPS, when each 
NPE system node and the alternate NPS system node becomes 
enabled, unlock each of these nodes.

27 Wait for the LSSI to be Deactivated/Prohibited, then re-activate 
the LSS instance on the NPS system node. 

28 If an NPE chain has been provisioned with an alternate NPS, 
wait for the LSSI to be Deactivated/Prohibited, then re-activate 
the NP LSS instance running on the alternate NPS system node.

29 Verify that the running load is the previous version. If not, make 
sure that the correct image is selected on the provisioning and 
maintenance window.

30 Repeat steps 17-29 for any remaining NPS system nodes in the 
system.

31 Once the re-activated local subsystem instance(s) enter the 
allowed/activated state, monitor the USP for 15 minutes to 
ensure it performs normally and does not report any 
LOG_SWERRs or LOG_TRAPs. 

32 In the provisioning and maintenance window of the active NPC 
system node, click the SWACT button to switch the active NPC 
system node.

33 In the provisioning and maintenance window of the newly 
inactive NPC system node, set its boot image to the previous 
NPC release version. 

34 If an NPE chain has been provisioned for this NPC, repeat steps 
2 to 5 for the NPE system nodes and the alternate NPS system 
node associated with this chain.

35 Deactivate the local subsystem instance on the newly inactive 
NPC system node.

36 If an NPE chain has been provisioned with an alternate NPS, 
deactivate the NP LSS instance running on the alternate NPS 
system node, using the Local Subsystem Instance window.

37  Lock and load the newly inactive NPC system node.
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38 If an NPE chain has been provisioned for this NPC, lock and load 
each NPE system node and the alternate NPS system node 
associated with this chain.

39 When the newly inactive NPC system node becomes enabled, 
unlock it.

40 If an NPE chain has been provisioned for this NPC, when each 
NPE system node and the alternate NPS system node becomes 
enabled, unlock each of these nodes.

41 Wait for the LSSI to be Deactivated/Prohibited, then re-activate 
the local subsystem instance on the newly inactive NPC system 
node.

42 If an NPE chain has been provisioned with an alternate NPS, 
wait for the LSSI to be Deactivated/Prohibited, then re-activate 
the NP LSS instance running on the alternate NPS system node.

43 Verify that the load running is the previous version. If not, make 
sure that the correct image is selected on the maintenance and 
provisioning window. If the right image is selected but the 
incorrect load is running, stop the downgrade procedures and 
contact Nortel Networks technical support.

44 In the provisioning and maintenance window of the newly 
inactive NPC system node, click the SWACT button to switch the 
active NPC system node.

45 Once the re-activated local subsystem instance(s) enter the 
allowed/activated state, Monitor the USP for 15 minutes to 
ensure it performs normally and does not report any 
LOG_SWERRs or LOG_TRAPs.

On LSMS

46 Re-establish all SMI connections to the UNPM. Refer to the 
LSMS operation manual for release methods.

47 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.
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Manually downgrading the RTC system node in slot 15
The following procedure is used to manually downgrade the RTC 
system node in slot 15.

To manually downgrade the RTC system node in slot 15:

At the OAMP workstation

1 Click Configuration>platform>node.

2 Click Graphical View.

3 Double-click the slot 15 for this RTC node to open the node in 
the Administration panel.

4 Select the drop-down menu to set the boot image to the previous 
release version.

5 Lock and load the inactive RTC system node.

6 When the inactive RTC system node becomes enabled, unlock 
it.

7 Verify that the running load is the downgraded version. If not, 
make sure that the correct image is selected on the Provisioning 
and Maintenance window. If the correct image is selected, but 
the incorrect image is running, stop the downgrade procedures 
and contact your next level of support.

8 Set the alternate boot load for both RTC 12 and RTC15 to the 
previous load.

9 After downgrading the RTC, perform a test call to make sure the 
call is routed correctly. If there are any errors, contact your next 
level of support.

Proceed to the section Stop the upgrade and delete the upgrade 
package on page 194.

10 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.
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Stop the upgrade and delete the upgrade package
When you abort a software upgrade procedure, perform the procedure: 
Stopping the upgrade.

Remove the upgrade package from both RTC system nodes. To do this, 
perform the procedure: Deleting the upgrade package.

You then must delete the new loads from RTC12 and RTC15, delete all 
snapshots associated with the unwanted USP release from both RTC 
system nodes, and delete the loads and snapshots from the Alternate 
Boot Server.

Stopping the upgrade

At the OAMP workstation

1 Click Stop Upgrade. A confirmation dialog box appears.

2 Click Finish on the wizard action and navigation panel.

3 Create a data snapshot, copy it to the alternate boot server and 
set the alternate boot server snapshot

4 Set user privileges back to pre-upgrade settings and re-enable 
any user accounts that were disabled during the upgrade. Refer 
to the file you created in "Limit user access" section, step 7 for 
the correct user status. Refer to the sections Security: User 
accounts and Security: User session in the USP Administration 
and Security guide for additional information.

5 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

Deleting the upgrade package

At the OAMP workstation

1 Open the File Manager panel. To do this, click 
Administration>File Manager.

2 Highlight RTC12 in the list.

3 Open the upgrade folder.

4 Open the required version folder.

5 Select the required upgrade file.

6 Click Delete.

7 Repeat steps 2 to 6 for the RTC in slot 15.

8 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.
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Deleting the new loads from RTC12 and RTC15

At the OAMP workstation

1 Open the File Manager panel. To do this, click 
Administration>File Manager.

2 Select the RTC system node from which you want to delete the 
load image file from the RTC drop box.

3 Expand the Loads folder.

4 Expand the folder for the new release.

5 Select the files to be deleted from the Loads.

Note: Make sure you select the correct loads before deleting 
them.

6 Click Delete.

7 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

Deleting snapshots from the RTCs

At the OAMP workstation

1 Open the File Manager panel. To do this, click Administration 
> File Manager.

2 Select the RTC system node from which you want to delete the 
snapshot from the RTC drop box.

Note: You cannot delete the boot data snapshot. If you 
attempt to delete the boot data snapshot, you will receive an 
error message.

3 Expand the Snapshot folder.

4 Expand the folder for the new release.

5 Click Delete to delete the snapshot. An hourglass appears while 
the data snapshot is deleted. When the deletion operation is 
complete, snapshot is removed from the RTC side of the File 
Manager window.

6 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.
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Deleting loads from the alternate boot server

At the OAMP workstation

1 Open the ABS configuration manager. There are two versions of 
ABS Configuration Manager available on the CMT. One is 
graphically-based and the other is console-based. If you opened 
the graphically-based ABS Configuration Manager, perform 
steps 2 to 4. If you opened the console-based ABS 
Configuration Manager, proceed to step 5.

2 Click on file, then select uninstall release from the drop-down 
menu. The uninstall existing release window appears.

3 Select the load to be deleted from the drop-down menu.

4 Click Apply, and proceed to step 6.

5 Enter ABSCM>release uninstall <release-name>.

6 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

Deleting old snapshots from the alternate boot server

At the OAMP workstation

1 Open the File Manager panel. To do this: click 
Administration>File Manager.

2 Expand the Snapshot folder.

3 Expand the folder for the new release. 

4 Click Delete to delete the snapshot. An hourglass appears while 
the data snapshot is deleted. When the deletion operation is 
complete, the snapshot is removed from the Alternate Boot 
Server side of the File Manager window.

5 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

Downgrade the GUI
When aborting a software upgrade, you can choose to uninstall the new 
version of the USP GUI from your workstation(s) and then install the 
previous version.

However, downgrading the GUI is not required. The new version of the 
GUI is backward-compatible with the previous USP software.
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If you choose to downgrade the GUI, uninstall the upgraded version 
and install the downgrade version on your alternate boot server first, 
and then repeat both procedures for the other OAMP workstations in 
your system, as necessary. To do this, see the procedure Uninstalling 
the upgraded USP GUI on page 197

If you uninstall the new version of the GUI, you must then install the 
previous version. To do this, see the procedure Installing the previous 
version of the USP GUI on page 197. Finally, after you have 
downgraded the GUI and restarted the workstation, you must reset the 
alternate boot server to the original configuration. To do this, see the 
procedure Modifying the alternate boot server on page 199.

Uninstalling the upgraded USP GUI

At the OAMP workstation

1 Close any open applications and exit all USP Distinct servers.

2 In Windows, click Start on your desktop.

3 On the Settings menu, select Control Panel.

4 In the Control Panel window, double-click the Add/Remove 
Programs icon.

5 In the Install/Uninstall tab window of the Add/Remove Programs 
Properties window, select Universal Signaling Point from the 
alphabetical list of programs.

6 Click Change/Remove. A pop-up menu asks if you are sure you 
want to completely remove the USP and all of its components.

7 Click Next.

8 Click Complete UnInstall.

9 Click Yes to confirm your choice. All of the files are removed.

10 Restart your computer. 

11 This procedure is complete. After your computer restarts, 
proceed to the next section .

Installing the previous version of the USP GUI

ATTENTION
To install the previous version of the USP GUI, you will require a 
Window-based OAMP workstation.
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At the OAMP workstation

1 Insert the previous version of the USP software CD-ROM disk 
into the CD-ROM drive.

2 Double-click the My Computer icon.

3 Double-click the CD-ROM disk icon.

4 Double-click Setup.exe.

5 A pop-up window appears with the warning that installing this 
software on a workstation other than a Nortel 
Networks-approved workstation can overwrite some system 
files used by other applications. If this is a Nortel 
Networks-approved workstation, click Yes to continue.

6 At the Welcome window for the setup program, click Next. The 
Copying Program Files window appears with a status bar while 
the files are copied.

7 A pop-up window asks if you want to configure this workstation 
as an alternate boot server. Each USP system needs one 
workstation configured as an alternate boot server. If this 
workstation is your alternate boot server, click Yes. If not, click 
No.

Note: Do not configure more than one alternate boot server 
for each USP system.

If you answer yes, then after completing these installation steps, 
follow the additional steps to configure the three distinct servers 
(the BOOTP server, the NFS server, and the FTP server).

8 If Adobe Acrobat Reader is already installed on this workstation, 
skip to step 12. If not, a Welcome window for Adobe Acrobat 
Reader Setup Program appears. Click Next.

9 The Acrobat Reader Licence Agreement appears. Click Yes to 
accept the terms of the agreement.

10 The Acrobat Reader Destination Location window appears. 
Click Next. Do not modify the destination path for Acrobat 
Reader.

11 The Acrobat Reader Setup Complete window appears. Click 
Finish. The Acrobat Reader Setup Complete window appears 
again. Click OK.

12 The Installation Setup Complete window appears.

13 Click the radio button next to the option “Yes, I want to restart my 
computer now”.

14 Click Finish. The computer restarts.
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15 Remove the USP software disk from the drive. Keep the disk 
handy to the USP hardware.

16 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

Modifying the alternate boot server

At the OAMP workstation

1

A pop-up window prompts you to create a password for the 
Alternate Boot Server Configuration Manager.

2 Click the Distinct BOOTP Server button on the taskbar to 
maximize the Distinct BOOTP Server window.

3 Click the Configure menu and select Administrator and then 
Login to display the Distinct BOOTP Login window.

4 Enter your administrator password in the Enter the administrator 
password field and click OK to log into the server.

The Distinct BOOTP Login window closes.

5 Click the Configure menu and select Server to display the 
Configure BOOTP window.

6 In the Addresses tab window, view the contents of the field at the 
bottom of the window, next to the Add, Modify, and Remove 
buttons. This field will contain the hexadecimal Ethernet 
hardware addresses of the RTC system nodes in your system.

7 Select the Ethernet hardware address that matches the Ethernet 
hardware address for the RTC system node in slot 12 of your 
system. The information for that Ethernet hardware address will 
appear in the various fields.

8 In the Boot File field, change the value to 
/d/ntssgusp/abs/sites/<site_name>/rtc12/rtcboot (where 
site_name is the name of your system as it appears in the site 
configuration information).

9 Click Modify to save the changes.

CAUTION

Make a record of the password immediately.
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10 Select the Ethernet hardware address that matches the Ethernet 
hardware address for the RTC system node in slot 15 of your 
system. The information for that Ethernet hardware address will 
appear in the various fields.

11 In the Boot File field, change the value to 
/d/ntssgusp/abs/sites/<site_name>/rtc15/rtcboot (where 
site_name is the name of your system as it appears in the site 
configuration information).

12 Click Modify, then Apply to save the changes.

13 Open the Alternate Boot Server Configuration Manager. There 
are two versions of the ABS Configuration Manager available on 
the CMT. One is graphically-based and the other is 
console-based. If you opened the graphically-based ABS 
Configuration Manager, perform steps 14 to 20. If you opened 
the console-based ABS Configuration Manager, perform steps 
21 to 29.

14 Log in to the Alternate Boot Server Configuration Manager.

15 Under the File drop-down menu, select ABS Configuration.

16 Select a site from the Site list.

17 Confirm that the Alternate Boot Loads displayed for each RTC 
are for the pre-upgrade load. 

18 Confirm that the Alternate Boot Snapshot display is the snapshot 
taken earlier in this procedure. A pre-upgrade snapshot

19 Click Apply to save the changes.

20 Log out of the Alternate Boot Server Configuration Manager and 
proceed to step 30.

21 Log in to the console-based Alternate Boot Server Configuration 
Manager.

Type: ABSCM>login

22 Enter the ABSCM> site show <site-name> command to view 
the site's details.

23 To view all the available loads, enter ABSCM>load show all.

24 To view all the snapshots for a specified site, enter:

ABSCM>snapshot show <site-name>

25 To modify the RTC12-load of the specified site, enter:

ABSCM>site mod <site-name> rtc12-load 
<new-rtc12-load-name>

26 To modify the RTC15-load of the specified site, enter:
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ABSCM>site mod <site-name> rtc15-load 
<new-rtc15-load-name>

27 To modify the snapshot of the specified site, enter:

ABSCM>site mod <site-name> snapshot 
<new-snapshot-name>

28 Confirm that the Alternate Boot Snapshot display is the snapshot 
taken earlier in this procedure. It should be a pre-upgrade 
snapshot.

29 Log out of the Alternate Boot Server Configuration Manager.

30 This procedure is complete. If applicable, return to the higher 
level task flow or procedure that directed you to this procedure.

Note: Refer to the ABS_Specification.pdf document for the 
complete details of all the console-based ABS Configuration 
Manager commands.
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